Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System

Multi-Well Plates and Array Card Experiments

for use with:  Other real-time PCR systems

ExpressionSuite Software
TaqMan® Genotyper Software

MULTI-WELL PLATES AND ARRAY CARD EXPERIMENTS USER GUIDE

Publication Part Number  4470050 Rev. A
Revision Date  March 2012
For General Laboratory Use.

For Research Use Only. Not intended for any animal or human therapeutic or diagnostic use.

Information in this document is subject to change without notice.

WARRANTY AND LIABILITY

LIFE TECHNOLOGIES CORPORATION AND/OR ITS AFFILIATE(S) DISCLAIM ALL WARRANTIES WITH RESPECT TO THIS DOCUMENT, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. TO THE EXTENT ALLOWED BY LAW, IN NO EVENT SHALL LIFE TECHNOLOGIES AND/OR ITS AFFILIATE(S) BE LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY, OR UNDER ANY STATUTE OR ON ANY OTHER BASIS FOR SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM THIS DOCUMENT, INCLUDING BUT NOT LIMITED TO THE USE THEREOF.

NOTICE TO PURCHASER: LIMITED USE LABEL LICENSE: Research Use Only

The purchase of this product conveys to the purchaser the limited, non-transferable right to use the purchased amount of the product only to perform internal research for the sole benefit of the purchaser. No right to resell this product or any of its components is conveyed expressly, by implication, or by estoppel. This product is for internal research purposes only and is not for use in commercial applications of any kind, including, without limitation, quality control and commercial services such as reporting the results of purchaser’s activities for a fee or other form of consideration. For information on obtaining additional rights, please contact outlicensing@lifetech.com or Out Licensing, Life Technologies, 5791 Van Allen Way, Carlsbad, California 92008.

TRADEMARKS

The trademarks mentioned herein are the property of Life Technologies Corporation or their respective owners.

TaqMan, AmpErase and AmpliTaq Gold are registered trademarks of Roche Molecular Systems, Inc. Twister is a registered trademark of Caliper Life Sciences. Microsoft and Windows are registered trademarks of Microsoft Corporation.

©2012 Life Technologies Corporation. All rights reserved.
Roadmap

BOOKLET 1  Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments

BOOKLET 2  Running Standard Curve Experiments

BOOKLET 3  Running Relative Standard Curve and Comparative $C_T$ Experiments

  PART I:  Running Relative Standard Curve Experiments

  PART II:  Running Comparative $C_T$ Experiments

BOOKLET 4  Running Genotyping Experiments

BOOKLET 5  Running Presence/Absence Experiments

BOOKLET 6  Running Melt Curve Experiments

BOOKLET 7  QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments - Appendixes
Booklet 1 - Getting Started with QuantStudio™
12K Flex System Multi-Well Plates and Array
Card Experiments

Publication Part Number 4470050 Rev. A
Revision Date March 2012
## Contents

**About This Guide** ............................................. 5

- Revision history ............................................. 5
- Purpose ....................................................... 5
- Prerequisites ................................................ 5
- How to use these booklets as tutorials .................. 6
- How to use the guides with your own experiments ..... 6
  - Assumptions ............................................... 6
  - How to access an example experiment ................. 6
  - Data files in the Examples folder ..................... 7
- User attention words ....................................... 8

**CHAPTER 1** General Information and Instructions ................. 9

- Set up an experiment ....................................... 10
  - Define experiment properties .......................... 10
  - Define experiment name and type .................... 10
  - Select the reagent ....................................... 11
  - Define the instrument run properties ............... 11
  - Define targets, samples, and biological replicate groups .... 12
  - Assign targets, samples, and biological replicate groups - Alternate procedure .................. 14
  - Assign targets, samples, and biological replicate groups - Alternate procedure .......... 16
  - Define the run method .................................. 17
  - (Optional) Use libraries when designing your own experiments .................. 19
- Prepare reactions ........................................... 20
  - Supported consumables ................................ 20
  - Supported reagents ..................................... 23
  - Reagent detection process ............................. 23
  - Precautions while preparing reactions ............. 25
  - Materials required while preparing the dilutions .... 25
  - Guidelines for preparing the dilutions, reaction mix, and plate .................. 26
  - Seal the reaction plate .................................. 26
  - Fill and seal the array card ........................... 28
  - Capping and uncapping the 96-well reaction tubes and tube strips .................. 32
- Start the experiment ........................................ 33
  - Instrument Console ..................................... 34
  - Load the reaction plate or array card into the instrument .............. 37
  - Enable or change the Notification Settings .......... 38
  - Run the experiment ..................................... 39
  - Monitor the experiment ................................ 40
  - Unload the instrument .................................. 46
  - Transfer experiment results ........................... 47
- Review experiment results ................................ 50
  - About analysis results ................................ 50
  - About the Analysis Settings Library .................. 50
  - To override calibration ................................. 51
## Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>To display wells</td>
<td>52</td>
</tr>
<tr>
<td>To display multiple plots</td>
<td>52</td>
</tr>
<tr>
<td>To display an expanded view of a plot or wells</td>
<td>53</td>
</tr>
<tr>
<td>To edit plot properties</td>
<td>53</td>
</tr>
<tr>
<td>To save current settings as default</td>
<td>54</td>
</tr>
<tr>
<td>To publish the analyzed data</td>
<td>54</td>
</tr>
<tr>
<td>Export an experiment</td>
<td>54</td>
</tr>
<tr>
<td>About exporting an experiment</td>
<td>54</td>
</tr>
<tr>
<td>Export procedure</td>
<td>55</td>
</tr>
<tr>
<td><strong>CHAPTER 2 Experiment Shortcuts</strong></td>
<td>59</td>
</tr>
<tr>
<td>Create an experiment from a template</td>
<td>59</td>
</tr>
<tr>
<td>To create a template</td>
<td>59</td>
</tr>
<tr>
<td>To create a new experiment using a template</td>
<td>59</td>
</tr>
<tr>
<td>To create an experiment using a template on the QuantStudio™ 12K Flex Instrument touchscreen</td>
<td>60</td>
</tr>
<tr>
<td>QuickStart an experiment</td>
<td>60</td>
</tr>
<tr>
<td>QuickStart from the QuantStudio™ 12K Flex Software</td>
<td>60</td>
</tr>
<tr>
<td>QuickStart from the QuantStudio™ 12K Flex Instrument touchscreen</td>
<td>61</td>
</tr>
<tr>
<td>Import plate setup for an experiment</td>
<td>62</td>
</tr>
<tr>
<td>Import sample information</td>
<td>63</td>
</tr>
<tr>
<td>Create a sample definition file</td>
<td>63</td>
</tr>
<tr>
<td>Import sample information from a sample definition file</td>
<td>64</td>
</tr>
<tr>
<td>Use a template to create a batch of experiments</td>
<td>66</td>
</tr>
<tr>
<td>Create an experiment using ReadiApp</td>
<td>68</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>69</td>
</tr>
</tbody>
</table>
About This Guide

CAUTION! ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard types specified in procedures may be abbreviated in this document. For the complete safety information, see the “Safety” appendix in this document.

IMPORTANT! Before using this product, read and understand the information the “Safety” appendix in this document.

Revision history

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>March 2012</td>
<td>New document</td>
</tr>
</tbody>
</table>

Purpose

The QuantStudio™ 12K Flex Real-Time PCR System Multi-Well Plates and Array Card Experiments User Guide Binder functions as both a tutorial and as a guide for performing your own experiments using the 384-Well, 96-Well (0.1ml and 0.2ml), and the Array Card consumables on the QuantStudio™ 12K Flex System.

Prerequisites

This user guide is intended for personnel who have been specifically trained by Life Technologies. The manufacturer is not liable for damage or injury that results from use of this manual by unauthorized or untrained parties.

This guide uses conventions and terminology that assume a working knowledge of the Microsoft® Windows® operating system, the Internet, and Internet-based browsers.

Note: First-time users of the QuantStudio™ 12K Flex System, please read this booklet, Getting Started with QuantStudio™ 12K Flex System 96-Well, 384-Well, and Array Card Experiments thoroughly. The booklet provides information and general instructions that are applicable to all the experiments described in this binder.
How to use these booklets as tutorials

Each booklet in this guide provides a tutorial for running an example experiment using QuantStudio™ 12K Flex Software and the example data provided on the installation CD. The following booklets are provided:

- **Getting Started with QuantStudio™ 12K Flex System 96-Well, 384-Well, and Array Card Experiments** – introductory information and experiment workflow common to all experiments.
- **Running Standard Curve Experiments** – designing, running, and analyzing a Standard Curve experiment.
- **Running Relative Standard Curve and Comparative C_T Experiments** – designing, running, and analyzing Relative Standard Curve and Comparative C_T experiments.
- **Running Genotyping Experiments** – designing, running, and analyzing a Genotyping experiment.
- **Running Presence/Absence Experiments** – designing, running, and analyzing a Presence/Absence experiment.
- **Running Melt Curve Experiments** – designing, running, and analyzing a Melt Curve experiment.
- **QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments - Appendixes** – common information such as ordering information, additional documentation, and glossary.

**Note:** In all booklets, the term “experiment” refers to the entire process of performing an experiment, including setup, run, and analysis.

How to use the guides with your own experiments

Each booklet contains instructions specific to an example experiment provided on the installation CD. However, you can use the booklets as guides for your own experiments; tips for running your own experiments are provided at various points in each booklet.

**Assumptions**

This guide assumes that you have access to the example experiments provided with the software.
How to access an example experiment

Start the QuantStudio™ 12K Flex Software

Double-click  (QuantStudio™ 12K Flex Software shortcut) to access the Home screen, shown below.

**Note:** You can customize the Home screen by importing an image of your choice. The image is displayed on the right hand side of the screen.

To personalize the Home screen, go to **Tools ‣ Select Welcome Image**. Browse to the image of your choice and click **OK**.

**Note:** The icons in the Analyze menu appear active only if you've downloaded the ExpressionSuite Software, TaqMan® Genotyper Software and DigitalSuite Software on your computer.

Open an example experiment

From the Home screen, click **Open**, to navigate to the **experiments** folder (default): C:\Program Files\Applied Biosystems\QuantStudio 12K Flex Software\examples, and open the example experiment file.

**Data files in the Examples folder**

- Gene Expression
  - Comparative $C_T$
  - Relative Standard Curve
- Genotyping
- Melt Curve
- Presence Absence
• Standard Curve

In addition to the above, the examples folder also contains the User Sample Files folder:

• BarCode Template.txt
• Custom Sample Properties Example.xls

User attention words

Five user attention words may appear in this document. Each word implies a particular level of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper instrument operation or accurate chemistry kit use.

⚠️ CAUTION! Indicates a potentially hazardous situation that, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

⚠️ WARNING! Indicates a potentially hazardous situation that, if not avoided, could result in death or serious injury.

⚠️ DANGER! Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury.

Except for IMPORTANTs, the safety alert words in user documentation appear with an open triangle figure that contains a hazard symbol. These hazard symbols are identical to the hazard symbols that are affixed to the instrument. See the “Safety” appendix for descriptions of the symbols.
General Information and Instructions

- Set up an experiment ................................................................. 10
- Define experiment properties .................................................. 10
- Define experiment name and type ............................................. 10
- Select the reagent ................................................................. 11
- Define the instrument run properties ........................................ 11
- Define targets, samples, and biological replicate groups ............. 12
- Assign targets, samples, and biological replicate groups ............ 14
- Assign targets, samples, and biological replicate groups - Alternate procedure 16
- Define the run method ............................................................ 17
- (Optional) Use libraries when designing your own experiments .... 19
- Prepare reactions ................................................................... 20
- Supported consumables ......................................................... 20
- Supported reagents ............................................................... 23
- Reagent detection process ....................................................... 23
- Precautions while preparing reactions ....................................... 25
- Materials required while preparing the dilutions ....................... 25
- Guidelines for preparing the dilutions, reaction mix, and plate .... 26
- Seal the reaction plate ............................................................ 26
- Fill and seal the array card ....................................................... 29
- Capping and uncapping the 96-well reaction tubes and tube strips 32
- Start the experiment ............................................................... 33
- Instrument Console ............................................................... 34
- Load the reaction plate or array card into the instrument .......... 37
- Enable or change the Notification Settings ............................... 38
- Run the experiment ............................................................... 39
- Monitor the experiment .......................................................... 40
- Unload the instrument ........................................................... 47
- Transfer experiment results .................................................... 47
- Review experiment results ..................................................... 50
- About analysis results ............................................................ 50
- About the Analysis Settings Library ........................................ 50
- To override calibration ........................................................... 51
- To display wells ................................................................. 52
- To display multiple plots ....................................................... 52
Set up an experiment

Define experiment properties

All experiments require the same general setup tasks; individual booklets supply specific parameters. The following procedures outline general steps to take to set up an experiment.

Access QuantStudio™ 12K Flex Software and from the Experiment menu, click the Create icon. Click Experiment Properties to access the Experiment Properties screen.

Define experiment name and type

1. Enter a unique experiment name in the Experiment Name field. The default is a date and time stamp, which you can change. For example, 2011-12-08 123517.
   - Enter a name that is descriptive and easy to remember. You can enter up to 100 characters.
   - You can only use the alpha-numeric, period (.), hyphen (-), underscore (_), and spaces ( ) characters.

Note: Make sure each experiment name is unique. If you have named two different experiments with the same name, you cannot run them on the same instrument. You will receive the following error message:

![Error message]

If you do not want to delete the existing experiment, rename the duplicate experiment and then proceed to the run.

2. (Optional) Enter or scan the barcode on the reaction plate. You can enter up to 100 characters in the Barcode field.

3. (Optional) Enter a user name to identify the owner of the experiment. You can enter up to 100 characters in the User Name field.

4. (Optional) Enter comments to describe the experiment.

5. Select the block type you are using to run the experiment
   - 384-Well
   - Array Card

Note: For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ Software by pressing F1, clicking Help in the toolbar, or selecting Help Æ QuantStudio™ 12K Flex Software Help.
6. Select the experiment type:
   - Standard Curve
   - Relative Standard Curve
   - Comparative $C_T$ ($\Delta\Delta C_T$)
   - Melt Curve
   - Genotyping
   - Presence/Absence

Select the reagent
Select the reagent you are using to detect the target sequence:
   - TaqMan® Reagents
   - SYBR® Green Reagents
   - Other
   Note: If you select SYBR® Green as the reagent, then you have the option of including a melt curve for that experiment.

Define the instrument run properties
1. Select the ramp speed for the experiment:
   - Standard
   - Fast
2. For Genotyping and Presence/Absence experiments, select the options for the data collection to include in the experiment run:
   - Pre-PCR Read - to include data before amplification occurs. Use the data collected during pre-PCR read to normalize fluorescence data collected during post-PCR read.
   - Amplification - to include real-time data.
   - Post-PCR Read - to include data after amplification has taken place.
3. (Optional) For real-time data collection, you can change the default analysis settings in the Preferences for the following:
   - Automatic analysis
   - Automatic save
   - Baseline settings

Go to Tools > Preferences. Click the Experiment tab. Select the Auto Analysis and Auto Save check boxes for the QuantStudio™ 12K Flex Software to automatically analyze and save experiment results. You can also edit the following default baseline settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Cycle Number</td>
<td>3 (default)</td>
</tr>
<tr>
<td>End Cycle Number</td>
<td>15 (default)</td>
</tr>
</tbody>
</table>

Note: By default, the Auto Analysis and Auto Save check boxes are selected.
4. For the Melt Curve experiment, select the **Include PCR** check box, to include PCR.

5. Save the experiment. The default file name (\.eds extension) is the experiment name that you entered when you set up the experiment and saved it for the first time. Changes to the experiment name after the first save do not update the file name. To change the file name, select **File > Save As**.

The Experiment Properties screen for a Standard Curve experiment is shown in the following graphic:

**Define targets, samples, and biological replicate groups**

Use the Define screen to define targets, samples and biological replicates for your experiment. For Genotyping experiments, use this screen to specify the number of SNP assays to include in the experiment.

**Note:** You can start a run without these definitions, but there will be no real-time data in the amplification plots (the amplification plots can be seen only after you have set up the plate).

1. Click **Define** to access the Define screen.
2. Define targets.
   a. Click **New** to add targets and define them.
   b. In the target table, click a cell in the Target Name column for the target, then enter your target name. The default name is Target 1.
   c. Select the **Reporter** and **Quencher** from the respective drop-down menu.
      **Note:** The default reporter and quencher dyes used depend on the reagent selected during experiment setup. For example, if TaqMan® is the selected reagent, the default reporter FAM and default quencher is **NFQ-MGB**.
   d. Select the target **Color** from the drop-down menu.
   e. (Optional) Click **Save to Library** to save the newly added or existing edited targets to the target library.
      **Note:** Use the targets from the Target Library to avoid re-entering the information. See “(Optional) Use libraries when designing your own experiments” on page 19 for information on target libraries.
f. Click **Import from Library** to add targets from the target library.

3. Define samples.
   a. Click **New** to add samples and name them.
   b. In the samples table, click a cell in the Sample Name column for the sample to define and enter your sample name. The default sample name is Sample 1.
   c. Select the sample **Color** from the drop-down menu.
   d. (Optional) Click **Save to Library** to save the newly added or existing edited samples to the sample library.

   **Note:** Use the samples from the Sample Library to avoid re-entering the information. See “(Optional) Use libraries when designing your own experiments” on page 19 for information on sample libraries.

   e. Click **Import from Library** to add samples from the sample library.

4. Define biological replicates.
   a. In the Define Biological Replicates Groups table, click **New** to add biological replicate group and name them. You can enter up to 100 characters in this field.
   b. Select the **Color** from the drop-down menu.
   c. Click in the **Comments** column to add comments for that biological replicate group.

5. Select the Passive Reference from the drop-down menu.
   The Define screen for a Standard Curve experiment is shown in the following graphic:
Assign targets, samples, and biological replicate groups

Use the Assign screen to assign targets, samples, and biological replicate groups to wells in the reaction plate. For Genotyping experiments, use this screen to assign SNP assays.

**Note:** You can start a run without these assignments, but there will be no real-time data in the amplification plots (the amplification plots can be seen only after you have set up the plate).

1. Click **Assign** to access the Assign screen.

2. Assign targets.
   a. Select wells using the plate layout or the well table on the Assign screen.
   b. Select a target and assign its task, in the plate, from the drop-down menu. Depending on the experiment type, options are:

<table>
<thead>
<tr>
<th>Experiment type</th>
<th>Legend</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Curve</td>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>S</td>
<td>Standard</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Negative Control</td>
</tr>
<tr>
<td>Relative Standard Curve</td>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>S</td>
<td>Standard</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Negative Control</td>
</tr>
<tr>
<td>Comparative CT</td>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Negative Control</td>
</tr>
<tr>
<td>Genotyping</td>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>1/1</td>
<td>Positive Control Allele 1/ Allele 1</td>
</tr>
<tr>
<td></td>
<td>2/2</td>
<td>Positive Control Allele 2/ Allele 2</td>
</tr>
<tr>
<td></td>
<td>1/2</td>
<td>Positive Control Allele 1/ Allele 2</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>No Template Control</td>
</tr>
<tr>
<td>Presence/ Absence</td>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>I</td>
<td>Internal Positive Control</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Negative Control</td>
</tr>
<tr>
<td></td>
<td>⚫</td>
<td>Blocked Internal Positive Control</td>
</tr>
<tr>
<td>Melt Curve</td>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Negative Control</td>
</tr>
</tbody>
</table>

3. Assign Samples.
Chapter 1  General Information and Instructions

Set up an experiment

1. **Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments**

   1. **Chapter 1**

   2. **General Information and Instructions**

   3. **Set up an experiment**

      a. Select wells using the plate layout or the well table on the Assign screen.

      b. Select the check box next to the sample to assign to the selected wells.

         **Note:** You can assign only one sample to a well.

4. **Assign Biological Replicate Groups.**

   a. Select wells using the plate layout or the well table on the Assign screen.

   b. Select the check box next to the biological replicate group to assign to the selected wells.

   The Assign screen for a Standard Curve experiment is shown in the following graphic:

   ![Assign screen graphic](image-url)
Assign targets, samples, and biological replicate groups - Alternate procedure

As shown in the following graphics, you can also paste assignment information from an *.xls file into the plate layout of the QuantStudio™ 12K Flex Software for wells with single targets.

**Note:** You must select the header, and the Well Number and Well Position columns while copying information from the *.xls file.

**Note:** Any of the columns not copied are treated as NULL values for those columns.
Define the run method

Use the Run Method screen to set up the run method for your own experiments in the QuantStudio™ 12K Flex Software.

1. Click Run Method to access the Run Method screen.
   
   **Note:** You can save multiple run methods to the Run Method Library for later use. See “(Optional) Use libraries when designing your own experiments” on page 19 for information on run method libraries.

2. Enter a number from 1 to 20 for the reaction volume per well. The QuantStudio™ 12K Flex Instrument supports the following maximum reaction volumes for the consumables listed below:

   - MicroAmp® Optical 384-Well Reaction Plate - 30 µL
   - Applied Biosystems Array Card - 1 µL
   - MicroAmp® Optical 96-Well Reaction Plate (0.2 mL)- 200 µL
   - MicroAmp® Optical 96-Well Reaction Plate (0.1 mL)- 100 µL
   - MicroAmp® Optical 8-Tube Strip with cap (0.2 µL)-200 µL
   - MicroAmp® Fast 8-Tube Strip with cap (0.1 µL)-100 µL
   - MicroAmp® Optical Reaction Tube without cap (0.2 µL)-200 µL
   - MicroAmp® Fast Reaction Tube without cap (0.1 µL)-100 µL

3. In the Graphical View tab, review and, if necessary, edit the run method.

   - Make sure that the thermal profile is appropriate for your reagents.
   - Edit the default run method or replace it with one from the run method library included in the QuantStudio™ 12K Flex Software.
   - Enable data collection by clicking .
     
     **Note:** Enabling data collection is especially useful when you later need to analyze data collected in real-time during the various stages.
   - Edit the ramp rate. You can increase or decrease the ramp rate for a stage.
     
     **Note:** Ramp rates are decimal numbers from 0.015—3.4.
• Edit the PCR Stage.
• Change the Number of Cycles for the PCR stage.
• Select the Enable AutoDelta check box, to increase or decrease the temperature and/or hold time for each subsequent cycle or to change the Starting Cycle for AutoDelta. Enabling AutoDelta displays the ▲ icon. Click the AutoDelta Off ▲ icon to change the AutoDelta settings for the cycling stage in the AutoDelta Settings dialog box. Then, click Save Setting to display the AutoDelta On ▲ icon.

![AutoDelta Settings](image)

**Note:** If you selected SYBR® Green as the reagent, the Melt Curve stage automatically appears in the Run Method screen. If you delete the Melt Curve Stage section from the protocol, then the melt curve is active in the Add Stage drop-down menu.

4. Complete the tasks on the Optical Filters tab:
   By default, the Optical Filters tab is not visible. To show the Optical Filters tab, go to **Tools ➔ Preferences**, and select the Show optical filters for run method check box under the Non-OpenArray tab.

![Filter Settings](image)

• To add a new filter set to the filter set library, click Save.
• To load a saved filter set, click Load.
• To go back to the original filter set combinations, click Revert to Defaults.

Note: Select the filter set that matches the profile of the dye you have added to the plate. Refer to the Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System Maintenance and Administration Guide for information on the emission spectrum for each dye, and the filter at which each dye is read.

(Optional) Use libraries when designing your own experiments

The QuantStudio™ 12K Flex Software allows you to save information to libraries, so you can easily use the information again when setting up an experiment. The libraries include:

- Targets library
- Samples library
- SNP Assay library (only available for Genotyping experiments)
- Run Method library

Target, Sample, and SNP Assay libraries

You can access the Targets, Samples, and SNP Assay libraries from the Tools menu to add, edit, delete, and import or export items. You can also access a library by clicking Import from Library in the Define screen when you are setting up an experiment.

Run Method library

You can use the Run Method library from the Run Method screen to:

- Save a new run method for later use.
- To select an existing run method for an experiment.

To add a run method to the Run Method Library:

1. Click Save Run Method in the toolbar of the Graphical View tab on the Run Method screen.
2. Enter a name and description (optional) for the run method, then click **Save**.

To select a run method from the Run Method Library

Click **Open Run Method** on the Run Method screen, and select one from the saved run methods.

## Prepare reactions

**Supported consumables**

The QuantStudio™ 12K Flex Instrument is optimized for Applied Biosystems consumables. These can be ordered from the Life Technologies website. Use the consumables appropriate for the sample block of your instrument.

<table>
<thead>
<tr>
<th>Sample block</th>
<th>Consumable</th>
<th>Maximum reaction volume (µL) supported</th>
<th>Recommended reaction volume (µL)</th>
</tr>
</thead>
</table>
| 384-Well Plate     | MicroAmp® Optical 384-Well Reaction Plate  
|                    | MicroAmp® Optical Adhesive Film      | 30                                    | 5-20                            |
| Array Card         | Applied Biosystems Array Card       | 1                                     | 1                               |

![Image of a 384-Well Plate]

![Image of an Array Card]

## Chapter 1 General Information and Instructions

### Prepare reactions

<table>
<thead>
<tr>
<th>Sample block</th>
<th>Consumable</th>
<th>Maximum reaction volume (µL) supported</th>
<th>Recommended reaction volume (µL)</th>
</tr>
</thead>
</table>
| 96-Well Plate (0.2 mL) | • MicroAmp® Optical 96-Well Reaction Plate  
• MicroAmp® Optical Adhesive Film  
• MicroAmp® 96-Well Support Base (only used during sample preparation)  
• QuantStudio™ 12K Flex System 96-Well Plate Adaptor | 200 | 10-100 |
| Fast 96-Well Plate (0.1 mL) | • MicroAmp® Fast Optical 96-Well Reaction Plate  
• MicroAmp® Optical Adhesive Film  
• MicroAmp® 96-Well Support Base (only used during sample preparation)  
• QuantStudio™ 12K Flex System Fast 96-Well Plate Adaptor | 100 | 10-30 |
### Chapter 1 General Information and Instructions

**Prepare reactions**

<table>
<thead>
<tr>
<th>Sample block</th>
<th>Consumable</th>
<th>Maximum reaction volume (µL) supported</th>
<th>Recommended reaction volume (µL)</th>
</tr>
</thead>
</table>
| 96-Well Plate (0.2 µL) and Fast 96-Well plate (0.1 µL) | • MicroAmp® Optical 8-Cap Strip  
• MicroAmp® Optical 8-Tube Strip (0.2 µL)/MicroAmp® Fast 8-Tube Strip (0.1 µL)  
• MicroAmp® 96-Well Tray/Retainer Set (Blue) (0.2 µL)/MicroAmp® 96-Well Tray (Black) (0.1 µL)  
• MicroAmp® 96-Well Support Base (only used during sample preparation)  
• QuantStudio™ 12K Flex System 96-Well Tube Adaptor/QuantStudio™ 12K Flex System Fast 96-Well Tube Adaptor | • 100 for Fast 96-well plate  
• 200 for 96-well plate | • 10-30 for Fast 96-well plate  
• 10-100 for 96-well plate |

| 96-Well Plate (0.2 µL) and Fast 96-Well plate (0.1 µL) | • MicroAmp® Optical Tube without cap (0.2 µL)/MicroAmp® Fast Reaction Tube without Cap (0.1 µL)  
• MicroAmp® Optical 8-Cap Strip  
• MicroAmp® 96-Well Support Base (only used during sample preparation)  
• MicroAmp® 96-Well Tray/Retainer Set (Blue) (0.2 µL)/MicroAmp® 96-Well Tray (Black) (0.1 µL)  
• QuantStudio™ 12K Flex System 96-Well Tube Adaptor/QuantStudio™ 12K Flex System Fast 96-Well Tube Adaptor | • 100 for Fast 96-well plate  
• 200 for 96-well plate | • 10-30 for Fast 96-well plate  
• 10-100 for 96-well plate |

**WARNING!** Make sure that you use the flat caps for 0.2 µL tubes and 0.1 µL tubes. Use of rounded caps damages the heated cover.
Life Technologies supports the reagents listed below for experiments performed on the QuantStudio™ 12K Flex System.

<table>
<thead>
<tr>
<th>Experiment</th>
<th>Reagent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Curve</td>
<td>• Applied Biosystems TaqMan® Reagents</td>
</tr>
<tr>
<td></td>
<td>• Applied Biosystems SYBR® Green reagents</td>
</tr>
<tr>
<td></td>
<td>• Other reagents</td>
</tr>
<tr>
<td>Relative Standard Curve</td>
<td>• Applied Biosystems TaqMan® Reagents</td>
</tr>
<tr>
<td></td>
<td>• Applied Biosystems SYBR® Green reagents</td>
</tr>
<tr>
<td></td>
<td>• Other reagents</td>
</tr>
<tr>
<td>Comparative C_T (ΔΔC_T)</td>
<td>• Applied Biosystems TaqMan® Reagents</td>
</tr>
<tr>
<td></td>
<td>• Applied Biosystems SYBR® Green reagents</td>
</tr>
<tr>
<td></td>
<td>• Other reagents</td>
</tr>
<tr>
<td>Melt Curve</td>
<td>• Applied Biosystems SYBR® Green reagents</td>
</tr>
<tr>
<td></td>
<td>• Other reagents</td>
</tr>
<tr>
<td>Genotyping</td>
<td>• Applied Biosystems TaqMan® Reagents</td>
</tr>
<tr>
<td></td>
<td>• Other reagents</td>
</tr>
<tr>
<td>Presence/Absence</td>
<td>• Applied Biosystems TaqMan® Reagents</td>
</tr>
<tr>
<td></td>
<td>• Other reagents</td>
</tr>
</tbody>
</table>

**Note:** Fast Universal Master Mix is not recommended to be used with the 96-well (0.2 µL) reaction plates or reaction tubes and tube strips sealed with caps.

**Reagent detection process**

**Applied Biosystems TaqMan® Reagents**

**Description**

TaqMan® reagents use a fluorogenic probe to enable detection of a specific PCR product as it accumulates during PCR cycles.

**Advantages**

- Increased signal specificity with the addition of a fluorogenic probe.
- Multiplex capability.
- Optional preformulated assays, optimized to run under universal thermal cycling conditions, are available.
- Can be used for either 1- or 2-step RT-PCR.

**Limitations**

Require synthesis of a unique fluorogenic probe.
Prepare reactions

TaqMan® Reagents detection process

**PCR and detection of cDNA**

- **a. Assay components**
- **b. Denatured template and annealing of assay components**
- **c. Signal generation**

---

**Applied Biosystems SYBR® Green reagents**

**Description**

SYBR Green reagents use SYBR® Green I dye, a double-stranded DNA binding dye, to detect PCR products as they accumulate during PCR cycles.

**Advantages**

- Economical (no probe needed).
- Allow for melt curve analysis to measure the Tm of all PCR products.
- Can be used for either 1- or 2-step RT-PCR.

**Limitations**

Bind nonspecifically to all double-stranded DNA sequences. To avoid erroneous information signals, check for nonspecific product formation using melt curve or gel analysis.
Chapter 1 General Information and Instructions

Prepare reactions

SYBR® Green detection process

Step 1: Reaction setup
The SYBR® Green I dye fluoresces when bound to double-stranded DNA.

Step 2: Denaturation
When the DNA is denatured into single-stranded DNA, the SYBR® Green I dye is released and the fluorescence is drastically reduced.

Step 3: Polymerization
During extension, primers anneal and PCR product is generated.

Step 4: Polymerization completed
SYBR® Green I dye binds to the double-stranded product, resulting in a net increase in fluorescence detected by the instrument.

Precautions while preparing reactions

- Make sure that you do not prepare the reactions on a wet table. Wet surfaces lead to contamination of your reactions.
- Wear appropriate protective eyewear, clothing, and powder-free gloves.
- Make sure that you use the appropriate consumables. The quality of pipettors and tips and the care used in measuring and mixing dilutions affect data accuracy.
- Make sure that you perform dilutions exactly as instructed. Mistakes or inaccuracies in making the dilutions directly affect the quality of results.
- Use a permanent marker or pen to mark a tube and the side of a plate or array card. Do not use fluorescent markers.
- Make sure that the arrangement of the PCR reactions matches the plate layout displayed in the QuantStudio™ 12K Flex Software.

Materials required while preparing the dilutions

- DI water or DEPC water
- Microcentrifuge tubes
- Pipettors
- Pipette tips
- Vortex mixer
- Centrifuge
- Sample stock
Prepare reactions

- Standard stock
- Reaction mix components
- Plate or array card

Guidelines for preparing the dilutions, reaction mix, and plate

- Include excess volume in your calculations to provide excess volume for the loss that occurs during reagent transfers.
- Use TE buffer or water to dilute the standards and samples.
- Prepare the reagents according to the manufacturer’s instructions.
- Keep the dilutions and assay mix protected from light, in the freezer, until you are ready to use it. Excessive exposure to light may affect the fluorescent probes or dyes.
- Prior to use:
  - Mix the master mix thoroughly by swirling the bottle.
  - Resuspend the assay mix by vortexing, then centrifuge the tube briefly.
  - Thaw any frozen samples by placing them on ice. When thawed, resuspend the samples by vortexing, then centrifuge the tubes briefly
- Do not allow the bottom of the reaction plate to become dirty. Fluids and other contaminants that adhere to the bottom of the reaction plate can contaminate the sample block(s) and cause an abnormally high background signal.

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Correct Image]</td>
<td>![Incorrect Image]</td>
</tr>
</tbody>
</table>
| Liquid is at the bottom of the well. | Not centrifuged with enough force
Or
Not centrifuged for enough time |

- For Genotyping experiments, prepare the reactions for each SNP separately.
- Place the reaction plate or array card at 4°C and in the dark until you are ready to load it into the instrument

Seal the reaction plate

If you use optical adhesive film to seal your reaction plates, seal each reaction plate as follows:

**Note:** The sealing instructions are applicable to 384-well and 96-well reaction plates.

1. Load the reaction plate using the plate layout described in “Assign targets, samples, and biological replicate groups” on page 14.

**Note:** For 96-well reaction plates, place the reaction plate onto the center of the 96-well base, then perform this step. Be sure that the reaction plate is flush with the top surface of the 96-well base.
Note: You can also use the MicroAmp® Optical 8-Cap Strip to seal the 96-well reaction plates.

2. Remove a single optical adhesive film from the box. Bend both end-tabs upward. Hold the film backing side up.

3. In one swift movement, peel back the white protective backing from the center sealing surface. Do not touch the center sealing surface.

IMPORTANT! Improper peeling of the optical adhesive film may result in haziness, but it will not affect results. Haziness disappears when the film comes into contact with the heated cover in the instrument.

4. Holding the film by the end-tabs, lower the film onto the reaction plate (adhesive side facing the reaction plate). Make sure that the film completely covers all wells of the reaction plate.

5. Applying firm pressure, move the applicator slowly across the film, horizontally and vertically, to ensure good contact between the film and the entire surface of the reaction plate.
6. Using the applicator to hold the edge of the film in place, grasp one end of the end-tab and pull up and away sharply. Repeat for the other end-tab.

**Note:** Ensure clean removal of both end-tabs from the dotted line. Improper peeling of the end-tab can cause sticking of plate on the heated cover assembly.

7. To ensure a tight, evaporation-free seal, repeat **Applying firm pressure, move the applicator slowly across the film, horizontally and vertically, to ensure good contact between the film and the entire surface of the reaction plate.**

   Applying firm pressure, run the edge of the applicator along all four sides of the outside border of the film.

   **Note:** Optical adhesive films do not adhere on contact. The films require the application of pressure to ensure a tight, evaporation-free seal.

8. Inspect the reaction plate to be sure that all wells are sealed. You should see an imprint of all wells on the surface of the film. Check for the perforated tab to be completely torn off to avoid plates from sticking to the instrument after a run.

**IMPORTANT!** Remove all excess adhesive from the perimeter of the optical adhesive cover. When the film is applied, the glue from the optical adhesive cover can adhere to the edges of the plate. If the excess glue is not removed, the plate may adhere to the gripper of the Twister® Robot or to the sample block of the QuantStudio™ 12K Flex Instrument.
Fill and seal the array card

**IMPORTANT!** Wear powder-free gloves while preparing the Arrays.

1. Remove an array card from its box and place it on a clean, dry surface.
2. Using a permanent marker, mark the side of the empty array cards.
3. Transfer the experiment-related chemistries and solutions into the port of the array card.
   For each transfer:
   a. Place the array card on a lab bench, with the foil side down.
   b. Load 100 µL of fluid into a pipette.
   c. Hold the pipette in an angled position (~45 degrees) and place the tip into the fill port. There is a fill port on the left arm of each fill reservoir – it is the larger of the two holes.
      Do not allow the tip to contact and possibly damage the coated foil beneath the fill port.
   d. Dispense the fluid so that it sweeps in and around the fill reservoir toward the vent port. Pipette fluid into the fill reservoir, but do not go past the first stop of pipettor plunger when pipetting the reagents into the array card, or you may blow the solution out of the port.

**IMPORTANT!** Do not allow the tip to contact and possibly damage the coated foil beneath the fill port.

Fill and spin the array card
4. Place the filled array card(s) into a centrifuge array card carrier clip and place empty array card(s) in the remaining slots. Make sure that the labels on the buckets and clips face the same way.

**IMPORTANT!** Make sure to balance the loads in opposite buckets in the centrifuge.

5. Place the filled carrier clips into the centrifuge buckets. Make sure that the array-card fill reservoirs and bucket and clip labels face outward when loaded into the centrifuge. Balance the loads in opposite buckets.

**IMPORTANT!** You must run the centrifuge with all four buckets in place and each of the two carriers filled with the array card. Place empty array cards (4-pack PN 4334812 and 1-pack PN 4351471) into unfilled slots.

6. Close the centrifuge cover, then spin the array card(s) for 1 minute at 1200 rpm.

7. When the run is finished, stop the centrifuge, then spin the array card(s) again for 1 minute at 1200 rpm.

**IMPORTANT!** Do not try to save time by doing one spin for 2 minutes. The two sets of ramps are important for a good fill into the array card.

8. When the second run is finished, open the centrifuge and check that the fluid levels in the reservoirs of each array card have decreased by the same amount. Also, check for the formation of bubbles in all wells and note possible problems.

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Correct" /></td>
<td><img src="image2.png" alt="Incorrect" /></td>
</tr>
</tbody>
</table>

9. If necessary, centrifuge the array card(s) for an additional minute to fill any unfilled wells. Do not exceed three 1-minute runs or centrifuge the array card for longer than 1 minute at a time.

**Note:** Visit the Life Technologies website, log on to store, and view an online video of loading, centrifuging, and sealing an array card.
Seal the array card(s)

1. With the carriage (roller assembly) of the TaqMan® Array Micro Fluidic Card Sealer in the Start position, place a filled array card into the fixture with the foil side up so that the fill reservoirs are the farthest away from the carriage.

2. Press down on all four corners of the array card to ensure that it is fully seated within the fixture.

3. Use the two alignment pins in the fixture to position the array card correctly.

4. Seal the array card by running the carriage slowly over it, in one direction only. Do not apply downward force on the carriage as you move it forward over the card.

5. Remove the sealed array card from the fixture and trim the fill reservoirs from the array card assembly using scissors. Trim the foil array card so that the edge is even with the plastic carrier.
**Prepare reactions**

**IMPORTANT!** Completely remove the fill reservoirs from the array card so that the edge is free of residual plastic. The plastic from the fill reservoirs that extends beyond the edge of the card can prevent the card from seating properly on the sample block and affect amplification.

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Correct Image" /></td>
<td><img src="image2" alt="Incorrect Image" /></td>
</tr>
</tbody>
</table>

**IMPORTANT!** As you seal the remaining filled array cards, store them in a dark place until you are ready to use them. The fluorescent dyes in the array card are photosensitive. Prolonged exposure to light can diminish the fluorescence of the dye.

**Capping and uncapping the 96-well reaction tubes and tube strips**

**Note:** Make sure that you secure the caps on the tubes and tube-strips tightly to avoid sample evaporation.

If you use the 96-well MicroAmp® Optical 8-Tube Strips or MicroAmp® Optical Tubes without Cap, use the MicroAmp® Cap Installing Tool (PN 4330015) and follow the instructions below for:

- Applying the MicroAmp® Optical 8-Cap Strip or MicroAmp® Optical Tubes without Cap to the tubes
- Removing a cap string from a plate

**Required materials:**
- MicroAmp® Cap Installing Tool
- MicroAmp® Optical 8-Tube Strips or MicroAmp® Optical Tubes without cap
- MicroAmp® Optical 8-Cap Strip

---

Apply the MicroAmp® Optical 8-Cap Strip (flat)

1. Grasp the Cap Installing Tool so that the grooved side is exposed.
2. Hold the strip of caps over the tube strip or the row of tubes.
3. Use the grooved side (shown) of the Cap Installing Tool to push and seat each cap firmly in place. Use a rocking motion to properly seat each cap.

Remove a cap string from a plate

The MicroAmp® Cap Installing Tool is also used for removing the MicroAmp® Optical 8-Cap Strip from the 96-well optical plates and tray/retainer assemblies. To remove the cap or cap strip:

1. Insert the small protrusions on the side of the Cap Installing Tool under the webbing between the caps on a cap strip.
2. Slowly pry the strip from the plate or Tray/ Retainer assembly.

Start the experiment

To start an experiment:

1. Access the Instrument Console.
2. Load the reaction plate or array card into the instrument, as shown on page 37.
3. Run the experiment as shown on page 39.
Instrument Console

The Instrument Console displays all the QuantStudio™ 12K Flex Instruments discovered on a network.
Left panel

The features on the left panel of the Instrument Console allow:

- Instrument access: Open and close the QuantStudio™ 12K Flex Instrument door from the QuantStudio™ 12K Flex Software user interface.
- Group management:
  - Create, rename, and delete groups and assign instruments to the groups.
  - Add and remove instruments to and from My Instruments.
    - **Note:** To add instruments, select the icon of the QuantStudio™ 12K Flex Instrument that you want to add to the My Instruments list. Then click **Add to My Instruments.** Similarly, click **Remove from My Instruments** to remove an instrument from the My Instruments list. You can also drag and drop the instrument icon into My Instruments or into the group created by you.
  - Display instrument groups from the Display Group drop-down menu according to their activity. Select the status from the Filtered By drop-down menu. For more information on the status of an instrument, see “Monitor the experiment” on page 40.
- Instrument management:
  - Monitor experiments (check the run status or monitor a temperature plot or amplification plot during a run). For more information on monitoring experiments, see “Monitor the experiment” on page 40.
  - Maintain instruments (check the calibration status of instruments and perform different calibrations). For more information on Instrument maintenance, refer to *Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System Maintenance and Administration Guide*.
  - Manage files (upload setup files; download completed experiments; and create, rename, and delete experiment files and plate setup folders).
    - **Note:** Completed experiments are downloaded into the default folder **Completed Experiments.**
    - **Note:** To manage files, click **Manage Instrument.**
      Use the File Manager to create, rename or delete folders for holding setup files for starting a run or completed experiments for analysis. To move setup files from one folder to the other, click **Move** and select the setup folder you want to shift the setup file into.

**IMPORTANT!** To Manage and Monitor, you must move instruments from On the Network to My Instruments or a custom group. You can start a run and calibrate instruments present only in the My Instruments group or the custom group(s) that you created.

Right panel

The right panel of the Instrument Console displays:

- The name of the instrument whose instrument icon is selected.
- The run status of the selected instrument.
• The group the instrument belongs to.
• The calibration status, maintenance reminders and instrument properties of the selected instrument.

The calibration status is indicated by the ⚠ icon. The icon appears in the Status column of the Calibration Status table after the last reminder date before the calibration expires.

Status icons

You can monitor the instrument status and view calibration and other information in the Instrument Console.

QuantStudio™ 12K Flex Instrument status icon

The status of an instrument is represented by an icon in the top-right corner of the thumbnail representation of the instrument on the Instrument Console. An instrument displays the status when you place the instrument icon under My Instruments or under the Group(s) that you created.

To monitor the instrument status:

1. On the Home tab ( ), select Instrument Console. If you do not see an instrument, click Refresh in the instrument console toolbar.

2. If needed, move the instrument from the On the Network group to a group which can be monitored:
   a. Click the instrument of interest, then click Assign to Group in the instrument console toolbar.
   b. Select the My Instruments or a personal group in the drop-down list. The instrument is now monitored.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Instrument status</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Ready Icon" /></td>
<td>Ready</td>
</tr>
<tr>
<td><img src="image" alt="Available on Network Icon" /></td>
<td>Available on the network but cannot be monitored because that instrument is not under My Instruments or a group you created.</td>
</tr>
<tr>
<td><img src="image" alt="Run in Process Icon" /></td>
<td>Run in process (The time remaining for the run is shown to the left of the icon.)</td>
</tr>
<tr>
<td><img src="image" alt="Unavailable Icon" /></td>
<td>Unavailable</td>
</tr>
<tr>
<td><img src="image" alt="Incompatible Firmware Icon" /></td>
<td>Incompatible firmware version</td>
</tr>
<tr>
<td><img src="image" alt="No Longer Connected Icon" /></td>
<td>No longer connected to the network</td>
</tr>
</tbody>
</table>
Load the reaction plate or array card into the instrument

**CAUTION! PHYSICAL INJURY HAZARD.** During instrument operation, the temperature of the sample block(s) can exceed 100 °C. Keep your hands away until the sample block(s) reaches room temperature.

**IMPORTANT!** Wear powder-free gloves when you handle the reaction plate or array card.

**IMPORTANT!** Plates and array cards should be loaded and unloaded by operators who have been warned of the moving parts hazard and have been adequately trained.

1. Touch 🕵️‍♂️ on the QuantStudio™ 12K Flex Instrument touchscreen or click **Open Door** in the Instrument Console screen of the QuantStudio™ 12K Flex Software to allow the plate adapter to come out from the instrument side.
2. Place the reaction plate or array card on the plate adapter. Ensure that the reaction plate or array card is properly aligned in the holder.
   - Make sure the well A1 is positioned at the top-left of the tray for any of the plate formats.
   - Make sure the barcode (for any of the plate formats) is facing the front of the instrument.
   - If using reaction tubes or tube strips, make sure you use adaptors. The adaptors are attached to the plate transport arm. The tray containing the tubes or tube strips must be placed on the adaptor and not into the sample block directly.

   **IMPORTANT!** For optimal performance with partial loads, load at least 16 tubes and arrange them in:
   - Adjacent columns of 8 tubes, using rows A through H. For example, use wells in columns 6 and 7 (rows A through H).
   - Or
   - Adjacent rows of 8 tubes, using columns 3 through 10. For example, use wells in row D (columns 3 through 10) and row E (columns 3 through 10).

   **WARNING!** Make sure that you use the flat caps for the 0.2µL tubes and 0.1µL tubes. Use of rounded caps damages the heated cover.

3. Touch the QuantStudio™ 12K Flex Instrument touchscreen or click Close Door in the Instrument Console screen of the QuantStudio™ 12K Flex Software to retract the plate adapter back into the instrument.

You can configure the QuantStudio™ 12K Flex Software to alert you by email when the QuantStudio™ 12K Flex Instrument begins and completes a run, or if an error occurs during a run.

**Note:** For details on using the Notification Settings feature, refer to the *Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System Maintenance and Administration Guide.*
You can run the experiment in either of the following two ways:

- From the QuantStudio™ 12K Flex Software
- From the QuantStudio™ 12K Flex Instrument touchscreen

**Note:** The example experiments in each of the getting started guide booklets start a run from the QuantStudio™ 12K Flex Software.

**IMPORTANT!** Make sure that instrument calibration is up-to-date. If a calibration has expired, you will get a warning when you start a run. For information on calibrating the QuantStudio™ 12K Flex Instrument, refer to Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System Maintenance and Administration Guide.

**IMPORTANT!** Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 12K Flex Instrument is in operation.

### From the QuantStudio™ 12K Flex Software

1. In the QuantStudio™ 12K Flex Software, click **Run** in the navigation pane.

2. Click **START RUN**. Select the instrument for the run from the drop-down menu of the instruments placed under My Instruments.

**IMPORTANT!** Make sure that the instrument to run the experiment on is in My Instruments or the custom group, and that it is ready to run an experiment. If the preferred instrument is not present under My Instruments or the custom group, or if it is unavailable, clicking START RUN does not display instrument names in the drop-down menu.

### From the QuantStudio™ 12K Flex Instrument touchscreen

1. Touch the QuantStudio™ 12K Flex Instrument touchscreen to awaken it. **Note:** If the touchscreen is not at the Main Menu screen, touch ★.

2. In the Main Menu screen, touch **Browse Experiments**.

3. In the Browse screen, touch **Folders**, to display the folders containing the experiment setup files.

4. Touch any of the folder names to display the experiments in that folder.
5. In the Experiments screen, select the desired experiment, then touch **View/Edit** to view or edit the experiment before starting the run.

**Note:** You can start a run immediately by clicking **Start Run**, then go to the **Start Run screen**, touch each field as needed to modify the associated parameter, then touch **Start Run Now** to start the experiment.

6. (Optional) Modify the experiment parameters as needed. You can use the:
   - **Add** and **Delete** buttons to add and delete a stage or step to the thermal profile.
   - **Add Melt Curve** button to add a melt curve to the thermal profile.
   - **Save** button to save the experiment you modify.

7. In the Save Experiment screen, touch each field to edit the:
   - Experiment name
   - Folder to save the experiment
   - Reaction volume
   - Barcode Number
   - Notes

When finished, touch **Save & Start Run** to start the experiment.

8. In the Start Run screen, touch each field as needed to modify the associated parameter, then touch **Start Run Now** to start the experiment.

**Note:** When the run is complete, touch to unload the plate from the instrument. You can download the results of the experiment from a computer if the instrument is connected to a network, or copy the data to a USB device as explained in “Transfer experiment results” on page 47.

---

### Monitor the experiment

**Note:** If there is loss of connection during an experiment, remove and then add the instrument to the My Instruments list. You may then resume monitoring the experiment.

You can monitor an experiment run in three ways:

- From the QuantStudio™ 12K Flex Instrument touchscreen, in the same way that you run the experiment (see “From the QuantStudio™ 12K Flex Instrument touchscreen” on page 39).
- From the Run screen of the QuantStudio™ 12K Flex Software, while the experiment is in progress, as shown below.
- From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor an experiment started from another computer or from the QuantStudio™ 12K Flex Instrument touchscreen) as described in “From the QuantStudio™ 12K Flex Software Instrument Console” on page 41.

### From the QuantStudio™ 12K Flex Software Run screen

1. Click **Amplification Plot** from the Run Experiment Menu to monitor the amplification plot of the experiment you are running.

**Note:** For Melt Curve experiments, click **Melt Curve Plot** from the Run Experiment Menu.
2. Click **Temperature Plot** from the Run Experiment Menu to monitor the temperature plot of the experiment you are running.

**From the QuantStudio™ 12K Flex Software Instrument Console**

1. In the Instrument Console screen, select the icon of the instrument that you are using to run the experiment.
2. Click **Manage Instrument**.
3. On the Instrument Manager screen, click **Monitor Running Instrument**.

You can view the progress of the run in real time from the Run screen. During the run, periodically view the Amplification Plot, Temperature Plot and Run Method (see page 42) available from the QuantStudio™ 12K Flex Software for potential problems.

<table>
<thead>
<tr>
<th>To...</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop the run</td>
<td>• In the QuantStudio™ 12K Flex Software, click <strong>STOP RUN</strong>.</td>
</tr>
<tr>
<td></td>
<td>• In the Stop Run dialog, click one of the following:</td>
</tr>
<tr>
<td></td>
<td>– <strong>Stop Immediately</strong> to stop the run immediately.</td>
</tr>
<tr>
<td></td>
<td>– <strong>Cancel</strong> to continue the run.</td>
</tr>
<tr>
<td>View amplification data in real time</td>
<td>Select <strong>Amplification Plot</strong>.</td>
</tr>
<tr>
<td></td>
<td>See “To monitor the Amplification Plot” on page 42.</td>
</tr>
<tr>
<td>View temperature data for the run in real time</td>
<td>Select <strong>Temperature Plot</strong>.</td>
</tr>
<tr>
<td></td>
<td>See “To monitor the Temperature Plot” on page 42.</td>
</tr>
<tr>
<td>View progress of the run in the Run Method screen</td>
<td>Select <strong>Run Method</strong>.</td>
</tr>
<tr>
<td></td>
<td>See “To monitor the Run Method” on page 43.</td>
</tr>
<tr>
<td>Enable/disable the Notification Settings</td>
<td>Select or deselect <strong>Enable Notifications</strong>.</td>
</tr>
<tr>
<td></td>
<td>See “Enable or change the Notification Settings” on page 38.</td>
</tr>
</tbody>
</table>

**Note:** The individual experiment booklets provide illustrations of the different experiments in real time.

**Note:** For Melt Curve experiments, click **Melt Curve Plot** from the Run Experiment Menu.
The Run screen for a Standard Curve experiment run looks like this:

To monitor the Amplification Plot

To view data in the Amplification Plot, click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab, then select the wells to view.

The Amplification Plot screen allows you to view sample amplification as your instrument collects fluorescence data during a run. If a method is set up to collect real-time data, the Amplification Plot screen displays the data for the wells selected in the Plate Layout tab. The plot contrasts normalized dye fluorescence (ΔRn) and cycle number.

The Amplification Plot screen is useful for identifying and examining abnormal amplification, including:

- Increased fluorescence in negative control wells.
- Absence of detectable fluorescence at an expected cycle (determined from previous similar experiments run using the same reagents under the same conditions).

Note: If you notice abnormal amplification or a complete absence of signal, troubleshoot the error as explained in the QuantStudio™ 12K Flex Software Help (click ? or press F1).

To monitor the Temperature Plot

To view data in the Temperature Plot screen, click Temperature Plot from the Run Experiment Menu.
During a run, the Temperature Plot screen displays the temperatures of the sample block(s), the heated cover, and samples (calculated) in real-time.

<table>
<thead>
<tr>
<th>To...</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or remove temperature plots</td>
<td>Select <strong>Cover</strong> or <strong>Sample Block</strong> to view the presence of the associated data in the plot.</td>
</tr>
<tr>
<td>Change the time to display in the plot</td>
<td>From the <strong>View</strong> drop-down menu, select the amount of time to display in the plot.</td>
</tr>
<tr>
<td>Display a fixed time window during the instrument run</td>
<td>Select <strong>Fixed View</strong>.</td>
</tr>
</tbody>
</table>

The Temperature Plot screen can be useful for identifying hardware failures. When monitoring the Temperature Plot screen, observe the Sample and Block plots for abnormal behavior.

- The Sample and Block plots should mirror each other approximately. A significant deviation of the plots may indicate a problem.
- The Cover plot should maintain the constant temperature specified in the method. A departure from the constant temperature may indicate a problem.

**Note:** If you notice abnormal temperature plot, troubleshoot the error as explained in the QuantStudio™ 12K Flex Software Help (click 📘 or press F1).

To monitor the Run Method

To view data in the Run Method screen, click **Run Method** from the Run Experiment Menu.

The Run Method screen displays the run method selected for the run in progress. The software updates the Run Status field throughout the run.

<table>
<thead>
<tr>
<th>To...</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the number of cycles</td>
<td>In the <strong>Adjust # of Cycles</strong> field, enter the number of cycles to apply to the Cycling Stage.</td>
</tr>
<tr>
<td>Add a melt curve stage to the end of the run</td>
<td>Select <strong>Add Melt Curve Stage to End</strong>.</td>
</tr>
<tr>
<td>Add a Hold stage to the end of the run</td>
<td>Select <strong>Add Holding Stage to End</strong>.</td>
</tr>
</tbody>
</table>
Chapter 1 General Information and Instructions

Start the experiment

<table>
<thead>
<tr>
<th>To...</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add an indefinite hold to the end of the run</td>
<td>Select Add Infinite Hold to End</td>
</tr>
<tr>
<td>Apply your changes</td>
<td>Click Send to Instrument.</td>
</tr>
</tbody>
</table>

If an alert appears, click the error for more information and troubleshoot the problem as explained in the QuantStudio™ 12K Flex Software Help (click ⚙ or press F1).

**To view the run data**

After a run is complete, you can view a run report by clicking View Run Data. The View Run Data screen displays information about the completed run, as in the following example from a Standard Curve experiment:

The run report data helps in:

- Comparing two experiments of the same type run on two different instruments.
- Troubleshooting. For example, after a firmware upgrade, you can compare an experiment run before and after the upgrade to determine if the upgrade affected performance.

**From the QuantStudio™ 12K Flex Instrument touchscreen**

The touchscreen displays the method for the experiment, the date and time at which the run started, the time remaining in the run, and other information.

<table>
<thead>
<tr>
<th>To...</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display a graphical view of the run</td>
<td>Touch Experiment View.</td>
</tr>
<tr>
<td>Show the Amplification Plot for the run</td>
<td>Touch the Plot View, then touch Experiment View to return to the Run Method screen.</td>
</tr>
</tbody>
</table>
Start the experiment

The run method on the QuantStudio™ 12K Flex Instrument touchscreen is shown in the following graphics:

**Experiment View**
Chapter 1  General Information and Instructions

Start the experiment

Time View

Plot View

The Plot View displays the Amplification Plot in real time. You can change the plot using the drop-down menus present below the Plot View tab.

<table>
<thead>
<tr>
<th>Touch...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rn</td>
<td>Change the data displayed on the y axis. Select either Rn (normalized reporter) or ΔRn (baseline-corrected normalized reporter).</td>
</tr>
</tbody>
</table>
Unload the instrument

When your QuantStudio™ 12K Flex Instrument displays the Main Menu screen, unload the reaction plate from the instrument and transfer the experiment data to the computer for analysis.

Unload the reaction plate or array card

**CAUTION! PHYSICAL INJURY HAZARD.** During instrument operation, the temperature of the sample block(s) can exceed 100 °C. Keep your hands away until the sample block(s) reaches room temperature.

1. Touch \([\text{Open Door}](#)\) on the QuantStudio™ 12K Flex Instrument touchscreen or click **Open Door** in the Instrument Console screen of the QuantStudio™ 12K Flex Software.
2. Remove the reaction plate or array card from the plate adapter.
3. Touch \([\text{Close Door}](#)\) or click **Close Door** to retract the plate adapter back into the instrument.
   
   If the QuantStudio™ 12K Flex Instrument does not eject the plate, remove the plate as follows:
   
   a. Power off the QuantStudio™ 12K Flex Instrument.
   b. Wait for 15 minutes, then power on the QuantStudio™ 12K Flex Instrument and eject the plate.
   c. If the plate does not eject, power off and unplug the QuantStudio™ 12K Flex Instrument, then open the access door.
   d. Wearing powder-free gloves, reach into the QuantStudio™ 12K Flex Instrument and remove the plate from the heated cover, then close the access door.
   e. Perform a background calibration to confirm that the sample block has not been contaminated.

Transfer experiment results

You can transfer the experiment results in either of the following two ways:

Download the experiment from the QuantStudio™ 12K Flex Instrument over the network

1. In the QuantStudio™ 12K Flex Software, select **Instrument ➤ Instrument Console**.
2. Select the instrument icon of the QuantStudio™ 12K Flex Instrument you just used to run the experiment from the My Instruments list.
3. Click **Manage Instrument** to open the Instrument Manager.
4. In the Instrument Manager, click **Manage Files**.
5. In the Experiments panel, select the experiment to download. Click **Download**.

6. In the Save dialog box, select the folder to hold the experiment results and click **Save**. The experiments folder is located at:

   \<drive>:\Applied Biosystems\QuantStudio 12K Flex Software\experiments\ 

   where, `<drive>` is the computer hard drive on which the QuantStudio™ 12K Flex Software is installed. The default installation drive for the software is the C: drive.

Transfer the experiment from the QuantStudio™ 12K Flex Instrument to the computer via a USB drive:

1. If not already connected to the instrument, connect a USB drive to the USB port.

2. Touch the QuantStudio™ 12K Flex Instrument touchscreen to awaken it.

3. If the touchscreen is not at the Main Menu screen, touch **Home**.

4. In the Main Menu, touch **Collect Results** to save the data to the USB drive.

5. Select one or multiple experiments (by touching them). Then touch **Save to USB** to copy selected experiments to the USB drive.

   **Note:** If your instrument cannot find the USB drive, remove the USB drive, then try again. If the instrument still does not recognize the USB drive, try another USB drive.

6. Touch **Home** to return to the Main Menu.

7. Remove the USB drive from your instrument, then connect it to one of the USB ports on your computer.

8. In the computer desktop, use the Windows explorer to open the USB drive.

9. Copy the example experiment file to:

   \<drive>:\Applied Biosystems\QuantStudio 12K Flex Software\experiments\
where <drive> is the computer hard drive on which the QuantStudio™ 12K Flex Software is installed. The default installation drive for the software is the C: drive.
Review experiment results

About analysis results

Immediately after a run, the QuantStudio™ 12K Flex Software automatically analyzes the data using the default analysis settings, then displays the Amplification Plot screen.

**Note:** For auto-analysis of data, after a run, go to Tools › Preferences › Experiment and select the Auto Analysis check box.

**Note:** For Genotyping experiments, the QuantStudio™ 12K Flex Software displays the Allelic Discrimination Plot screen.

To reanalyze the data, select all the wells in the plate layout, then click Analyze.

About the Analysis Settings Library

Analysis Settings are different for each experiment type. If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

You can save the changed analysis settings to the Analysis Settings Library so that you can use them in other experiments.

In the Analysis Settings Library dialog box you can apply a filter to reduce the number of settings protocols displayed.

You can access the Analysis Settings Library from the Tools menu. The Analysis Settings Library dialog box looks like this:

To change the analysis settings and to save them to the Analysis Settings Library:

1. From the Experiment Menu pane, select Analysis.
2. On the Analysis screen, click **Analysis Settings** to open the Analysis Settings dialog box.

3. Change the analysis settings as per your requirement.

4. Click **Save to Library** to save the changes you have made to the Analysis Settings Library.

You can import the analysis settings you have previously saved to the Analysis Settings Library, by clicking **Load from Library** in the Analysis Settings dialog box.

**To override calibration**

Each experiment file (.eds) stores the calibration data from the QuantStudio™ 12K Flex Instrument it was run on. The calibration data can affect the analysis results of an experiment.

If you have run multiple experiments on different QuantStudio™ 12K Flex Instruments and prefer the analysis results from a particular instrument, then you can choose to use the calibration data from another QuantStudio™ 12K Flex Instrument.

**To use the calibration data of another experiment**

1. Open the experiment file (.eds), in which you want to import the calibration data from another QuantStudio™ 12K Flex Instrument, in the QuantStudio™ 12K Flex Software.

2. Go to **Analysis → Override Calibration → Use Calibration From Another File**.

3. Browse to experiment file (.eds) from which you want to use the calibration data.
   
   **Note:** You can choose to override the calibration data in an experiment with the calibration data of only the same experiment type.

4. Click **Open**.

**To revert to the original calibration data**

1. Open the experiment file (.eds), in which you want to import the original calibration data, in the QuantStudio™ 12K Flex Software.

2. Go to **Analysis → Override Calibration → Revert To Original Calibration**.

The experiment file will display analysis results as per the calibration data of the QuantStudio™ 12K Flex Instrument that the experiment was run on.
To display wells

To display specific wells in the analysis plots, select the wells in the Plate Layout tab:

- To select wells of a specific type, use the Select Wells drop-down menus: Select Sample, Target, or Task, then select the sample, target, or task name.
- To select a single well, click the well in the plate layout.
- To select multiple wells, click and drag over the desired wells, press Ctrl-click, or press Shift-click in the plate layout.
- To select all the wells, click the upper left corner of the plate layout.

The plate layout for a Standard Curve experiment is shown in the following graphic:

To display multiple plots

Use the Multiple Plots View screen to display up to four plots simultaneously. To navigate within the Multiple Plots View screen, from the Experiment Menu pane, select Analysis ➤ Multiple Plots View.

- To display four plots, click Show plots in a 2 × 2 matrix.
- Similarly, to display two plots in rows, click Show plots in two rows. and to display two plots vertically, click Show plots in two columns.
- To display a specific plot, select the plot from the drop-down menu above each plot display.
The Multiple Plots View screen for a Standard Curve experiment is shown in the following graphic:

To display an expanded view of a plot or wells

- Click to expand the view of a plot, displayed on the left-hand side of the screen.
- Click to expand the view of the Plate Layout or Well Table displayed on the right-hand side of the screen.

To edit plot properties

Use the Plot Properties dialog box on the Analysis screen to edit plot settings such as the font and color of the plot text, and the labels on the X axis and Y Axis.

1. Click on the Analyze screen (the icon appears above the plot) to open the Plot Properties dialog box.

2. Edit the settings under the General, X Axis, and Y Axis tab.
   - Click the General tab to edit the plot title text, font, or color. You can also select whether to show the plot title.
   - Click the X Axis tab to edit the x axis label text, font, or color; select the tick marks and tick mark labels to display; and select the range to display.
   - Click the Y Axis tab to edit the y axis label text, font, or color; select the tick marks and tick mark labels to display; and select the range to display.

3. Click OK.
To save current settings as default

You can change the Plot Settings for the different analysis plots, and save them as defaults.

Select the **Save current settings as the default** check box on the respective plot screens under the Analysis Experiment Menu.

To publish the analyzed data

<table>
<thead>
<tr>
<th>To...</th>
<th>Click</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save a plot as an image file</td>
<td>![Image Icon]</td>
</tr>
<tr>
<td>Print a plot</td>
<td>![Print Icon]</td>
</tr>
<tr>
<td>Copy a plot to the clipboard</td>
<td>![Clipboard Icon]</td>
</tr>
<tr>
<td>Print a report</td>
<td>![Print Report Icon]</td>
</tr>
<tr>
<td>Export data</td>
<td>![Export Icon]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To...</th>
<th>Go to</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print the plate layout</td>
<td><strong>File ➔ Print...</strong></td>
<td>Select the background color, and click <strong>Print</strong></td>
</tr>
<tr>
<td>Create slides</td>
<td><strong>File ➔ Send to PowerPoint...</strong></td>
<td>Select the slides for your presentation, and click <strong>Create Slides</strong></td>
</tr>
<tr>
<td>Print a report</td>
<td><strong>File ➔ Print Report...</strong></td>
<td>Select data for the report, and click <strong>Print Report</strong></td>
</tr>
</tbody>
</table>

Export an experiment

About exporting an experiment

The Export feature of QuantStudio™ 12K Flex Software allows you to export:

- **Plate setup files for future experiments.**
  Plate setup files contain setup information such as the well number, sample name, sample color, target name, dyes, and other reaction plate contents.

- **Analyzed data in different formats for further analysis.**
  The data can be exported in the QuantStudio 12K Flex format, the 7900 SDS format, and the RDML format.
  The 7900 format is applicable only to Standard Curve, Relative Standard Curve, Genotyping, Presence/Absence, and Melt Curve experiments.
  The RDML export format is applicable only to Standard Curve, Relative Standard Curve, Comparative C_T, and Melt Curve experiments. The RDML format is available only in a single file format.
Export an experiment

For Standard Curve experiments, you can also export the analyzed data from the QuantStudio™ 12K Flex Software to the external application, CopyCaller® Software if it is installed on your computer before the QuantStudio™ 12K Flex Software is installed. The application appears in the Tools menu.

- Gene Expression studies to carry out a comparative analysis.

Export procedure

Note: If you choose the Auto Export option during experiment setup or before running an experiment, the data is automatically exported to the location you specified. If you did not set the Auto Export option, the analyzed data is not exported automatically.

1. Open the experiment file that contains the data to export, and from the Experiment Menu, click Export.

2. Select the format for exported data:
   - **QuantStudio 12k Flex format** (supports .txt, .xls, and .xlsx data).
   - **7900 format** - Single experiments are exported in the SDS 2.4 detector centric export format of the 7900 Sequence Detecting System. The 7900 format supports only the .txt type of data.
   - **RDML format** - Real Time Data Markup Language (supports only .xml type of data).

3. Select to export all data in one file or in separate files for each data type.
   - **One File** - All data types are exported in one file.
     - If you select the *.xls format, a worksheet is created for each data type.
     - If you select the *.txt format, the data are grouped by data type.
   - **Separate Files** - Each data type is exported in a separate file. For example, if you select three different data types Results, Amplification, and Multicomponent to export, three separate files (one each for Results, Amplification, and Multicomponent) are created. You can select the type of file (*.xls, *.xlsx or *.txt) to export from the File Type drop-down menu.
     
     **Note:** You cannot use an exported *.xls or an *.xlsx file when importing plate setup information.

4. (Optional) Select the Open file(s) when export is complete check box to automatically open the file when export is complete.

5. Enter a file name and location.
   a. Enter a name for the export file in the Export File Name field.
b. Enter the **Export File Location**. Click **Browse** if you do not want to save the export file in the default export folder.

**Note:** To set up the Export File Location, go to **Tools ➤ Preferences**, and select the **Export** tab. You can select the **Use Last File Location** or **Use Default Folder** check box.

6. Select the data to export:

<table>
<thead>
<tr>
<th>Select...</th>
<th>To export...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample setup</td>
<td>Well, sample name, sample color, and target name of samples in the plate</td>
</tr>
<tr>
<td>Raw data</td>
<td>Raw fluorescence data for each filter, for each cycle</td>
</tr>
<tr>
<td>Amplification data</td>
<td>Amplification results, such as $C_T$ values, Rn, or $\Delta Rn$</td>
</tr>
<tr>
<td>Multicomponent data</td>
<td>Fluorescence data for each dye, for each cycle</td>
</tr>
<tr>
<td>Results</td>
<td>Results information, such as $C_T$ values, Rn, or calls</td>
</tr>
<tr>
<td>Technical Replicate Results [Tech. Rep. Results]</td>
<td>Technical replicates information, such as Sample name, Target name, Task, or RQ</td>
</tr>
<tr>
<td>Biological Replicate Results [Bio. Rep. Results]</td>
<td>Biological replicates information, such as Biogroup name, Target name, Task, or RQ</td>
</tr>
</tbody>
</table>

**Note:** Results data are not available for export until the run status is complete and the data are analyzed.

**Note:** The Technical Replicate Results and Biological Replicates Results are available only in Relative Standard Curve and Comparative $C_T$ experiments.
7. *(Optional)* For Standard Curve experiments, select the external application, **CopyCaller® Software** if the Software is installed on your computer.

8. *(Optional)* After you have defined the export properties or after moving the table headings order, you can save those export settings as an export set by clicking **Save Export Set As**. Later you can import the heading order into another file by clicking **Load Export Set**. You can also delete export settings by clicking **Delete Export Set**.

   **Note:** It is advisable to keep the default order of the table headings if you are using the external Applied Biosystems application, **CopyCaller® Software** for further analysis.

9. Click **Start Export**.

   The Export screen for a Standard Curve experiment is shown in the following graphic:
Chapter 1 General Information and Instructions

Export an experiment

The exported file when opened in Notepad appears as shown in the following graphic:
Experiment Shortcuts

This chapter provides you with shortcuts to use in the QuantStudio™ 12K Flex Software after you have learned experiment basics.

You can reuse experiment settings and plate setup information by: directly importing and editing a template, using the QuickStart feature with a template, importing experiment setup information, or importing a sample definition file; you can also prepare several experiments at once or create a new experiment using the ReadiApp feature.

- Create an experiment from a template ........................................ 59
- QuickStart an experiment .......................................................... 60
- Import plate setup for an experiment ........................................... 62
- Import sample information .......................................................... 63
- Use a template to create a batch of experiments ............................ 66
- Create an experiment using ReadiApp ........................................... 68

Create an experiment from a template

You can use a template to create a new experiment. Templates are useful when you want to create many experiments with the same experiment parameters.

You can create an experiment from a template from the QuantStudio™ 12K Flex Software and from the QuantStudio™ 12K Flex Instrument touchscreen.

**Note:** To access the QuantStudio™ 12K Flex Software example templates, navigate to the templates folder located at `<drive>:\Program Files\Applied Biosystems\QuantStudio12KFlex\templates`.

**To create a template**

1. Log in to the QuantStudio™ 12K Flex Software and, from the Home screen, open an existing experiment, or create a new experiment.
   **Note:** To create a new experiment using the Experiment Setup, see “Set up an experiment” on page 10.

2. Select **File** ➤ **Save As Template**.

3. Enter a file name, select a location for the template, then click **Save** and **Close**.
   You can use that experiment as a template for similar experiments.

**To create a new experiment using a template**

1. From the Home screen, click **Create From Template**.

2. Locate and select the template file, then click **Open**.
   A new experiment is created using the setup information from the template.
3. Edit the experiment properties, plate definitions, plate assignments, and run method before you prepare the reactions and run the experiment.

4. Proceed to preparing reactions, running the experiment, and analyzing the data.

You can run experiments using templates from the QuantStudio™ 12K Flex Instrument touchscreen by importing the templates from the QuantStudio™ 12K Flex Software instrument console or a USB drive. You can also modify the experiment parameters in the templates as per your requirement.

To run a pre-existing template

1. Touch View Template on the Home screen of the QuantStudio™ 12K Flex Instrument touchscreen.
2. Select a pre-existing template from the templates list on the View Templates screen.
3. Touch View to see the run profile before you start a run.
4. After confirming the template setup is correct, touch to go back to View Template screen. Touch Start Run.

To edit a template before running the experiment

1. Touch New on the View Templates screen to create a new experiment from the existing template.
   Note: Select a template before you touch New.
2. Edit the experiment parameters in the Create New Experiment screen.
3. Touch Save & Exit to save and exit the experiment or touch Save & Start Run to save and start an experiment run.

QuickStart an experiment

You can use a template to run an experiment with the QuantStudio™ 12K Flex Software Quickstart feature:

QuickStart from the QuantStudio™ 12K Flex Software

1. Prepare the reactions.
2. Log in to the QuantStudio™ 12K Flex Software and, from the Home screen, click 96/384/Array Cards to access the Run 96/384/Array Cards dialog box.
3. In the QuickStart dialog box, enter or select the:
   a. Instrument icon of the instrument to perform the run on.
   b. Experiment name.
   c. Experiment location.
   d. Experiment template file.
   e. (Optional) Barcode, User Name, and Comments for the experiment.
4. *Optional* To review the experiment or to make changes to any of the experiment parameters, click **Experiment Setup**.

The 96/384/Array Cards dialog box looks like this:

![Image of the 96/384/Array Cards dialog box]

5. Proceed to running the experiment and analyzing the data.

**QuickStart from the QuantStudio™ 12K Flex Instrument touchscreen**

You can QuickStart an experiment from the QuantStudio™ 12K Flex Instrument touchscreen in the following ways:

- Start an experiment using a pre-defined template.
- Start an experiment with a pre-defined short-cut button.

**Start an experiment using a pre-defined template**

You can use a pre-existing template from the default experiments folder or use a custom template from another folder to start a run.

**Start an experiment with a pre-defined short-cut button**

The QuantStudio™ 12K Flex Instrument touchscreen displays up to 18 shortcut buttons to templates or folders that contain experiments to be run. The shortcut buttons are present under My Shortcuts on the Home screen. To start a run, touch any of the pre-defined experiment or folder buttons.

To create a shortcut button for a preferred experiment or a folder that contains experiments:
Chapter 2  Experiment Shortcuts

Import plate setup for an experiment

You can import the plate setup for a new experiment from an exported file with one of the following formats:

- *.txt - Text format
- *.xml - XML format
- *.csv - Comma separated values format
- *.sdt - Sequence detecting system (sds) template files format
- *.sds - 7900 v2.3 format

**IMPORTANT!** Make sure the file you select contains only plate setup data and that the experiment types match.

**Note:** For instructions on exporting an experiment, see “Export an experiment” on page 54.

To Import the plate setup data:

1. Create a new experiment or open an existing experiment.
2. In the Experiment Setup screen, select File > Import Plate Setup or access the Import drop-down menu in the toolbar and select Import Plate Setup.
3. Click Browse, locate and select the file to import, then click Select.
4. Click **Start Import**. The setup data from the exported text file is imported into the open experiment.

   **Note:** If your experiment already contains plate setup information, the software asks if you want to replace the plate setup with the data from the import file. Click **Yes** to replace the plate setup.

5. After importing plate setup information, use Experiment Setup to set up your experiment, and then run the experiment.

   **Note:** You can import plate setup information from a 96-well plate into a 384-well plate, provided that the file you are importing the information from is a .txt file.

---

**Import sample information**

You can import sample information from a sample definition file to include in the plate setup for your experiment. A sample definition file is a comma-delimited file (*.csv) or a tab-delimited text file (*.txt) that contains the following setup information: well number, sample name, and custom sample properties.

   **Note:** Make sure that the sample definition file you select contains only sample information.

---

**Create a sample definition file**

1. Open a text editing program such as Notepad.

2. Enter the following column headers in the first row (press the Tab key between each entry if you are saving the file as *.txt or enter a comma between each entry if you are saving the file as *.csv):
   - Well
   - Sample Name
   - *(Optional)* Column header names for up to six user-defined custom fields (for example, Custom 1, Custom 2, etc.)

3. For each subsequent row, enter the well number, press the **Tab** key or enter a comma, then enter the sample name. Optionally, press the **Tab** key, then enter the custom properties for the sample.

4. Save the file with the .txt or .csv file extension.
Chapter 2  Experiment Shortcuts

Import sample information

An example sample definition, saved with the .csv extension, file looks like this:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Sample Name</td>
<td>ID</td>
<td>Age</td>
<td>Sex</td>
<td>Weight</td>
<td>HairColor</td>
<td>Smoker</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Sample 1</td>
<td>1</td>
<td>22</td>
<td>Female</td>
<td>25</td>
<td>black</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>Sample 2</td>
<td>2</td>
<td>25</td>
<td>Male</td>
<td>36</td>
<td>brown</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>Sample 3</td>
<td>3</td>
<td>45</td>
<td>Female</td>
<td>50</td>
<td>blonde</td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>Sample 4</td>
<td>4</td>
<td>31</td>
<td>Male</td>
<td>35</td>
<td>red</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>5</td>
<td>Sample 5</td>
<td>5</td>
<td>26</td>
<td>Female</td>
<td>48</td>
<td>grey</td>
<td>No</td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>Sample 6</td>
<td>6</td>
<td>26</td>
<td>Male</td>
<td>35</td>
<td>black</td>
<td>No</td>
</tr>
<tr>
<td>8</td>
<td>7</td>
<td>Sample 7</td>
<td>7</td>
<td>31</td>
<td>Female</td>
<td>33</td>
<td>black</td>
<td>Yes</td>
</tr>
<tr>
<td>9</td>
<td>8</td>
<td>Sample 8</td>
<td>8</td>
<td>22</td>
<td>Male</td>
<td>67</td>
<td>black</td>
<td>No</td>
</tr>
<tr>
<td>10</td>
<td>9</td>
<td>Sample 9</td>
<td>9</td>
<td>32</td>
<td>Female</td>
<td>75</td>
<td>brown</td>
<td>Yes</td>
</tr>
<tr>
<td>11</td>
<td>10</td>
<td>Sample 10</td>
<td>10</td>
<td>26</td>
<td>Male</td>
<td>44</td>
<td>blonde</td>
<td>Yes</td>
</tr>
<tr>
<td>12</td>
<td>11</td>
<td>Sample 11</td>
<td>11</td>
<td>24</td>
<td>Female</td>
<td>25</td>
<td>red</td>
<td>No</td>
</tr>
<tr>
<td>13</td>
<td>12</td>
<td>Sample 12</td>
<td>12</td>
<td>34</td>
<td>Male</td>
<td>26</td>
<td>grey</td>
<td>No</td>
</tr>
<tr>
<td>14</td>
<td>13</td>
<td>Sample 13</td>
<td>13</td>
<td>36</td>
<td>Female</td>
<td>50</td>
<td>black</td>
<td>Yes</td>
</tr>
<tr>
<td>15</td>
<td>14</td>
<td>Sample 14</td>
<td>14</td>
<td>36</td>
<td>Male</td>
<td>33</td>
<td>black</td>
<td>No</td>
</tr>
<tr>
<td>16</td>
<td>15</td>
<td>Sample 15</td>
<td>15</td>
<td>36</td>
<td>Female</td>
<td>48</td>
<td>black</td>
<td>Yes</td>
</tr>
<tr>
<td>17</td>
<td>16</td>
<td>Sample 16</td>
<td>16</td>
<td>36</td>
<td>Male</td>
<td>35</td>
<td>brown</td>
<td>Yes</td>
</tr>
<tr>
<td>18</td>
<td>17</td>
<td>Sample 17</td>
<td>17</td>
<td>37</td>
<td>Female</td>
<td>33</td>
<td>blonde</td>
<td>No</td>
</tr>
<tr>
<td>19</td>
<td>18</td>
<td>Sample 18</td>
<td>18</td>
<td>37</td>
<td>Male</td>
<td>67</td>
<td>red</td>
<td>No</td>
</tr>
<tr>
<td>20</td>
<td>19</td>
<td>Sample 19</td>
<td>19</td>
<td>36</td>
<td>Female</td>
<td>55</td>
<td>grey</td>
<td>Yes</td>
</tr>
<tr>
<td>21</td>
<td>20</td>
<td>Sample 20</td>
<td>20</td>
<td>36</td>
<td>Male</td>
<td>44</td>
<td>black</td>
<td>No</td>
</tr>
</tbody>
</table>

1. Create a new experiment or open the experiment to receive the setup data (select File → Open, select the file to open, then click Open).

2. From the open experiment, select File → Import Plate Setup.

3. Click Browse to browse your computer for a sample definition text file (*.csv). After you locate the file and select it, click Select.

4. Click Start Import.

5. If your experiment already contains plate setup information, the software asks you if you want to replace the plate setup with the data from the file. Click Yes to replace the plate setup information.

The samples appear in the Samples table for the experiment. All samples and well assignments in the experiment are replaced with those in the file. If defined, the custom sample properties also appear in the Well Table of the Analysis Section, and also in the Plate Layout tooltips in both the Setup and Analysis screens. The custom fields can be exported with the results data.

Note: You cannot edit the custom sample properties from within the Well Table. To modify this information, edit the custom fields in the sample definition file and import the file again. All of the sample information in the experiment is replaced with the information in the new file.
The Assign screen with information from the above sample definition file looks like this:

The Well Table in the Analysis section looks like this:
Chapter 2  Experiment Shortcuts

Use a template to create a batch of experiments

Use the batch experiment utility to create multiple experiment files from the same template without using Experiment Setup.

1. In the menu bar, select Tools › Batch Experiment Setup. The Batch Experiment Setup Utility dialog box looks like this:

   ![Batch Experiment Setup Utility](image)

2. Select the file(s) to use to create the new experiments:
   a. For multi-well plate, array card experiments, or experiments that use sample integration, click Browse in the Experiment Template File field.
   b. Locate an *.edt file to import, then click Select.
   c. For OpenArray experiments, click Browse in the Experiment Template File field or in the Setup File Folder field.
   d. Locate either an *.edt (template) or an *.spf/*.tpf file to import, then click Select.
   e. (Optional) Repeat steps 2a and 2b for the remaining setup file types to import Assay Information File (*.aif), Plate Setup File (*.txt)).
3. Select the option to create experiment files. The selected option determines the number of experiment files created:

- **Specify Number of Files** - Enter a number from 1 to 100.
- **Barcode** - Click **Browse** and select a Barcode File (*.txt) to import. The software automatically adds the Plate Barcode attribute to the file name format. The number of experiments created equals the number of barcodes present in the barcode file.

  **Note:** A Barcode File contains one barcode per line. An example Barcode File looks like this:

```
A01BYW1
A01BYW2
A01BYW3
A01BYW4
...
```

4. (Optional) Edit the file name format. Use the File Name Preview to verify your settings.

- Select the check box to include or exclude the Custom Name Field Plate Barcode attribute from the file name. If included, click the Custom Name Field and enter up to 100 letters and/or numbers to identify the batch of experiments.

  **Note:** The file name can contain a total of 100 characters, including all file name attributes.

- Click **Move Up** or **Move Down** to change the order of the selected file name attributes.

5. Select the Sample Files Folder:

a. Click **Browse**, then locate and select a folder.

   Refer to the Expected Sample File Name for an example of a file name.

b. Click **Validate** to visually check that experiment files are matched to sample files. If they do not match then the “matching sample file’ shows the missing file as “not found” in red.

6. Select the location for the experiment files to be created:

   a. Click **Browse** in the Export Setup Files to: field.
b. Review the location for the experiment files. Navigate to a new location if you do not want to export the experiment files to that folder, then click Select.

7. Click Create Experiments. A confirmation message appears when the batch of experiments has been created.

Create an experiment using ReadiApp

You can use the ReadiApp feature to set up an experiment in the QuantStudio™ 12K Flex Software. The ReadiApp feature provides a shortcut to create experiments for the assays purchased from Life Technologies.

The default ReadiApp templates available in the QuantStudio™ 12K Flex Software include:

- TaqMan® Gene Signature Array Cards
- Custom TaqMan® Array Cards
- TaqMan® Gene Expression Assays
- TaqMan® Drug Metabolism Assays
- TaqMan® array MicroRNA Cards
- TaqMan® Copy Number Assays (CNV)
- TaqMan® SNP Genotyping Assays

1. Log in to the QuantStudio™ 12K Flex Software and, from the Tools menu on the Home screen, click ReadiApp.

2. Click the assay to use to set up an experiment.

Note: Click Cancel to exit the ReadiApp dialog box.

A new experiment is created using the setup information from the template.

3. (Optional) Edit the experiment properties.

4. Proceed to preparing reactions, running the experiment, and analyzing the data.
Getting Started with QuantiStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments

Numerics

Index
libraries, using in your own experiments
   Run Method library  19
   Samples library   19
   SNP Assay library 19
   Targets library   19

materials for dilutions
   master mix  27
melt curve  11
monitoring the experiment  41
multiple plots, displaying  52

notification settings, enable or change  39
NULL, values in well assignments  16

optical adhesive film  27
overriding calibration data  51

passive reference  13
PCR Stage, editing during experiment design  18
plate adapter  39
plate setup data, importing  62
plot properties  53

QuantStudio™ Format  55
quencher  12
QuickStart  59, 60

ramp speed  11
RDML Format  55
reaction plate, sealing  27
reaction tubes and strips, capping and uncapping  33
reactions
   precautions  26
   preparing  21
reagent detection process  24
reagents, selecting

Supported reagents  24
SYBR® Green Reagents  11, 25
TaqMan® Reagents  11, 24

reporter  12
results, reviewing  50
roller assembly  32
run method library  19
run properties, defining  17
Run screen  42
   Amplification Plot  43
   Run Method  44
   Temperature Plot  43
   View Run Data  45
running an experiment  40

sample block(s)  43
sample definition file, creating  63
sample information, importing  63
samples
   assigning  14, 16
   defining  13
shortcuts, experiments  59
storage conditions, photosensitive  33

tab-delimited text file, for sample definitions  63
target, sample, and SNP assay libraries  19
targets
   assigning  14, 16
   defining  12
template
   creating an experiment from a template  59
   creating batch of experiments from template  66
thermal profile  17
touchscreen, run method
   Experiment View  46
   Time View  46, 47
transferring experiment results  48

unloading an experiment  47
USB
   device  41
   drive  49
Wells, displaying 52
Booklet 2 - Running Standard Curve Experiments

Publication Part Number 4470050 Rev. A
Revision Date March 2012
Contents

Tips for analyzing your own experiments .................................................. 38
Identify well problems using the Well Table ............................................. 40
  Purpose ........................................................................................................ 40
  View the Well Table .................................................................................. 40
  Tips for analyzing your own experiments ................................................ 42
Confirm accurate dye signal using the Multicomponent Plot ....................... 42
  Purpose ........................................................................................................ 42
  View the Multicomponent Plot ................................................................. 43
  Tips for confirming dye accuracy in your own experiment ....................... 44
Determine signal accuracy using the Raw Data Plot .................................. 44
  Purpose ........................................................................................................ 44
  View the Raw Data Plot ........................................................................... 44
  Tips for determining signal accuracy in your own experiments ............... 44
Review the flags in the QC Summary ......................................................... 46
  Possible flags .............................................................................................. 47
For more information .................................................................................... 48

Section 5.2  Adjust parameters for re-analysis of your own experiments ....... 51
Adjust analysis settings ................................................................................ 51
  View the analysis settings ........................................................................ 51
  Adjust analysis settings ............................................................................ 52
Improve C_T precision by omitting wells ..................................................... 55
For more information .................................................................................... 56

CHAPTER 6  Export Analysis Results .............................................................. 57

Index ............................................................................................................... 59
About Standard Curve Experiments

This chapter covers:

- Before you begin ............................................................... 5
- About the example experiment ........................................... 6

IMPORTANT! First-time users of the QuantStudio™ 12K Flex System please read Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments and Booklet 7, QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments - Appendices of this binder thoroughly. The booklets provide information and general instructions that are applicable to all the experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ 12K Flex Software by pressing F1, clicking 📖 in the toolbar, or selecting Help › QuantStudio™ 12K Flex Software Help.

Before you begin

The Standard Curve method is used for determining absolute target quantity in samples. With the standard curve method, the software measures amplification of the target in samples and in a standard dilution series. Data from the standard dilution series are used to generate the standard curve. Using the standard curve, the software interpolates the absolute quantity of target in the samples.

Assemble required components

- **Sample** – The tissue group that you are testing for a target gene.
- **Standard** – A sample that contains known quantities of the target; used in quantification experiments to generate standard curves.
- **Standard dilution series** – A set of standards containing a range of known quantities. The standard dilution series is prepared by serially diluting standards.
- **Replicates** – The total number of identical reactions containing identical samples, components, and volumes.
- **Negative Controls** – Wells that contain water or buffer instead of sample template. No amplification of the target should occur in negative control wells.

PCR Options

When performing real-time PCR, choose between:

- Singleplex and multiplex PCR (page 6)
- 1-step and 2-step RT-PCR (page 6)
Singleplex and Multiplex PCR

You can perform a PCR reaction using either:

- **Singleplex PCR** – In singleplex PCR a single primer set is present in the reaction tube or well. Only one target or endogenous control can be amplified per reaction.

  or

- **Multiplex PCR** – In multiplex PCR, two or more primer sets are present in the reaction tube or well. Each set amplifies a specific target or endogenous control. Typically, a probe labeled with FAM™ dye detects the target and a probe labeled with VIC® dye detects the endogenous control.

**IMPORTANT!** SYBR® Green reagents cannot be used for multiplex PCR.

1- and 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in separate reactions (2-step). The reagent configuration you use depends on whether you are performing 1- or 2-step RT-PCR:

- **1-step RT-PCR** – In 1-step RT-PCR, RT and PCR take place in one buffer system. Using one buffer system provides the convenience of a single-tube preparation for RT and PCR amplification. However, you cannot use Fast PCR master mix or the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

- **2-step RT-PCR** – 2-step RT-PCR is performed in two separate reactions: First, total RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful for detecting multiple transcripts from a single cDNA template or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be used to prevent carryover contamination.

  **Note:** The Standard Curve example experiment is designed for singleplex PCR, where every well contains a primer/probe set for a single target; the reactions are set up for a 2-step RT-PCR.

**About the example experiment**

To illustrate how to perform Standard Curve experiments, this guide leads you through the process of designing and performing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with the QuantStudio™ 12K Flex System.

The objective of the Standard Curve example experiment is to determine the quantity of the RNase P gene in two populations.
In the standard curve example experiment:

- The samples are genomic DNA isolated from two populations.
- The target is the RNase P gene.
- One standard curve is set up for the RNase P gene (target). The standard used for the standard dilution series contains known quantities of the RNase P gene. Because a single target is being studied, only one standard curve is required.

  **Note:** In experiments where multiple targets are being studied, a standard curve is required for each target.

- The Standard Curve is a five-point dilution with 16 technical replicates per point.
- The experiment is designed for singleplex PCR, where every well contains a primer/probe set for a single target.
- Reactions are set up for 2-step RT-PCR.
- Primer/probe sets are from Life Technologies RNase P assay.

  **Note:** The human RNase P FAM™ dye-labeled MGB probe is not available as a TaqMan® Gene Expression Assay. It can be ordered as a Custom TaqMan® Gene Expression Assay (PN 4331348).
Chapter 1 About Standard Curve Experiments

About the example experiment
Design the Experiment

This chapter explains how to design the example experiment from the Experiment Setup menu.

This chapter covers:

- Define the experiment properties ................................................................. 9
- Define targets, samples, and biological replicates ........................................... 10
- Assign targets, samples, and biological groups ............................................. 11
- Set up the run method ....................................................................................... 13
- For more information ....................................................................................... 15

**Note:** To automatically export the analyzed data to a specified location, select the Auto Export task from the Export screen, before running the experiment. For more information on Auto Export, refer to Chapter 1 in Booklet 1, *Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments*.

### Define the experiment properties

Click **Experiment Setup > Experiment Properties** to create a new experiment in the QuantStudio™ 12K Flex Software. Enter:

<table>
<thead>
<tr>
<th>Field or selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Name</td>
<td>384-Well Fast Standard Curve Example</td>
</tr>
<tr>
<td>Barcode</td>
<td>Leave field empty</td>
</tr>
<tr>
<td>User Name</td>
<td>Example User</td>
</tr>
<tr>
<td>Comments</td>
<td>Standard Curve example</td>
</tr>
<tr>
<td>Block</td>
<td>384-Well</td>
</tr>
<tr>
<td>Experiment Type</td>
<td>Standard Curve</td>
</tr>
<tr>
<td>Reagents</td>
<td>TaqMan® Reagents</td>
</tr>
<tr>
<td>Ramp speed</td>
<td>Fast</td>
</tr>
</tbody>
</table>

Save the experiment.
Define targets, samples, and biological replicates

Click Define to access the Define screen. Enter:

1. Targets

<table>
<thead>
<tr>
<th>Target name</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>RNaseP</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
</tbody>
</table>

2. Samples

<table>
<thead>
<tr>
<th>Sample name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pop1</td>
<td></td>
</tr>
<tr>
<td>Pop2</td>
<td></td>
</tr>
</tbody>
</table>

3. Dye to be used as a Passive Reference

ROX
Assign targets, samples, and biological groups

Click **Assign** to access the Assign screen.

1. Define and set up standards.
   
   a. Click **Define and Set Up Standards** on the Assign screen.
   
   b. Select a target.

<table>
<thead>
<tr>
<th>Field</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a target for this standard curve</td>
<td>RNaseP</td>
</tr>
</tbody>
</table>

   c. Define the standard curve.

<table>
<thead>
<tr>
<th>Field</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td># of Points</td>
<td>5</td>
</tr>
<tr>
<td># of Replicates</td>
<td>16</td>
</tr>
<tr>
<td>Starting Quantity</td>
<td>1250.0</td>
</tr>
<tr>
<td>Serial Factor</td>
<td>2x</td>
</tr>
</tbody>
</table>

**Note:** This example experiment does not define biological replicate groups. Leave Biological Replicate Groups blank.
d. Select and arrange wells for the standards.

<table>
<thead>
<tr>
<th>Field</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Wells</td>
<td>Let Me Select Wells</td>
</tr>
</tbody>
</table>

2. Assign targets and samples.

<table>
<thead>
<tr>
<th>Target name</th>
<th>Well number</th>
<th>Task</th>
<th>Quantity</th>
<th>Sample name</th>
</tr>
</thead>
<tbody>
<tr>
<td>RNaseP</td>
<td>A1 - P1 (column 1)</td>
<td>Negative</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>RNaseP</td>
<td>A2 - P2 (column 2)</td>
<td>Standard</td>
<td>1250</td>
<td>None</td>
</tr>
<tr>
<td>RNaseP</td>
<td>A3 - P3 (column 3)</td>
<td>Standard</td>
<td>2500</td>
<td>None</td>
</tr>
<tr>
<td>RNaseP</td>
<td>A4 - P4 (column 4)</td>
<td>Standard</td>
<td>5000</td>
<td>None</td>
</tr>
<tr>
<td>RNaseP</td>
<td>A5 - P5 (column 5)</td>
<td>Standard</td>
<td>10000</td>
<td>None</td>
</tr>
</tbody>
</table>
Chapter 2  Design the Experiment

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- Reaction Volume Per Well: 20 µL
- Thermal Profile

Your Assign screen should look like this:

<table>
<thead>
<tr>
<th>Target name</th>
<th>Well number</th>
<th>Task</th>
<th>Quantity</th>
<th>Sample name</th>
</tr>
</thead>
<tbody>
<tr>
<td>RNaseP</td>
<td>A6 - P6</td>
<td>Standard</td>
<td>20000</td>
<td>None</td>
</tr>
<tr>
<td>RNaseP</td>
<td>A7 - P15</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Pop1</td>
</tr>
<tr>
<td>RNaseP</td>
<td>A16 - P24</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Pop2</td>
</tr>
</tbody>
</table>

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- Reaction Volume Per Well: 20 µL
- Thermal Profile
## Chapter 2  Design the Experiment

### Set up the run method

Your Run Method screen should look like this:

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold Stage</td>
<td>Step 1</td>
<td>1.9°C/s</td>
<td>95°C</td>
<td>20 seconds</td>
</tr>
<tr>
<td>PCR Stage</td>
<td>Step 1</td>
<td>1.9°C/s</td>
<td>95°C</td>
<td>1 second</td>
</tr>
<tr>
<td></td>
<td>Step 2</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>20 seconds</td>
</tr>
</tbody>
</table>

Number of Cycles: 40 (default)
Enable AutoDelta: Unchecked (default)
Starting Cycle: Disabled when Enable AutoDelta is unchecked
# For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumables</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em> Appendix A in Booklet 7, <em>QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments - Appendixes</em></td>
<td>4470050</td>
</tr>
<tr>
<td>Using other quantification methods</td>
<td>Booklet 3, <em>Running Relative Standard Curve and Comparative C&lt;sub&gt;T&lt;/sub&gt; Experiments</em>.</td>
<td>4470050</td>
</tr>
<tr>
<td>Amplification efficiency</td>
<td><em>Amplification Efficiency of TaqMan® Gene Expression Assays</em> Application Note</td>
<td>127AP05-03</td>
</tr>
<tr>
<td>Using alternative setup</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
</tbody>
</table>
Chapter 2  Design the Experiment
For more information
Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Standard Curve example experiment.

This chapter covers:

- Assemble required materials .......................................................... 17
- Prepare the sample dilutions ............................................................ 17
- Prepare the standard dilution series ................................................. 18
- Prepare the reaction mix (“cocktail mix”) ......................................... 19
- Prepare the reaction plate ............................................................... 19
- For more information ................................................................. 22

Assemble required materials

- Items listed in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.
- Samples - Human Raji cell line-derived cDNA samples (100 ng/µL)
- Example experiment reaction mix components:
  - TaqMan® Fast Universal PCR Master Mix
  - RNase P Assay Mix (20X) (PN 4316831)

Prepare the sample dilutions

To determine the quantity of the RNase P gene in the example experiment, dilute the samples (as directed below) before adding the samples to the final reaction mix.

The stock concentration of each sample is 100 ng/µL. After dilution, the sample Pop1 has a concentration of 6.6 ng/µL and Pop 2 has a concentration of 3.3 ng/µL. Add 2µL to each reaction.

Use this table for sample dilution volumes for the example experiment.

<table>
<thead>
<tr>
<th>Sample name</th>
<th>Stock concentration (ng/µL)</th>
<th>Sample volume (µL)</th>
<th>Diluent volume (µL)</th>
<th>Total volume of diluted sample (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pop1</td>
<td>100.0</td>
<td>25</td>
<td>355</td>
<td>380</td>
</tr>
<tr>
<td>Pop2</td>
<td>100.0</td>
<td>12.5</td>
<td>367.5</td>
<td>380</td>
</tr>
</tbody>
</table>
Note: For your own experiment, adjust the input amounts of the template depending on the template type and target abundance.

1. Label a separate microcentrifuge tube for each diluted sample:
   - Pop 1
   - Pop 2

2. Add the required volume of water (diluent) to each empty tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample name</th>
<th>Diluent volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pop 1</td>
<td>355</td>
</tr>
<tr>
<td>2</td>
<td>Pop 2</td>
<td>367.5</td>
</tr>
</tbody>
</table>

3. Add the required volume of sample stock to each tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample name</th>
<th>Sample volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pop 1</td>
<td>25</td>
</tr>
<tr>
<td>2</td>
<td>Pop 2</td>
<td>12.5</td>
</tr>
</tbody>
</table>

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the standard dilution series

The standard concentration in stock is 20,000 copies/µL:

<table>
<thead>
<tr>
<th>Standard name (labeled tube)</th>
<th>Dilution point</th>
<th>Source</th>
<th>Source volume (µL)</th>
<th>Diluent volume (µL)</th>
<th>Total volume (µL)</th>
<th>Standard concentration (copies/µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>RNase P Std. 1</td>
<td>1 (20,000)</td>
<td>Stock</td>
<td>18</td>
<td>18</td>
<td>36</td>
<td>10,000</td>
</tr>
<tr>
<td>RNase P Std. 1</td>
<td>2 (10,000)</td>
<td>Dilution 1</td>
<td>18</td>
<td>18</td>
<td>36</td>
<td>5,000</td>
</tr>
<tr>
<td>RNase P Std. 1</td>
<td>3 (5,000)</td>
<td>Dilution 2</td>
<td>18</td>
<td>18</td>
<td>36</td>
<td>2,500</td>
</tr>
<tr>
<td>RNase P Std. 1</td>
<td>4 (2500)</td>
<td>Dilution 3</td>
<td>18</td>
<td>18</td>
<td>36</td>
<td>1250</td>
</tr>
<tr>
<td>RNase P Std. 1</td>
<td>5 (1250)</td>
<td>Dilution 4</td>
<td>18</td>
<td>18</td>
<td>36</td>
<td>625</td>
</tr>
</tbody>
</table>

1. Prepare five standard dilutions:

Note: For dilution 1, first vortex the stock for 3 to 5 seconds, then centrifuge the RNase P Std. 1 tube briefly before pipetting stock into the tube.

For each dilution:
Chapter 3  Prepare the Reactions

Prepare the reaction mix (“cocktail mix”)

For the RNase P assay (Standard Curve example experiment), the following table lists the universal assay conditions (volume and final concentration) for using the TaqMan® Fast Universal PCR Master Mix.

<table>
<thead>
<tr>
<th>Reaction component</th>
<th>Volume for 1 reaction (µL)</th>
<th>Volume for 384 reactions + 10% excess (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® Fast Universal PCR Master Mix Kit</td>
<td>5</td>
<td>2112</td>
</tr>
<tr>
<td>RNase P Assay (20X)</td>
<td>0.5</td>
<td>211.2</td>
</tr>
<tr>
<td>Water</td>
<td>3.5</td>
<td>1478.4</td>
</tr>
<tr>
<td>Total reaction mix volume</td>
<td>9</td>
<td>3801.6</td>
</tr>
</tbody>
</table>

1. Label an appropriately sized tube for the reaction mix: RNase P Reaction Mix.
2. Add the required volumes of each cocktail mix component to the tube.
   
   Note: Do not add the sample or standard at this time.
3. Mix the cocktail thoroughly by gently pipetting up and down several times, then cap the tube.
4. Centrifuge the tube briefly to remove air bubbles.
5. Place the cocktail mix on ice until you prepare the reaction plate.

Note: You can separately add the sample to the reaction plate, as opposed to preparing individual reaction mixes for each sample.

Prepare the reaction plate

Example experiment reaction plate components

The reaction plate for the Standard Curve example experiment contains:

- A MicroAmp® Optical 384-Well Reaction Plate
- Reaction volume: 10 µL/well
- 288 Unknown wells
- 80 Standard wells
- 16 Negative Control wells
Chapter 3  Prepare the Reactions

Prepare the reaction plate

The plate layout looks like this:

To prepare the reaction plate components

1. Prepare the negative control reactions for the target:
   a. To an appropriately sized tube, add the volumes of reaction mix and water listed below.

<table>
<thead>
<tr>
<th>Tube</th>
<th>Reaction mix</th>
<th>Reaction mix volume (µL) (includes 10% excess)</th>
<th>Water volume (µL) (includes 10% excess)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RNase P reaction mix</td>
<td>157.5</td>
<td>17.5</td>
</tr>
</tbody>
</table>

   b. Mix the reaction by gently pipetting up and down, then cap the tube.
   c. Centrifuge the tube briefly to remove air bubbles.
   d. Add 10 µL of the negative control reaction to the appropriate wells in the reaction plate.

2. For each replicate group, prepare the standard reactions:
   a. To appropriately sized tubes, add the volumes of reaction mix and standard listed below.
Chapter 3  Prepare the Reactions

Prepare the reaction plate

3. Prepare the reactions:

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 10 µL of the standard reaction to the appropriate wells in the reaction plate.

3. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample listed below.

<table>
<thead>
<tr>
<th>Tube</th>
<th>Standard reaction</th>
<th>Reaction mix</th>
<th>Reaction mix volume (µL) (includes 10% excess)</th>
<th>Standard</th>
<th>Standard volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RNase P Std 1</td>
<td>RNase P reaction mix</td>
<td>157.5</td>
<td>RNase P Std 1</td>
<td>17.5</td>
</tr>
<tr>
<td>2</td>
<td>RNase P Std 2</td>
<td>RNase P reaction mix</td>
<td>157.5</td>
<td>RNase P Std 2</td>
<td>17.5</td>
</tr>
<tr>
<td>3</td>
<td>RNase P Std 3</td>
<td>RNase P reaction mix</td>
<td>157.5</td>
<td>RNase P Std 3</td>
<td>17.5</td>
</tr>
<tr>
<td>4</td>
<td>RNase P Std 4</td>
<td>RNase P reaction mix</td>
<td>157.5</td>
<td>RNase P Std 4</td>
<td>17.5</td>
</tr>
<tr>
<td>5</td>
<td>RNase P Std 5</td>
<td>RNase P reaction mix</td>
<td>157.5</td>
<td>RNase P Std 5</td>
<td>17.5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tube</th>
<th>Unknown reaction</th>
<th>Reaction mix</th>
<th>Reaction mix volume (µL) (includes 10% excess)</th>
<th>Sample</th>
<th>Sample volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RNase P pop1</td>
<td>RNase P reaction mix</td>
<td>1422 pop1</td>
<td>158</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RNase P pop2</td>
<td>RNase P reaction mix</td>
<td>1422 pop2</td>
<td>158</td>
<td></td>
</tr>
</tbody>
</table>

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 10 µL of the unknown (sample) reaction to the appropriate wells in the reaction plate.

4. Seal the reaction plate with optical adhesive film.
5. Centrifuge the reaction plate briefly to remove air bubbles.

6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the reaction plate again at a higher speed and for a longer period of time.

7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning the reaction plate components</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
<tr>
<td>Sealing the reaction plate</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
</tbody>
</table>
Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K Flex Instrument.

This chapter covers:
■ Start the run ................................................................. 23
■ Monitor the run .............................................................. 23

IMPORTANT! Run the experiment at the same ambient temperature at which you calibrated the instrument. Extreme variations in ambient temperature can affect the heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 12K Flex Instrument is in operation.

Start the run

1. Open the Standard Curve example file that you created using instructions in Chapter 2.
2. Load the reaction plate into the instrument.
3. Start the run.

Monitor the run

Monitor the example experiment run:
• From the QuantStudio™ 12K Flex Software using the Run screen, while the experiment is in progress.
• From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor an experiment started from another computer or from the QuantStudio™ 12K Flex Instrument touchscreen).
• From the QuantStudio™ 12K Flex Instrument touchscreen.

**From the Instrument Console of the QuantStudio™ 12K Flex Software**

1. In the Instrument Console screen, select the instrument icon.
2. Click Manage Instrument or double-click on the instrument icon.
3. On the Manage Instrument screen, click Monitor Running Experiment to access the Run screen.
View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all the three plots available from the QuantStudio™ 12K Flex Software for potential problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab, then select the wells to view.

The figure below shows the Amplification Plot screen as it appears at the end of the example experiment.

View the Temperature Plot

Click Temperature Plot from the Run Experiment Menu.

The figure below shows the Temperature Plot screen as it appears during the example experiment.
Note: The Sample temperature displayed in the Current Temperatures group is an estimated value.

View the Run Method

Click **Run Method** from the Run Experiment Menu.

The figure below shows the Run Method screen as it appears in the example experiment.

View the run data

Click **View Run Data** from the Run Experiment Menu.

The figure below shows the View Run Data screen as it appears in the example experiment.
You can also view the progress of the run from the touchscreen of the QuantStudio™ 12K Flex Instrument.

The Run Method screen on the QuantStudio™ 12K Flex Instrument touchscreen looks like this:

**Experiment View**

![Experiment View Screenshot]

*Note:* The above screenshot is for visual representation only. Actual results will vary with the experiment.

**Time View**

![Time View Screenshot]
Chapter 4 Run the Experiment
Monitor the run

Plot View
Chapter 4  Run the Experiment

Monitor the run
In Section 5.1 of this chapter you review the analyzed data using several of the analysis screens and publish the data. Section 5.2 of this chapter walks you through the process of modifying experiment parameters to troubleshoot problems with experiment results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ......................................................... 31

- Analyze the example experiment ........................................... 31
- View the Standard Curve Plot .............................................. 31
- Assess amplification results using the Amplification Plot .......... 33
- Identify well problems using the Well Table .......................... 40
- Confirm accurate dye signal using the Multicomponent Plot .... 43
- Determine signal accuracy using the Raw Data Plot ................. 45
- Review the flags in the QC Summary .................................... 47
- For more information ......................................................... 48

Section 5.2 Adjust parameters for re-analysis of your own experiments .......... 49

- Adjust analysis settings .................................................... 49
- Improve $C_T$ precision by omitting wells ............................. 53
- For more information ....................................................... 54
Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.
2. Click Analyze. The software analyzes the data using the default analysis settings.
   Note: You can also access the experiment to analyze from the Home screen.

View the Standard Curve Plot

The Standard Curve Plot screen displays the standard curve for samples designated as standards. The QuantStudio™ 12K Flex Software calculates the quantity of an unknown target from the standard curve.

Purpose

The purpose of viewing the standard curve for the example experiment is to identify:
- Slope and amplification efficiency
- R² value (correlation coefficient)
- Cₜ values

To view and assess the Standard Curve Plot

1. From the Experiment Menu pane, select Analysis ▶ Standard Curve.
   Note: If no data are displayed, click Analyze.
2. Display all 384 wells in the Standard Curve Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.
3. Enter the Plot Settings:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>All</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Target</td>
</tr>
<tr>
<td></td>
<td>Check [default]</td>
</tr>
</tbody>
</table>

   [This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.]

4. View the values displayed below the standard curve.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slope</td>
<td>-3.372</td>
</tr>
<tr>
<td>R²</td>
<td>0.994</td>
</tr>
<tr>
<td>Amplification efficiency</td>
<td>97.944%</td>
</tr>
<tr>
<td>Error</td>
<td>0.03</td>
</tr>
</tbody>
</table>
5. Check that all samples are within the standard curve. In the example experiment, as shown below, all samples (blue dots) are within the standard curve (red dots).

6. Check the $C_T$ values:
   a. Click the **Well Table** tab.
   b. From the Group By menu, select **Replicate**.
   c. Look at the values in the $C_T$ column. In the example experiment, the $C_T$ values fall within the expected range (>8 and <35).
Tips for analyzing your own experiments

When you analyze your own standard curve experiment, look for:

- **Slope and amplification efficiency values** – The amplification efficiency is calculated using the slope of the regression line in the standard curve. A slope close to \(-3.3\) indicates optimal, 100% PCR amplification efficiency. Factors that affect amplification efficiency:
  - Range of standard quantities – For accurate and precise efficiency measurements, use a broad range of standard quantities, 5 to 6 logs (10^5 to 10^6 fold).
  - Number of standard replicates – For accurate efficiency measurements, include replicates to decrease the effects of pipetting inaccuracies.
  - PCR inhibitors – PCR inhibitors in the reaction can reduce amplification efficiency.

- **R^2 values (correlation coefficient)** – The R^2 value is a measure of the closeness of fit between the regression line and the individual CT data points of the standard reactions. A value of 1.00 indicates a perfect fit between the regression line and the data points. An R^2 value >0.99 is desirable.

- **CT values** – The threshold cycle (CT) is the PCR cycle number at which the fluorescence level meets the threshold.
  - A CT value >8 and <35 is desirable.
  - A CT value <8 indicates that there is too much template in the reaction.
  - A CT value >35 indicates a low amount of target in the reaction; for CT values >35, expect a higher standard deviation.

If your experiment does not meet the guidelines above, troubleshoot as follows:

- Omit wells (see “Improve CT precision by omitting wells” on page 53).
- Rerun the experiment.

Assess amplification results using the Amplification Plot

Amplification plots available for viewing

The Amplification Plot screen displays amplification of all samples in the selected wells. There are three plots available:

- **ΔRn vs Cycle** – ΔRn is the magnitude of normalized fluorescence signal generated by the reporter at each cycle during the PCR amplification. This plot displays ΔRn as a function of cycle number. Use this plot to identify and examine irregular amplification and to view threshold and baseline values for the run.

- **Rn vs Cycle** – Rn is the fluorescence signal from the reporter dye normalized to the fluorescence signal from the passive reference. This plot displays Rn as a function of cycle number. Use this plot to identify and examine irregular amplification.

- **CT vs Well** – CT is the PCR cycle number at which the fluorescence meets the threshold in the amplification plot. This plot displays CT as a function of well position. Use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.
Purpose

The purpose of viewing the amplification plot for the example experiment is to identify:

- Correct baseline and threshold values
- Outliers

View the Amplification Plot

1. From the Experiment Menu pane, select Analysis ➔ Amplification Plot.
   Note: If no data are displayed, click Analyze.

2. Display the RNase P wells in the Amplification Plot screen. Click the Plate Layout tab. Enter the Plot Settings:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Wells With</td>
<td>Target ➔ RNaseP</td>
</tr>
</tbody>
</table>

3. In the Amplification Plot screen, enter:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>ΔRn vs Cycle</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Well (default)</td>
</tr>
</tbody>
</table>
4. View the baseline values.
   a. From the Graph Type drop-down menu, select Linear.
   b. Select the Baseline check box to show the start cycle and end cycle.
   c. Verify that the baseline is set correctly: The end cycle should be set a few cycles before the cycle number where significant fluorescent signal is detected. In the example experiment, the baseline is set correctly.

   ![Amplification Plot]

5. View the threshold values.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Type</td>
<td>Log</td>
</tr>
<tr>
<td>Target</td>
<td>RNaseP</td>
</tr>
</tbody>
</table>

   a. Select the Threshold check box to show the threshold.
b. Verify that the threshold is set correctly. In the example experiment, the threshold is in the exponential phase.

6. Locate outliers:
   a. From the Plot Type drop-down menu, select $C_T$ vs Well.
   b. Look for outliers from the amplification plot. In the example experiment, there are no outliers for RNase P.
When you analyze your own standard curve experiment, look for:

- **Outliers**

- **A typical amplification plot** – The QuantStudio™ 12K Flex Software automatically calculates baseline and threshold values based on the assumption that the data exhibit a *typical* amplification plot. A typical amplification plot has four distinct sections:
  - Plateau phase
  - Linear phase
  - Exponential (geometric phase)
  - Baseline

A typical amplification plot should look like this:

![Amplification Plot](image)

**IMPORTANT!** Experimental error (such as contamination or pipetting errors) can produce atypical amplification curves that can result in incorrect baseline and threshold value calculations by the QuantStudio™ 12K Flex Software. Life Technologies recommends that you examine the Amplification Plot screen and review the assigned baseline and threshold values for each well after analysis.
Chapter 5 Review Results and Adjust Experiment Parameters

Assess amplification results using the Amplification Plot

**Note:** If you use the Relative Threshold algorithm to analyze an experiment that includes amplification, select to view the analysis results using the ΔRn vs Cycle, Rn vs Cycle, or C<sub>RT</sub> vs Well plot type and Linear or Log graph type. Also select the **Show Crt** check box to view the derived fractional cycle on the amplification plot.

- Correct threshold values:

**Threshold Set Correctly**

The threshold is set in the exponential phase of the amplification curve. Threshold settings above or below the optimum increase the standard deviation of the replicate groups.

**Threshold Set Too Low**

The threshold is set below the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar up into the exponential phase of the curve.
**Threshold Set Too High**  
The threshold is set above the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar down into the exponential phase of the curve.

- **Correct baseline values:**

**Baseline Set Correctly**  
The amplification curve begins after the maximum baseline.

**Baseline Set Too Low**  
The amplification curve begins too far to the right of the maximum baseline. Increase the End Cycle value.

**Baseline Set Too High**  
The amplification curve begins before the maximum baseline. Decrease the End Cycle value.
If your experiment does not meet the guidelines above, troubleshoot as follows:

- Omit wells (see “Improve C_T precision by omitting wells” on page 53).
  
  Or

- Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on page 49).

### Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including:

- The sample name, target name, task, and dyes
- The calculated threshold cycle (C_T), normalized fluorescence (Rn), and quantity values
- Comments
- Flags

**Purpose**

The purpose of viewing the well table is to identify:

- Quantity values
- Flags
- C_T values (including C_T standard deviation)

**View the well table**

1. From the Experiment Menu pane, select Analysis, then select the Well Table tab.

   **Note:** If no data are displayed, click Analyze.

2. Use the Group By drop-down menu to group wells by a specific category. For the example experiment, group the wells by replicate, flag, or C_T value.

   **Note:** You can select only one category at a time.

**To group by replicate**

From the Group By drop-down menu, select Replicate. The software groups the replicate wells: negative controls, standards, and samples. In the example experiment, note that the quantity values within each replicate group are similar.
### Section 5.1 Review Results

**Identify well problems using the Well Table**

**Note:** In the example experiment, the Quantity, Quantity Mean, and Quantity SD columns have been moved from their default locations to the beginning of the Well Table. To move a column, click and drag on the column heading.

The well table looks like this:

<table>
<thead>
<tr>
<th>Well</th>
<th>Sample Name</th>
<th>Target Name</th>
<th>Ct Mean</th>
<th>Ct SD</th>
<th>Quantity</th>
<th>Quantity Mean</th>
<th>Quantity SD</th>
<th>NTC</th>
<th>OQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td></td>
<td></td>
<td>27.798</td>
<td>0.198</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A2</td>
<td></td>
<td></td>
<td>28.275</td>
<td>0.127</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A3</td>
<td></td>
<td></td>
<td>29.487</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4</td>
<td></td>
<td></td>
<td>26.602</td>
<td>0.121</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A5</td>
<td></td>
<td></td>
<td>25.889</td>
<td>0.126</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A6</td>
<td></td>
<td></td>
<td>24.949</td>
<td>0.131</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A7</td>
<td></td>
<td></td>
<td>27.198</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A8</td>
<td></td>
<td></td>
<td>27.538</td>
<td>0.135</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A9</td>
<td></td>
<td></td>
<td>27.798</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A10</td>
<td></td>
<td></td>
<td>28.275</td>
<td>0.127</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A11</td>
<td></td>
<td></td>
<td>29.487</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A12</td>
<td></td>
<td></td>
<td>26.602</td>
<td>0.121</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B1</td>
<td></td>
<td></td>
<td>27.798</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B2</td>
<td></td>
<td></td>
<td>28.275</td>
<td>0.127</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B3</td>
<td></td>
<td></td>
<td>29.487</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B4</td>
<td></td>
<td></td>
<td>27.798</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B5</td>
<td></td>
<td></td>
<td>28.275</td>
<td>0.127</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B6</td>
<td></td>
<td></td>
<td>29.487</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B7</td>
<td></td>
<td></td>
<td>27.198</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B8</td>
<td></td>
<td></td>
<td>27.538</td>
<td>0.135</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B9</td>
<td></td>
<td></td>
<td>27.798</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B10</td>
<td></td>
<td></td>
<td>28.275</td>
<td>0.127</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B11</td>
<td></td>
<td></td>
<td>29.487</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B12</td>
<td></td>
<td></td>
<td>26.602</td>
<td>0.121</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Well Summary:**

<table>
<thead>
<tr>
<th>Well</th>
<th>Sample Name</th>
<th>Target Name</th>
<th>Ct Mean</th>
<th>Ct SD</th>
<th>Quantity</th>
<th>Quantity Mean</th>
<th>Quantity SD</th>
<th>NTC</th>
<th>OQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td></td>
<td></td>
<td>27.798</td>
<td>0.198</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A2</td>
<td></td>
<td></td>
<td>28.275</td>
<td>0.127</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A3</td>
<td></td>
<td></td>
<td>29.487</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4</td>
<td></td>
<td></td>
<td>26.602</td>
<td>0.121</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A5</td>
<td></td>
<td></td>
<td>25.889</td>
<td>0.126</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A6</td>
<td></td>
<td></td>
<td>24.949</td>
<td>0.131</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A7</td>
<td></td>
<td></td>
<td>27.198</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A8</td>
<td></td>
<td></td>
<td>27.538</td>
<td>0.135</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A9</td>
<td></td>
<td></td>
<td>27.798</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A10</td>
<td></td>
<td></td>
<td>28.275</td>
<td>0.127</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A11</td>
<td></td>
<td></td>
<td>29.487</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A12</td>
<td></td>
<td></td>
<td>26.602</td>
<td>0.121</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B1</td>
<td></td>
<td></td>
<td>27.798</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B2</td>
<td></td>
<td></td>
<td>28.275</td>
<td>0.127</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B3</td>
<td></td>
<td></td>
<td>29.487</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B4</td>
<td></td>
<td></td>
<td>27.798</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B5</td>
<td></td>
<td></td>
<td>28.275</td>
<td>0.127</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B6</td>
<td></td>
<td></td>
<td>29.487</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B7</td>
<td></td>
<td></td>
<td>27.198</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B8</td>
<td></td>
<td></td>
<td>27.538</td>
<td>0.135</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B9</td>
<td></td>
<td></td>
<td>27.798</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B10</td>
<td></td>
<td></td>
<td>28.275</td>
<td>0.127</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B11</td>
<td></td>
<td></td>
<td>29.487</td>
<td>0.133</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B12</td>
<td></td>
<td></td>
<td>26.602</td>
<td>0.121</td>
<td>5.525</td>
<td>4.996</td>
<td>1.705</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 5  Review Results and Adjust Experiment Parameters

Identify well problems using the Well Table

To group by flag

From the Group By drop-down menu, select Flag. The software groups the flagged and unflagged wells. In the example experiment, there are four flagged wells.

To group by C_T value

From the Group By drop-down menu, select C_T. The software groups the wells by C_T value: low, medium, high, and undetermined. In the example experiment, the C_T values are within the expected range (>8 and <35).
Tips for analyzing your own experiments

- **Replicate** – The software groups the wells by replicate: negative controls, standards, and samples. Look in the Quantity columns to make sure the quantity values for each replicate group are similar indicating tight C_T precision.

- **Flag** – The software groups the flagged and unflagged wells. A flag indicates that the software has found a potential error in the flagged well. For a description of the QuantStudio™ 12K Flex Software flags, see “Flag Settings” on page 51.

- **C_T** – The threshold cycle (C_T) is the PCR cycle number at which the fluorescence level meets the threshold. A C_T value >8 and <35 is desirable. A C_T value <8 indicates that there is too much template in the reaction. A C_T value >35 indicates a low amount of target in the reaction; for C_T values >35, expect a higher standard deviation.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

**Purpose**

In the standard curve example experiment, you review the Multicomponent Plot screen for:

- ROX™ dye (passive reference)
- FAM™ dye (reporter)
- Spikes, dips, and/or sudden changes
- Amplification in the negative control wells

**View the Multicomponent Plot**

1. From the Experiment Menu pane, select Analysis ⟷ Multicomponent Plot.
   
   **Note**: If no data are displayed, click Analyze.

2. Display the unknown and standard wells one at a time in the Multicomponent Plot screen:
   
   a. Click the Plate Layout tab.
   
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.

   **Note**: If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click Show a legend for the plot (default).

   **Note**: This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal remains constant throughout the PCR process; a constant ROX dye signal indicates typical data.
6. Check the FAM dye signal. In the example experiment, the FAM dye signal increases throughout the PCR process; increase in FAM dye signal indicates normal amplification.

7. Select the negative control wells one at time and check for amplification. In the example experiment, there is no amplification in the negative control wells.
Tips for confirming dye accuracy in your own experiment

When you analyze your own standard curve experiment, look for:

- **Passive reference** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.
- **Reporter dye** – The reporter dye fluorescence level should display a flat region corresponding to the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.
- **Irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.
- **Negative Control wells** – There should not be any amplification in the negative control wells.

**Determine signal accuracy using the Raw Data Plot**

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter for the selected wells during each cycle of the real-time PCR.

**Purpose**

In the standard curve example experiment, you review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

**View the Raw Data Plot**

1. From the Experiment Menu pane, select Analysis → Raw Data Plot.
   
   **Note:** If no data are displayed, click Analyze.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.

3. Click Show a legend for the plot (default). The legend displays the color code for each row of the reaction plate (see the legend in the Raw Data Plot shown below).
4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example experiment, there is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.

The filters used for the example experiment are:

Tips for determining signal accuracy in your own experiments

When you analyze your own standard curve experiment, look for the following in each filter:
- Characteristic signal growth
- No abrupt changes or dips
Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags, including the flag frequency and location for the open experiment.

View the QC Summary

1. From the Experiment Menu pane, select Analysis ▶ QC Summary.
   Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.
   Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment. If the frequency is >0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.

   In the example experiment, there are four flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed information about the flag. In the example experiment, the Frequency column displays 0 for all flags.

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view information on correcting the flag.

   Possible flags

   The flags listed below may be triggered by the experiment data.

   Note: To change the flag settings, refer to “Flag Settings” on page 51.
### Flag Description

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pre-processing flag</strong></td>
<td></td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td><strong>Primary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>$C_T$ algorithm failed</td>
</tr>
<tr>
<td>AMPSCORE</td>
<td>Amplification in the linear region is below a certain threshold, corresponding to the score set in the analysis settings</td>
</tr>
<tr>
<td><strong>Secondary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>OUTLIERRG</td>
<td>Outlier in replicate group</td>
</tr>
<tr>
<td>AMPNC</td>
<td>Amplification in negative control</td>
</tr>
<tr>
<td>HIGHSD</td>
<td>High standard deviation in replicate group</td>
</tr>
</tbody>
</table>

**Note:** When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

### For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing data</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
</tbody>
</table>
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle (CT), flags, and advanced options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.
2. Click Analysis ➔ Analysis Settings to open the Analysis Settings dialog box.
   In the example experiment, the default analysis settings are used for each tab:
   - CT Settings
   - Flag Settings
   - Advanced Settings
   - Standard Curve Settings
   The Analysis Settings dialog box for a Standard Curve experiment looks like this:
3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” below).

   **Note:** You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, *Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments*.

4. Click **Apply Analysis Settings** to apply the current analysis settings.

   **Note:** You can go back to the default analysis settings, by clicking **Revert to Default Analysis Settings**.

---

### Adjust analysis settings

#### C<sub>T</sub> Settings

- **Data Step Selection**
  
  Use this feature to select one stage/step combination for C<sub>T</sub> analysis when there is more than one data collection point in the run method.

- **Algorithm Settings**
  
  You can select the algorithm that determines the C<sub>T</sub> values. There are two algorithms: Baseline Threshold (the default) and Relative Threshold.

  The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for quantification.

  The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no dependence on targets, thereby reducing variability. It is not necessary to set either a baseline or a threshold when you use the Relative Threshold algorithm, so any settings for baseline or threshold will not affect the analysis.

- **Default C<sub>T</sub> Settings**
  
  Use the default C<sub>T</sub> settings feature to calculate C<sub>T</sub> for the targets that do not have custom settings. To edit the default settings, click **Edit Default Settings**.

- **C<sub>T</sub> Settings for Target**
  
  When you manually set the threshold and baseline, Life Technologies recommends:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Enter a value for the threshold so that the threshold is:</td>
</tr>
<tr>
<td></td>
<td>• Above the background.</td>
</tr>
<tr>
<td></td>
<td>• Below the plateau and linear regions of the amplification curve.</td>
</tr>
<tr>
<td></td>
<td>• Within the exponential phase of the amplification curve.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Select the Start Cycle and End Cycle values so that the baseline ends before significant fluorescent signal is detected.</td>
</tr>
</tbody>
</table>

**Note:** This setting is applicable only to the Baseline Threshold algorithm.

**Note:** Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.
Flag Settings

Use the Flag Settings tab to:

- Adjust the sensitivity so that more wells or fewer wells are flagged.
- Change the flags that are applied by the QuantStudio™ 12K Flex Software.

To adjust the flag settings:

1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.
   
   **Note:** If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.
   
   **Note:** After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments using the Standard Deviation calculations may change the result of CT SD. For some flags, analysis results calculated before the well is rejected are maintained.

4. Click **Apply Analysis Settings** in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.

The Flag Settings tab looks like this:

![Flag Settings Table Example](image-url)
Advanced Settings

Use the Advanced Settings tab to change baseline settings well-by-well.

**Note:** The baseline and threshold values do not affect the analysis using the Relative Threshold algorithm.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.
2. Deselect the **Use C_T Settings Defined for Target** check box.
3. Define the custom baseline settings:
   - For automatic baseline calculations, select the **Automatic Baseline** check box.
   - To define the baseline, deselect the **Automatic Baseline** check box, then enter the baseline start cycle and baseline end cycle.

Standard Curve Settings

Use this tab to review the settings of the current standard curve experiment or to import the standard curve from an external experiment (with the same samples and targets) and apply it to the current experiment.

**Note:** The run method must be the same. Life Technologies recommends using the standard curve from the current experiment.

For the example experiment, the settings from the current experiment have been used.
Improve $C_T$ precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all. These wells typically produce $C_T$ values that differ significantly from the average for the associated replicate wells. If included in the calculations, these outliers can result in erroneous measurements; to ensure $C_T$ precision, omit the outliers from the analysis.

1. From the Experiment Menu pane, select **Analysis** ➤ **Amplification Plot**.
   **Note:** If no data are displayed, click **Analyze**.

2. In the Amplification Plot screen, select **$C_T$ vs Well** from the Plot Type drop-down menu.

3. Select the **Well Table** tab.

4. In the Well Table, view outliers:
   a. From the Group By drop-down menu, select **Replicate**.
   b. Look for any outliers in the replicate group (make sure they are flagged).
   c. Select the **Omit** check box next to outlying well(s), as shown below.

5. Click **Analyze** to reanalyze the experiment data with the outlying well(s) removed from the analysis.
   **Note:** You can also omit undesirable wells in an experiment from the Plate Layout screen. To omit a well from the Plate Layout screen, right-click the well and select **Omit**.
For more information

<table>
<thead>
<tr>
<th>For more information on</th>
<th>Refer to</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification efficiency</td>
<td>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note.</td>
<td>127AP05-03</td>
</tr>
</tbody>
</table>
Export Analysis Results

1. Open the Standard Curve example experiment file that you analyzed in Chapter 5.

2. In the Experiment Menu, click Export.

   **Note:** To export data automatically after analysis, select the **Auto Export** check box during experiment setup or before running the experiment. Auto export is unchecked for the example experiment.

3. Select **QuantStudio™ 12K Flex format**.

4. Complete the Export dialog box as shown below:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export/ Select</td>
<td>Results</td>
</tr>
<tr>
<td>Content</td>
<td></td>
</tr>
<tr>
<td>Export Data To</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>384-Well Fast Standard Curve Example_QuantStudio_export</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td>&lt;drive&gt;:\Applied Biosystems\QuantStudio 12K Flex Software\User Files\experiments</td>
</tr>
</tbody>
</table>
Chapter 6  Export Analysis Results

Your Export screen should look like this:

Your exported file when opened in Notepad should look like this:
**Index**

**A**
- absolute quantity 5
- adjusting analysis settings 51
- adjusting parameters, re-analyzing own experiments 51
- Advanced Settings tab 54
- Algorithm Settings
  - Baseline Threshold 52
  - Relative Threshold 52
- amplification efficiency, factors affecting
  - PCR inhibitors 33
  - standard quantities 33
  - standard replicates 33
- amplification plot
  - amplification efficiency 15, 33, 56
  - assessing amplification results 34
  - reviewing baseline values 35
  - reviewing outliers 37
  - reviewing threshold values 36
  - tips for analyzing own experiments 38
  - viewing 24, 34
- AMPNC flag 49
- AMPSCORE flag 49
- analysis results, exporting 57
- Analysis Settings
  - Advanced Settings 51
  - $C_T$ Settings 51
  - Flag Settings 51
  - Standard Curve Settings 51
- Analyze
  - Amplification Plot 34
  - Multicomponent Plot 44
  - QC Summary 48
  - Raw Data Plot 46
  - Standard Curve Plot 31
  - Well Table 42
- Auto Export 57
- Automatic Threshold 52

**B**
- BADROX flag 49
- baseline values, correcting 41
- BLFAIL flag 49

**C**
- cocktail mix 19
- components

**D**
- designing experiment
  - assigning targets, samples, and biological groups 11
  - defining and setting up standards 11
  - defining experiment properties 9
  - defining targets, samples, and biological replicates 10
  - setting up run method 13
- dye accuracy
  - irregularities in the signal 46
  - negative control wells 46
  - passive reference 46
  - reporter dye 46

**E**
- example experiment 6
- experiment properties, defining 9
- EXPFAIL flag 49
- exporting analysis results 57

**F**
- Flag Settings tab 53
- flags
  - primary analysis 49
- flags, QC
  - AMPNC 49
  - AMPSCORE 49
  - BADROX 49
  - BLFAIL 49
  - CTFAIL 49
  - EXPFAIL 49
  - HIGHSD 49
  - NOAMP 49
  - NOISE 49
  - NOSIGNAL 49
  - OFFSCALE 49

reaction mix 17
reaction plate 20
correlation coefficient 33
$C_T$ settings
  - algorithm settings 52
  - data step, selecting 52
  - default 52
  - target 52
$C_T$ Settings tab 52, 49
Sample dilutions, preparing reactions 17
Samples, defining 10
Secondary analysis flags
- AMPNC 49
- HIGHSD 49
- OUTLIERRG 49
SPIKE flag 49
Standard 5
Standard curve experiments
- about 5
- overview 5
- PCR options 5
- required components, assemble 5
Standard curve plot
- tips for analyzing own experiment 33
- viewing 31
- viewing and assessing 31
Standard Curve Settings tab 54
Standard curve values
- amplification efficiency 31
- correlation coefficient 31
- $C_T$ values 31
Standard dilution series, preparing reactions 18
Standards, defining and setting up 11

Targets and samples, assigning 12
Targets, defining 10
Targets, samples, and biological groups, assigning 11
Targets, samples, and biological replicates, defining 10
Temperature plot, viewing 25
THOLDFAIL flag 49
Threshold cycle 34
Threshold values, correcting 40
Touchscreen, running experiment from
  - Experiment View 26
  - Plot View 27
  - Time View 27

Well table
- assessing own experiments 44
Booklet 3 - Running Relative Standard Curve and Comparative $C_T$ Experiments

Publication Part Number: 4470050 Rev. A
Revision Date: March 2012
For Research Use Only. Not intended for any animal or human therapeutic or diagnostic use.
## Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>About Relative Standard Curve Experiments</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>About Relative Standard Curve experiments</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Assemble required components</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>PCR options</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>About the example experiment</td>
<td>11</td>
</tr>
<tr>
<td>2</td>
<td>Design the Experiment</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Define the experiment properties</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Define targets, samples, and biological replicates</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>Assign targets, samples, and biological groups</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>Set up the run method</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>Tips for designing your own experiment</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>For more information</td>
<td>19</td>
</tr>
<tr>
<td>3</td>
<td>Prepare the Reactions</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Assemble required materials</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Prepare the template</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Example experiment settings</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>To prepare the template</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Prepare the sample dilutions</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Prepare the standard dilution series for FAS and HPRT assays</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Prepare the reaction mix (“cocktail mix”)</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Prepare the reaction plate</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>Example experiment reaction plate components</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>To prepare the reaction plate components</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>Tips for preparing reactions for your own experiments</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Tips for preparing templates</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Tips for preparing sample dilutions</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Tips for preparing the reaction mix</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Tips for preparing the reaction plate</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>For more information</td>
<td>27</td>
</tr>
<tr>
<td>4</td>
<td>Run the Experiment</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>Start the run</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>Monitor the run</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>From the Instrument Console of the QuantStudio™ 12K Flex Software</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>From the QuantStudio™ 12K Flex Instrument touchscreen</td>
<td>32</td>
</tr>
</tbody>
</table>
CHAPTER 5

Review Results and Adjust Experiment Parameters 35

Section 5.1 Review Results 37

Analyze the example experiment 37

View the Standard Curve Plot 37

Example experiment standard curve values 37

To view and assess the Standard Curve plot 37

Tips for analyzing your own experiments 39

Assess amplification results using the Amplification Plot 39

Amplification plots available for viewing 39

Purpose 40

View the Amplification Plot 40

Tips for analyzing your own experiments 43

Assess the gene expression profile using the Gene Expression Plot 46

Example experiment values 47

View the Gene Expression Plot 47

Assessing the gene expression plot in your own experiments 48

Identify well problems using the Well Table 48

Example experiment values and flags 48

View the well table 49

Assessing the well table in your own experiments 49

Confirm accurate dye signal using the Multicomponent Plot 50

Purpose 50

View the Multicomponent Plot 50

Tips for confirming dye accuracy in your own experiment 51

Determine signal accuracy using the Raw Data Plot 51

About the example experiment 51

View the Raw Data Plot 51

Tips for determining signal accuracy in your own experiment 52

View the endogenous control profile using the QC Plot 53

Review the QC flags in the QC Summary 54

View the QC Summary 54

Possible flags 55

For more information 55

Section 5.2 Adjust parameters for re-analysis of your own experiments 57

Adjust analysis settings 57

View the analysis settings 58

Adjust analysis settings 58

Improve C_T precision by omitting wells 61

For more information 62
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHAPTER 6</td>
<td>Export Analysis Results</td>
<td>65</td>
</tr>
<tr>
<td>CHAPTER 7</td>
<td>About Comparative C&lt;sub&gt;T&lt;/sub&gt; Experiments</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>About Comparative C&lt;sub&gt;T&lt;/sub&gt; experiments</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>Assemble required components</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>PCR options</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>About the example experiment</td>
<td>71</td>
</tr>
<tr>
<td>CHAPTER 8</td>
<td>Design the Experiment</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Define the experiment properties</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Define targets, samples and biological replicates</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>Assign targets, samples and biological groups</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>Set up the run method</td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>Tips for designing your own experiment</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>For more information</td>
<td>79</td>
</tr>
<tr>
<td>CHAPTER 9</td>
<td>Prepare the Reactions</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Assemble required materials</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Prepare the template</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Example experiment settings</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Prepare the template</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>Prepare the sample dilutions</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>Prepare the reaction mix (&quot;cocktail mix&quot;)</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>Prepare the reaction plate</td>
<td>83</td>
</tr>
<tr>
<td></td>
<td>Example experiment reaction plate components</td>
<td>83</td>
</tr>
<tr>
<td></td>
<td>To prepare the reaction plate components</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Tips for preparing reactions for your own experiments</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Tips for preparing templates</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Tips for preparing the reaction mix</td>
<td>85</td>
</tr>
<tr>
<td></td>
<td>Tips for preparing the reaction plate</td>
<td>85</td>
</tr>
<tr>
<td></td>
<td>For more information</td>
<td>85</td>
</tr>
<tr>
<td>CHAPTER 10</td>
<td>Run the Experiment</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>Start the run</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>Monitor the run</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>From the Instrument Console of the QuantStudio™ 12K Flex Software</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>From the QuantStudio™ 12K Flex Instrument touchscreen</td>
<td>90</td>
</tr>
</tbody>
</table>
## CHAPTER 11  
**Review Results and Adjust Experiment Parameters**  

### Section 11.1 Review Results  

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze the example experiment</td>
<td>95</td>
</tr>
<tr>
<td>Assess the gene expression profile using the Gene Expression Plot</td>
<td>95</td>
</tr>
<tr>
<td>Example experiment values</td>
<td>96</td>
</tr>
<tr>
<td>View the Gene Expression Plot</td>
<td>96</td>
</tr>
<tr>
<td>Assessing the gene expression plot your own experiments</td>
<td>97</td>
</tr>
<tr>
<td>Identify well problems using the Well Table</td>
<td>97</td>
</tr>
<tr>
<td>Example experiment values and flags</td>
<td>97</td>
</tr>
<tr>
<td>View the well table</td>
<td>98</td>
</tr>
<tr>
<td>Assessing the well table in your own experiments</td>
<td>98</td>
</tr>
<tr>
<td>Assess amplification results using the Amplification Plot</td>
<td>99</td>
</tr>
<tr>
<td>Amplification plots available for viewing</td>
<td>99</td>
</tr>
<tr>
<td>Purpose</td>
<td>99</td>
</tr>
<tr>
<td>View the Amplification Plot</td>
<td>99</td>
</tr>
<tr>
<td>Tips for analyzing your own experiments</td>
<td>102</td>
</tr>
<tr>
<td>Confirm accurate dye signal using the Multicomponent Plot</td>
<td>106</td>
</tr>
<tr>
<td>Purpose</td>
<td>106</td>
</tr>
<tr>
<td>View the Multicomponent Plot</td>
<td>106</td>
</tr>
<tr>
<td>Tips for confirming dye accuracy in your own experiment</td>
<td>108</td>
</tr>
<tr>
<td>Determine signal accuracy using the Raw Data Plot</td>
<td>108</td>
</tr>
<tr>
<td>About the example experiment</td>
<td>108</td>
</tr>
<tr>
<td>View the Raw Data Plot</td>
<td>108</td>
</tr>
<tr>
<td>Tips for determining signal accuracy in your own experiment</td>
<td>110</td>
</tr>
<tr>
<td>View the endogenous control profile using the QC Plot</td>
<td>110</td>
</tr>
<tr>
<td>Example experiment settings</td>
<td>110</td>
</tr>
<tr>
<td>View the QC Plot</td>
<td>110</td>
</tr>
<tr>
<td>Review the flags in the QC Summary</td>
<td>111</td>
</tr>
<tr>
<td>View the QC Summary</td>
<td>111</td>
</tr>
<tr>
<td>Possible flags</td>
<td>112</td>
</tr>
</tbody>
</table>

For more information                                                      | 113  |

### Section 11.2 Adjust parameters for re-analysis of your own experiments  

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust analysis settings</td>
<td>115</td>
</tr>
<tr>
<td>View the analysis settings</td>
<td>115</td>
</tr>
<tr>
<td>Adjust analysis settings</td>
<td>116</td>
</tr>
<tr>
<td>Improve C&lt;sub&gt;T&lt;/sub&gt; precision by omitting wells</td>
<td>118</td>
</tr>
</tbody>
</table>

## CHAPTER 12  
**Export Analysis Results**  

## Index  

123
PART I

Running Relative Standard Curve Experiments
About Relative Standard Curve Experiments

This chapter covers:

- About Relative Standard Curve experiments. ........................................... 9
- About the example experiment ................................................................. 11

**IMPORTANT!** First-time users of the QuantStudio™ 12K Flex System, please read Booklet 1, *Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments* and Booklet 7, *QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments - Appendixes* of this binder thoroughly. The booklets provide information and general instructions that are applicable to all the experiments described in this binder.

**Note:** For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ 12K Flex Software by pressing F1, clicking ? in the toolbar, or selecting Help › QuantStudio™ 12K Flex Software Help.

### About Relative Standard Curve experiments

The Relative Standard Curve method is used to determine relative target quantity in samples. The QuantStudio™ 12K Flex Software measures amplification of the target and of the endogenous control in samples, in a reference sample, and in a standard dilution series. Measurements are normalized using the endogenous control. Data from the standard dilution series are used to generate the standard curve. Using the standard curve, the software interpolates target quantity and endogenous control quantity in the samples and the reference sample. For each sample and reference sample, the target quantity is normalized by endogenous control quantity (quantity of target/quantity of endogenous control). The normalized quotient from samples is divided by the quotient from the reference sample to get relative quantification (fold change). The software determines the relative quantity of target in each sample by comparing target quantity in each sample to target quantity in the reference sample.

Relative Standard Curve experiments are commonly used to:

- Compare expression levels of a gene in different tissues.
- Compare expression levels of a gene in a treated sample and an untreated sample.
- Compare expression levels of wild-type alleles and mutated alleles.
- Analyze the gene expression changes over time under specific treatment conditions.

**Assemble required components**

- **Sample** – The tissue group that you are testing for a target gene.
- **Reference sample (also called a calibrator)** – The sample used as the basis for relative quantification results. For example, in a study of drug effects on gene expression, an untreated control is an appropriate reference sample.
Chapter 1  About Relative Standard Curve Experiments

About Relative Standard Curve experiments

• **Standard** – A sample that contains known quantities of the target; used in quantification experiments to generate standard curves.

• **Standard dilution series** – A set of standards containing a range of known quantities. The standard dilution series is prepared by serially diluting standards.

• **Endogenous control** – A gene that is used to normalize template input differences, and sample-to-sample or run-to-run variation.

• **Replicates** – The total number of identical reactions containing identical components and identical volumes.

• **Negative Controls** – Wells that contain water or buffer instead of sample template. No amplification of the target should occur in the negative control wells.

**PCR options**

When performing real-time PCR, choose between:

• Singleplex and multiplex PCR (page 10)
  
  and

• 1-step and 2-step RT-PCR (page 11)

**Singleplex and Multiplex PCR**

You can perform a PCR reaction using either:

• **Singleplex PCR** – In singleplex PCR a single primer and probe set is present in the reaction tube or well. Only one target or endogenous control can be amplified per reaction.

  Or

• **Multiplex PCR** – In multiplex PCR, two or more primer and probe sets are present in the reaction tube or well. Each set amplifies a specific target or endogenous control. Typically, a probe labeled with FAM™ dye detects the target and a probe labeled with VIC® dye detects the endogenous control.

**IMPORTANT!** SYBR® Green reagents cannot be used for multiplex PCR.
Chapter 1 About Relative Standard Curve Experiments

About the example experiment

1- and 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in separate reactions (2-step). The reagent configuration you use depends on whether you are performing 1- or 2-step RT-PCR:

- **1-step PCR**– In 1-step RT-PCR, RT and PCR take place in one buffer system. Using one buffer system provides the convenience of a single-tube preparation for RT and PCR amplification. However, you cannot use Fast PCR Master Mix or the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

- **2-step PCR**– 2-step RT-PCR is performed in two separate reactions: First, total RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful for detecting multiple transcripts from a single cDNA template or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be used to prevent carryover contamination.

About the example experiment

To illustrate how to perform a Relative Standard Curve, this guide leads you through the process of designing and performing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with the QuantStudio™ 12K Flex System.

The objective of the Relative Standard Curve example experiment is to compare the expression of the HPRT transcriptional factor (an oncoprotein that activates the transcription of growth-associated genes) in Human cDNA tissues.

In the Relative Standard Curve example experiment:

- The samples are 1, 10, 100, 1000, 10000, Heart, and Kidney.
- The target is HPRT.
- The endogenous control is FAS.
- The reference sample is Kidney.
- One standard curve is set up for HPRT. The standard used for the standard dilution series is a Human cDNA sample of known total concentration.
- One standard curve is set up for FAS (endogenous control). The standard used for the standard dilution series is a Human Male Raji cDNA sample of known total concentration.
- Reactions are set up for **2-step RT-PCR**. The Invitrogen VILO™ Kit is used for reverse transcription; the TaqMan® Gene Expression Master Mix (2X) is used for PCR.
- Select primer and probe sets from the Life Technologies TaqMan® Gene Expression Assays product line:
  - For the target assay (HPRT), select assay ID Hs99999909_m1.
  - For the endogenous control assay (FAS), select assay ID Hs00907759_m1.
Chapter 1 About Relative Standard Curve Experiments

About the example experiment
Design the Experiment

This chapter explains how to design the example experiment from the Experiment Setup menu.

This chapter covers:

- Define the experiment properties .................................................. 13
- Define targets, samples, and biological replicates .......................... 14
- Assign targets, samples, and biological groups ............................... 15
- Set up the run method ................................................................. 17
- Tips for designing your own experiment .................................... 18
- For more information ................................................................. 19

Note: To automatically export the analyzed data to a specified location, select the Auto Export task from the Export screen, before running the experiment. For more information on Auto Export, refer to Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

Define the experiment properties

Click Experiment Setup > Experiment Properties to create a new experiment in the QuantStudio™ 12K Flex Software. Enter:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Name</td>
<td>96-Well Relative Std Curve Example</td>
</tr>
<tr>
<td>Barcode</td>
<td>Leave field empty</td>
</tr>
<tr>
<td>User Name</td>
<td>Example User</td>
</tr>
<tr>
<td>Comments</td>
<td>Relative Standard Curve example</td>
</tr>
<tr>
<td>Block</td>
<td>96-Well (0.2 mL)</td>
</tr>
<tr>
<td>Experiment Type</td>
<td>Relative Standard Curve</td>
</tr>
<tr>
<td>Reagents</td>
<td>TaqMan® Reagents</td>
</tr>
<tr>
<td>Ramp speed</td>
<td>Standard</td>
</tr>
</tbody>
</table>

Save the experiment.
Chapter 2 Design the Experiment
Define targets, samples, and biological replicates

Your Experiment Properties screen should look like this:

Define targets, samples, and biological replicates

Click Define to access the Define screen. Enter:

1. Targets

<table>
<thead>
<tr>
<th>Target name</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAS</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>HPRT</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
</tbody>
</table>

2. Samples

<table>
<thead>
<tr>
<th>Sample name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td></td>
</tr>
<tr>
<td>10000</td>
<td></td>
</tr>
<tr>
<td>Heart</td>
<td></td>
</tr>
<tr>
<td>Kidney</td>
<td></td>
</tr>
</tbody>
</table>

3. Dye to be used as a Passive Reference
ROX

4. Analysis Settings
Chapter 2  Design the Experiment
Assign targets, samples, and biological groups

Assign targets, samples, and biological groups

Click Assign to access the Assign screen.

**Note:** To automatically set up and assign standards, click [Define and Set Up Standards] to open the Define and Set Up Standards dialog box.

To assign the targets and samples:

1. Set up the standards.
2. For the first standard for the FAS target:
   b. Check check box next to FAS in the Targets list.
   c. Select S in the Task drop-down menu.
   d. Enter 10,000 in the Quantity column.
   e. Repeat steps a through c for each of the standards for the FAS target, selecting the wells listed in the table below, and entering the corresponding quantity.

<table>
<thead>
<tr>
<th>Field</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Sample</td>
<td>Kidney</td>
</tr>
<tr>
<td>Endogenous Control</td>
<td>FAS</td>
</tr>
</tbody>
</table>

**Note:** This example experiment does not define biological replicate groups. Leave Biological Replicate Groups blank.
3. Repeat step 2 for each standard for the HPRT target.

<table>
<thead>
<tr>
<th>Target name</th>
<th>Well number</th>
<th>Task</th>
<th>Quantity</th>
<th>Sample name</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAS</td>
<td>A12</td>
<td>Negative</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>B4 - B6</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Kidney</td>
</tr>
<tr>
<td></td>
<td>B7 - B9</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>A1 - A3</td>
<td>Standard</td>
<td>10,000</td>
<td>10,000</td>
</tr>
<tr>
<td></td>
<td>A4 - A6</td>
<td>Standard</td>
<td>1,000</td>
<td>1,000</td>
</tr>
<tr>
<td></td>
<td>A7 - A9</td>
<td>Standard</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>A10 - A12</td>
<td>Standard</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>B1 - B3</td>
<td>Standard</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>HPRT</td>
<td>D12</td>
<td>Negative</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>D4 - D6</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Kidney</td>
</tr>
<tr>
<td></td>
<td>D7 - D9</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>C1 - C3</td>
<td>Standard</td>
<td>10,000</td>
<td>10,000</td>
</tr>
<tr>
<td></td>
<td>C4 - C6</td>
<td>Standard</td>
<td>1,000</td>
<td>1,000</td>
</tr>
<tr>
<td></td>
<td>C7 - C9</td>
<td>Standard</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>C10 - C12</td>
<td>Standard</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>D1 - D3</td>
<td>Standard</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>
Your Assign screen should look like this:

**Set up the run method**

Click *Run Method* to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- **Reaction Volume Per Well**: 20 µL
- **Thermal Profile**

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>50°C</td>
<td>2 minutes</td>
</tr>
<tr>
<td></td>
<td>Step 2</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>10 minutes</td>
</tr>
<tr>
<td>PCR Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>15 seconds</td>
</tr>
<tr>
<td>Number of Cycles: 40</td>
<td>Step 2</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>1 minute</td>
</tr>
</tbody>
</table>

Enable AutoDelta: Unchecked (default)
Starting Cycle: Disabled when Enable AutoDelta is unchecked
Your Run Method screen should look like this:

![Run Method Screen](image)

## Tips for designing your own experiment

Life Technologies recommends that you:

- Set up a standard curve for each target assay in the reaction plate.
- Identify each target assay with a unique name and color. You can enter up to 100 characters in the Target Name field.
- Identify each sample using a unique name and color. You can enter up to 100 characters in the Sample Name field.
- Select an endogenous control for each sample. The endogenous control is a target that is present in all samples under investigation. It should be expressed equally in all sample types, regardless of treatment or tissue origin (examples of endogenous controls are β-actin, GAPDH, and 18S ribosomal RNA [18S rRNA]). The endogenous control is used to normalize the PCR results; the endogenous control corrects for variable sample mass, nucleic acid extraction efficiency, reverse transcription efficiency, and pipette calibration errors.
  
  **Note:** Each sample type (for example, each tissue in a study comparing multiple tissues) requires an endogenous control.

- Enter at least five dilution points for each standard curve in the reaction plate.
- Enter at least three replicates (identical reactions) for each point in the standard curve and for each sample reaction.
- Enter at least three negative control reactions for each target assay.
• Carefully consider the appropriate range of standard quantities for your assay because the range of standard quantities affects the amplification efficiency calculations:
  – For more accurate measurements of amplification efficiency, use a broad range of standard quantities, spanning between 5 and 6 logs. If you do so, use a PCR product or a highly concentrated template, such as a cDNA clone.
  – If you have a limited amount of cDNA template and/or if the target is a low-copy number transcript, or known to fall within a given range, a narrow range of standard quantities may be necessary.
• Minimally run a five-point curve of 1:10 dilutions to minimize the effects of small pipetting errors.
• Select a reference sample from your previously defined samples. Amplification results from the samples and from the reference sample are compared to determine relative expression.
• Select an endogenous control from your previously defined target assays. Amplification results from the endogenous control are used to normalize the amplification results from the target for differences in the amount of template added to each reaction.

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumables</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
<tr>
<td></td>
<td>Appendix A in Booklet 7, <em>QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments - Appendixes</em></td>
<td></td>
</tr>
<tr>
<td>Amplification efficiency</td>
<td><em>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</em></td>
<td>127AP05-03</td>
</tr>
<tr>
<td>Using alternative setup</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
</tbody>
</table>
Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Relative Standard Curve example experiment.

This chapter covers:

- Assemble required materials .......................................................... 21
- Prepare the template ................................................................. 21
- Prepare the sample dilutions ..................................................... 22
- Prepare the standard dilution series for FAS and HPRT assays .............. 22
- Prepare the reaction mix (“cocktail mix”) ....................................... 23
- Prepare the reaction plate .......................................................... 24
- Tips for preparing reactions for your own experiments ................... 26
- For more information .............................................................. 27

Assemble required materials

- Items listed in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.
- Samples - Total RNA isolated from kidney, heart, liver, and brain tissues.
- Example experiment reaction mix components:
  - TaqMan® Gene Expression Master Mix (2X)
  - FAS Assay Mix (20X)
  - HPRT Assay Mix (20X)

Prepare the template

Prepare the template for the PCR reactions (both samples and standards) using one of the Invitrogen VILO™ kits, SuperScript® VILO™ cDNA Synthesis Kit (PN 4453650).

For the Relative Standard Curve example experiment, the template for the PCR reactions is cDNA reverse-transcribed from total RNA samples using the Invitrogen VILO™ kits.

Example experiment settings

To prepare the template

Use the Invitrogen VILO™ kits to reverse-transcribe cDNA from the total RNA samples. Follow the procedures in the Invitrogen VILO Kits Protocol (PN 10000284) to:

1. Isolate total RNA from cells using an Ambion® sample preparation kit appropriate to the tissue or cell type.
2. Quantify and perform quality control on the RNA.
3. Convert the RNA to cDNA via reverse transcription.

Prepare the sample dilutions

For the Relative Standard Curve example experiment, no more than 10% of your reaction should consist of the undiluted cDNA.

1. Label a separate microcentrifuge tube for each diluted sample:
   - Kidney
   - Heart

2. Add the required volume of water (diluent) to each empty tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample_name</th>
<th>Diluent volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Kidney</td>
<td>76</td>
</tr>
<tr>
<td>2</td>
<td>Heart</td>
<td>76</td>
</tr>
</tbody>
</table>

3. Add the required volume of sample stock (100 ng/µL) to each empty tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample_name</th>
<th>Diluent volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Kidney</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>Heart</td>
<td>4</td>
</tr>
</tbody>
</table>

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.
5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the standard dilution series for FAS and HPRT assays

The same standard materials are used to prepare the exact same dilutions for both the target genes. The prepared standards are then used to generate the two standard curves.

- The stock concentration for cDNA is 100 ng/µL.
- The volumes calculated for both the FAS and HPRT assays are:

<table>
<thead>
<tr>
<th>Standard name (labeled tube)</th>
<th>Dilution point</th>
<th>Source</th>
<th>Source volume (µL)</th>
<th>Diluent volume (µL)</th>
<th>Total volume (µL)</th>
<th>Standard concentration (ng/µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Std. 1</td>
<td>1</td>
<td>Stock</td>
<td>20</td>
<td>20</td>
<td>40</td>
<td>100</td>
</tr>
<tr>
<td>Std. 2</td>
<td>2</td>
<td>Dilution 1</td>
<td>20</td>
<td>20</td>
<td>40</td>
<td>50</td>
</tr>
<tr>
<td>Std. 3</td>
<td>3</td>
<td>Dilution</td>
<td>20</td>
<td>20</td>
<td>40</td>
<td>25</td>
</tr>
<tr>
<td>Std. 4</td>
<td>4</td>
<td>Dilution 3</td>
<td>20</td>
<td>20</td>
<td>40</td>
<td>12.5</td>
</tr>
</tbody>
</table>
1. Label ten separate microcentrifuge tubes for each diluted standard:
   - FAS (FAS Std. 1 - FAS Std. 5)
   - HPRT (HPRT Std. 1 - HPRT Std. 5)

2. Prepare five standard dilutions each for FAS and HPRT:
   
   **Note:** For dilution 1, first vortex the stock for 3 to 5 seconds, then centrifuge both the Std. 1 tubes briefly before pipetting 10 µL stock into each Std. 1 tube.

3. For each subsequent dilution, add source to the standard:
   
   a. Use a new pipette tip to add 10 µL of source to the FAS and HPRT tubes containing the standard.
   
   b. Vortex the tubes for 3 to 5 seconds, then centrifuge the tubes briefly.

4. Place the standards on ice until you prepare the reaction plate.

### Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:
   - FAS Reaction Mix
   - HPRT Reaction Mix

2. For the FAS assay, add the required volumes of each component to the FAS Reaction Mix tube:
   
   **Note:** Extra volume is already factored in for pipetting error

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume (µL) for 1 reaction</th>
<th>Volume (µL) for 30 reactions</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® Gene Expression Master Mix [2X]</td>
<td>10</td>
<td>300</td>
</tr>
<tr>
<td>FAS Assay Mix [20X]</td>
<td>1</td>
<td>30</td>
</tr>
<tr>
<td>Water</td>
<td>8</td>
<td>240</td>
</tr>
<tr>
<td>Total Reaction Mix Volume</td>
<td>19</td>
<td>570</td>
</tr>
</tbody>
</table>

3. For the HPRT assay, add the required volumes of each component to the HPRT Reaction Mix tube:

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume (µL) for 1 reaction</th>
<th>Volume (µL) for 30 reactions</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® Gene Expression Master Mix [2X]</td>
<td>10</td>
<td>300</td>
</tr>
</tbody>
</table>
Chapter 3  Prepare the Reactions

Prepare the reaction plate

Prepare the reaction plate

Example experiment reaction plate components

The reaction plate for the Relative Standard Curve example experiment contains:

- A MicroAmp® Optical 96-Well Reaction Plate
- Reaction volume: 20 µL/well
- 12 Unknown wells
- 30 Standard wells
- 2 Negative Control wells
- 52 Empty wells

The plate layout for the example experiment looks like this:

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume (µL) for 1 reaction</th>
<th>Volume (µL) for 30 reactions</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPRT Assay Mix [20X]</td>
<td>1</td>
<td>30</td>
</tr>
<tr>
<td>Water</td>
<td>8</td>
<td>240</td>
</tr>
<tr>
<td>Total Reaction Mix Volume</td>
<td>19</td>
<td>570</td>
</tr>
</tbody>
</table>

4. Mix the reaction in each tube by gently pipetting up and down, then cap each tube.

5. Centrifuge the tubes briefly to remove air bubbles.

6. Place the reaction mixes on ice until you prepare the reaction plate.

Note: Do not add the sample or standard at this time.
1. For each target, prepare the negative control reactions:
   a. To an appropriately sized tube, add the volumes of reaction mix and water listed below.
   
<table>
<thead>
<tr>
<th>Tube</th>
<th>Reaction mix</th>
<th>Reaction mix volume (µL)</th>
<th>Water volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FAS Reaction Mix</td>
<td>19</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>HPRT Reaction Mix</td>
<td>19</td>
<td>1</td>
</tr>
</tbody>
</table>

   b. Mix the reaction by gently pipetting up and down, then cap the tube.
   c. Centrifuge the tube briefly to remove air bubbles.
   d. Add 20 µL of the negative control reaction to the appropriate wells in the reaction plate.

2. For each replicate group, prepare the standard reactions:
   a. To appropriately sized tubes, add the volumes of reaction mix and standard listed below.

<table>
<thead>
<tr>
<th>Tube</th>
<th>Standard reaction</th>
<th>Reaction mix</th>
<th>Reaction mix volume (µL)</th>
<th>Standard</th>
<th>Standard volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FAS Std. 1</td>
<td>FAS Reaction Mix</td>
<td>76</td>
<td>FAS Std. 1</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>FAS Std. 2</td>
<td>FAS Reaction Mix</td>
<td>76</td>
<td>FAS Std. 2</td>
<td>4</td>
</tr>
<tr>
<td>3</td>
<td>FAS Std. 3</td>
<td>FAS Reaction Mix</td>
<td>76</td>
<td>FAS Std. 3</td>
<td>4</td>
</tr>
<tr>
<td>4</td>
<td>FAS Std. 4</td>
<td>FAS Reaction Mix</td>
<td>76</td>
<td>FAS Std. 4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>FAS Std. 5</td>
<td>FAS Reaction Mix</td>
<td>76</td>
<td>FAS Std. 5</td>
<td>4</td>
</tr>
<tr>
<td>6</td>
<td>HPRT Std. 1</td>
<td>HPRT Reaction Mix</td>
<td>76</td>
<td>HPRT Std. 1</td>
<td>4</td>
</tr>
<tr>
<td>7</td>
<td>HPRT Std. 2</td>
<td>HPRT Reaction Mix</td>
<td>76</td>
<td>HPRT Std. 2</td>
<td>4</td>
</tr>
<tr>
<td>8</td>
<td>HPRT Std. 3</td>
<td>HPRT Reaction Mix</td>
<td>76</td>
<td>HPRT Std. 3</td>
<td>4</td>
</tr>
<tr>
<td>9</td>
<td>HPRT Std. 4</td>
<td>HPRT Reaction Mix</td>
<td>76</td>
<td>HPRT Std. 4</td>
<td>4</td>
</tr>
<tr>
<td>10</td>
<td>HPRT Std. 5</td>
<td>HPRT Reaction Mix</td>
<td>76</td>
<td>HPRT Std. 5</td>
<td>4</td>
</tr>
</tbody>
</table>

   b. Mix the reactions by gently pipetting up and down, then cap the tubes.
   c. Centrifuge the tubes briefly to remove air bubbles.
   d. Add 20 µL of the standard reaction to the appropriate wells in the reaction plate.
3. For each replicate group, prepare the reactions for the unknowns:
   a. To appropriately sized tubes, add the volumes of reaction mix and sample listed below:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Unknown reaction</th>
<th>Reaction mix</th>
<th>Reaction mix volume (µL)</th>
<th>Sample</th>
<th>Sample volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FAS Kidney</td>
<td>FAS Reaction Mix</td>
<td>76</td>
<td>Kidney</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>FAS Heart</td>
<td>FAS Reaction Mix</td>
<td>76</td>
<td>Heart</td>
<td>4</td>
</tr>
<tr>
<td>3</td>
<td>HPRT Kidney</td>
<td>HPRT Reaction Mix</td>
<td>76</td>
<td>Kidney</td>
<td>4</td>
</tr>
<tr>
<td>4</td>
<td>HPRT Heart</td>
<td>HPRT Reaction Mix</td>
<td>76</td>
<td>Heart</td>
<td>4</td>
</tr>
</tbody>
</table>

   b. Mix the reactions by gently pipetting up and down, then cap the tubes.
   c. Centrifuge the tubes briefly to remove air bubbles.
   d. Add 20 µL of the unknown (sample) reaction to the appropriate wells in the reaction plate.

4. Seal the reaction plate with optical adhesive film.
5. Centrifuge the reaction plate briefly to remove air bubbles.
6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the reaction plate again at a higher speed and for a longer period of time.
7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

**Tips for preparing reactions for your own experiments**

**Tips for preparing templates**
When you prepare your own Relative Standard Curve experiment, Life Technologies recommends the following templates:

- **Complementary DNA (cDNA)** – cDNA reverse-transcribed from total RNA samples.
- **Genomic DNA (gDNA)** – Purified gDNA already extracted from tissue or sample

**Tips for preparing sample dilutions**
When you prepare your own Relative Standard Curve experiment, for optimal performance of TaqMan® Gene Expression Assays or Custom TaqMan® Gene Expression Assays, use 10 to 100 ng of cDNA template per 10µL reaction.

**Tips for preparing the reaction mix**
If your experiment includes more than one target assay, prepare the reaction mix for each target assay separately.
### Tips for preparing the reaction plate

When you prepare your own Relative Standard Curve experiment, make sure the arrangement of the PCR reactions matches the plate layout displayed in the QuantStudio™ 12K Flex Software.

### For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning the reaction plate components</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
<tr>
<td>Sealing the reaction plate</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
</tbody>
</table>
Chapter 3  Prepare the Reactions
For more information
Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K Flex Instrument.

This chapter covers:

- Start the run .......................................................... 29
- Monitor the run ......................................................... 29

IMPORTANT! Run the experiment at the same ambient temperature at which you calibrated the instrument. Extreme variations in ambient temperature can affect the heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 12K Flex Instrument is in operation.

Start the run

1. Open the Relative Standard Curve example file that you created using instructions in Chapter 2.
2. Load the reaction plate into the instrument.
3. Start the run.

Monitor the run

Monitor the example experiment run:

- From the QuantStudio™ 12K Flex Software using the Run screen, while the experiment is in progress.
- From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor an experiment started from another computer or from the QuantStudio™ 12K Flex Instrument touchscreen).
- From the QuantStudio™ 12K Flex Instrument touchscreen.

From the Instrument Console of the QuantStudio™ 12K Flex Software

1. In the Instrument Console screen, select the instrument icon.
2. Click Manage Instrument or double-click on the instrument icon.
3. In the Manage Instrument screen, click Monitor Running Experiment to access the Run screen.
Chapter 4 Run the Experiment

Monitor the run

View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all the three plots available from the QuantStudio™ 12K Flex Software for potential problems.

To view data in the Amplification Plot screen, click Amplification Plot from the Run Experiment Menu, and select the Plate Layout tab, then select the wells that you want to view.

The figure below shows the Amplification Plot screen as it appears at the end of the example experiment.

View the Temperature Plot

To view data in the Temperature Plot screen, click Temperature Plot from the Run Experiment Menu.

The figure below shows the Temperature Plot screen as it appears during the example experiment.
Note: The Sample temperature displayed in the Current Temperatures group is an estimated value.

View the Run Method

To view data in the Run Method screen, click **Run Method** from the Run Experiment Menu.

The figure below shows the Run Method screen as it appears in the example experiment.

![Run Method Screen](image)

View run data

To view the run data, click **View Run Data** from the Run Experiment Menu.

Your View Run Data screen should look like this:

![View Run Data Screen](image)
From the QuantStudio™ 12K Flex Instrument touchscreen

You can also view the progress of the run from the touchscreen of the QuantStudio™ 12K Flex Instrument.

The Run Method screen on the QuantStudio™ 12K Flex Instrument touchscreen looks like this:

**Experiment view**

![Experiment view screenshot]

**Note:** The above screenshot is for visual representation only. Actual results will vary with the experiment.

**Time view**

![Time view screenshot]
Plot view

December 08 2011 - 12:07AM
Heated cover reached target temperature.
In Section 5.1 of this chapter you review the analyzed data using several of the analysis screens and publish the data. Section 5.2 of this chapter walks you through the process of modifying experiment parameters to troubleshoot problems with experiment results before rerunning an experiment.

This chapter covers:

**Section 5.1  Review Results ................................. 37**
- Analyze the example experiment .................................. 37
- View the Standard Curve Plot ..................................... 37
- Assess amplification results using the Amplification Plot .......... 39
- Assess the gene expression profile using the Gene Expression Plot ...... 46
- Identify well problems using the Well Table .......................... 48
- Confirm accurate dye signal using the Multicomponent Plot ........... 50
- Determine signal accuracy using the Raw Data Plot .................. 51
- View the endogenous control profile using the QC Plot ................ 53
- Review the QC flags in the QC Summary .............................. 54
- For more information ................................................. 55

**Section 5.2  Adjust parameters for re-analysis of your own experiments ........ 57**
- Adjust analysis settings ............................................. 57
- Improve C_T precision by omitting wells ............................ 61
- For more information ............................................... 62
Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.
2. Click Analyze. The software analyzes the data using the default analysis settings. You can also access the experiment to analyze from the Home screen.

View the Standard Curve Plot

The Standard Curve Plot screen displays the standard curve for samples designated as standards. The QuantStudio™ 12K Flex Software calculates the quantity of an unknown target from the standard curve.

Example experiment standard curve values

In the standard curve example experiment, you review the Standard Curve Plot screen for the following regression coefficient values:

- Slope/amplification efficiency
- $R^2$ value (correlation coefficient)
- $C_T$ values

To view and assess the Standard Curve plot

1. From the Experiment Menu pane, select Analysis > Standard Curve.
   
   **Note:** If no data are displayed, click Analyze.

2. Display all 96 wells in the Standard Curve Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.

3. Enter the Plot Settings:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>All</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Default</td>
</tr>
<tr>
<td>![Legend](This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.)</td>
<td>Check (default)</td>
</tr>
</tbody>
</table>

4. View the values displayed below the standard curve. In the example experiment, the values for each target fall within the acceptable ranges:

<table>
<thead>
<tr>
<th>Target</th>
<th>Slope</th>
<th>$R^2$ Value</th>
<th>Amplification efficiency (Eff%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAS</td>
<td>−3.38</td>
<td>0.998</td>
<td>97.612</td>
</tr>
<tr>
<td>HPRT</td>
<td>−3.652</td>
<td>0.983</td>
<td>87.858</td>
</tr>
</tbody>
</table>
5. Check that all samples are within the standard curve. In the example experiment, all samples (blue dots) are within the standard curve (red dots).

6. Check the $C_T$ values:

7. Click the **Well Table** tab.

8. From the Group By drop-down menu, select **Replicate**.

9. Look at the values in the $C_T$ column. In the example experiment, the $C_T$ values fall within the expected range (>8 and <35).
Tips for analyzing your own experiments

When you analyze your own Relative Standard Curve experiment, look for:

- **Slope/amplification efficiency values** – The amplification efficiency is calculated using the slope of the regression line in the standard curve. A slope close to \(-3.3\) indicates optimal, 100% PCR amplification efficiency. Factors that affect amplification efficiency:
  - Range of standard quantities – For more accurate and precise efficiency measurements, use a broad range of standard quantities, 5 to 6 logs (10^5 to 10^6 fold).
  - Number of standard replicates – For more accurate efficiency measurements, include replicates to decrease the effects of pipetting inaccuracies.
  - PCR inhibitors – PCR inhibitors in the reaction can alter amplification efficiency.

- **R^2 values (correlation coefficient)** – The R^2 value is a measure of the closeness of fit between the regression line and the individual C_T data points of the standard reactions. A value of 1.00 indicates a perfect fit between the regression line and the data points. An R^2 value >0.99 is desirable.

- **C_T values** – The threshold cycle (C_T) is the PCR cycle number at which the fluorescence level meets the threshold.
  - A C_T value >8 and <35 is desirable.
  - A C_T value <8 indicates that there is too much template in the reaction.
  - A C_T value >35 indicates a low amount of target in the reaction; for C_T values >35, expect a higher standard deviation.

If your experiment does not meet the guidelines above, troubleshoot as follows:

- Omit wells (see “Improve C_T precision by omitting wells” on page 61).
- Rerun the experiment.

Assess amplification results using the Amplification Plot

Amplification plots available for viewing

The Amplification Plot screen displays amplification of all samples in the selected wells. There are three plots available:

- **ΔRn vs Cycle** – ΔRn is the magnitude of normalized fluorescence signal generated by the reporter at each cycle during the PCR amplification. This plot displays ΔRn as a function of cycle number. Use this plot to identify and examine irregular amplification and to view threshold and baseline values for the run.
- **Rn vs Cycle** – Rn is the fluorescence signal from the reporter dye normalized to the fluorescence signal from the passive reference. This plot displays Rn as a function of cycle number. Use this plot to identify and examine irregular amplification.
- **C_T vs Well** – C_T is the PCR cycle number at which the fluorescence meets the threshold in the amplification plot. This plot displays C_T as a function of well position. Use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.
Purpose

The purpose of viewing the amplification plot for the example experiment is to identify:

- Correct baseline and threshold values
- Outliers

View the Amplification Plot

1. From the Experiment Menu pane, select Analysis ▶ Amplification Plot.
   * Note: If no data are displayed, click Analyze.

2. Display the FAS wells in the Amplification Plot screen:
   a. Click the Plate Layout tab.
   b. From the Select Wells drop-down menu, select Target, then FAS.
      The Plate Layout screen should look like this:

3. In the Amplification Plot screen, enter:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>ΔRn vs Cycle (default)</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Well (default)</td>
</tr>
</tbody>
</table>

   (This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.)

4. View the baseline values:
   a. From the Graph Type drop-down menu, select Linear.
   b. Select the Baseline check box to show the start cycle and end cycle.
c. Verify that the baseline is set correctly: The end cycle should be set a few cycles before the cycle number where significant fluorescent signal is detected. In the example experiment, the baseline is set correctly.

5. View the threshold values:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Type</td>
<td>Log</td>
</tr>
<tr>
<td>Target</td>
<td>FAS</td>
</tr>
</tbody>
</table>

a. Select the **Threshold** check box to show the threshold.
b. Verify that the threshold is set correctly. In the example experiment, the threshold is in the exponential phase.

6. Locate outliers:
   a. From the Plot Type drop-down menu, select C_T vs Well.
   b. Look for outliers from the amplification plot. In the example experiment, there are no outliers for FAS.

7. Repeat steps 2 through 6 for the HPRT wells.
**Tips for analyzing your own experiments**

When you analyze your own Relative Standard Curve experiment, look for:

- **Outliers**
- **A typical amplification plot** – The QuantStudio™ 12K Flex Software automatically calculates baseline and threshold values based on the assumption that the data exhibit a *typical* amplification plot. A typical amplification plot has four distinct sections:
  - Plateau phase
  - Linear phase
  - Exponential (geometric phase)
  - Baseline

A typical amplification plot should look like this:

![Amplification Plot](image)

**IMPORTANT!** Experimental error (such as contamination or pipetting errors) can produce atypical amplification curves that can result in incorrect baseline and threshold value calculations by the QuantStudio™ 12K Flex Software. Therefore, Life Technologies recommends that you examine the Amplification Plot screen and review the assigned baseline and threshold values for each well after analysis completes.
Chapter 5  Review Results and Adjust Experiment Parameters

Assess amplification results using the Amplification Plot

**Note:** If you use the Relative Threshold algorithm to analyze an experiment that includes amplification, select to view the analysis results using the ∆Rn vs Cycle, Rn vs Cycle, or C_{RT} vs Well plot type and Linear or Log graph type. Also select the Show Crt check box to view the derived fractional cycle on the amplification plot.

- **Correct threshold values.**

  **Threshold Set Correctly**
  The threshold is set in the exponential phase of the amplification curve. Threshold settings above or below the optimum increase the standard deviation of the replicate groups.

  **Threshold Set Too Low**
  The threshold is set below the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar up into the exponential phase of the curve.
Section 5.1 Review Results

Assess amplification results using the Amplification Plot

### Threshold Set Too High
The threshold is set above the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar down into the exponential phase of the curve.

<table>
<thead>
<tr>
<th>Threshold Set Too High</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Graph" /></td>
</tr>
<tr>
<td><img src="image2.png" alt="Graph" /></td>
</tr>
</tbody>
</table>

### Correct baseline values

- **Baseline Set Correctly**
The amplification curve begins after the maximum baseline.

- **Baseline Set Too Low**
The amplification curve begins too far to the right of the maximum baseline. Increase the End Cycle value.

- **Baseline Set Too High**
The amplification curve begins before the maximum baseline. Decrease the End Cycle value.

<table>
<thead>
<tr>
<th>Baseline Set Correctly</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="Graph" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Baseline Set Too Low</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4.png" alt="Graph" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Baseline Set Too High</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Graph" /></td>
</tr>
</tbody>
</table>

If your experiment does not meet the guidelines above, troubleshoot as follows:

- Omit wells (see “Improve C\text{\textsubscript{T}} precision by omitting wells” on page 61).
  
  Or

- Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on page 57).
Assess the gene expression profile using the Gene Expression Plot

The Gene Expression Plot screen displays the results of relative quantification calculations in the gene expression profile. There are two plots available:

- **RQ vs Target** – Groups the relative quantification (RQ) values by target. Each sample is plotted for each target. You can view the plot as the linear, log10, Ln, and log2 graph types. The Gene Expression plot when viewed as a linear graph type looks like this:
Section 5.1 Review Results

Assess the gene expression profile using the Gene Expression Plot

- **RQ vs Sample** – Groups the relative quantification (RQ) values by sample. Each target is plotted for each sample. You can view the plot as the linear, log10, Ln, and log2 graph types. The Gene Expression plot when viewed as a linear graph type looks like this:

![Gene Expression Plot](image)

Example experiment values

Review each target in the Gene Expression Plot screen for the expression level (or fold change) of the target sample relative to the reference sample.

**View the Gene Expression Plot**

1. From the Experiment Menu pane, select **Analysis > Gene Expression**.
   
   *Note:* If no data are displayed, click **Analyze**.

2. In the Gene Expression Plot screen:
   
   a. From the Plot Type drop-down menu, select **RQ vs Sample**.
   
   b. From the Graph Type drop-down menu, select **Log10**.
   
   c. From the Orientation drop-down menu, select **Vertical Bars**.

3. Click **Show a legend for the plot** (default).
   
   *Note:* This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.
In the example experiment, the expression level of HPRT in heart is displayed relative to its expression level in the reference sample (kidney). Since the reference sample is compared to itself, the relative expression level is 1. When the result is displayed in the Log10 graph type, the expression level of the reference sample appears as 0 in the graph (log10 of 1 = 0).

Assessing the gene expression plot in your own experiments

When you analyze your own Relative Standard Curve experiment, look for differences in gene expression (as a fold change) relative to the reference sample.

Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including:
- The sample name, target name, task, and dyes
- The calculated threshold cycle (C_T), normalized fluorescence (Rn), and quantity values
- Flags

Review the Well Table to evaluate the C_T precision of the replicate groups.
View the well table

1. From the Experiment Menu pane, select Analysis > Amplification Plot, then click the Well Table tab.

2. From the Group By drop-down menu, select Replicate.

3. Look at the CT SD column to evaluate the CT precision of the replicate groups. In the example experiment, the CT SD have the expected value of < 0.5.

Note: To show or hide columns in the Well Table, select or deselect respectively the column name from the Show in Table drop-down menu.

Assessing the well table in your own experiments

When you analyze your own Relative Standard Curve experiment, look for standard deviation in the replicate groups (CT SD values). If needed, omit outliers (“Improve CT precision by omitting wells” on page 61).
Chapter 5  Review Results and Adjust Experiment Parameters

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

Purpose

In the Relative Standard Curve example experiment, you review the Multicomponent Plot screen for:

- ROX™ dye (passive reference)
- FAM™ dye (reporter for RNase P)
- Spikes, dips, and/or sudden changes
- Amplification in the negative control wells

View the Multicomponent Plot

1. From the Experiment Menu pane, select Analysis ➔ Multicomponent Plot.
   Note: If no data are displayed, click Analyze.

2. Display the unknown and standard wells one at a time in the Multicomponent Plot screen:
   a. Click the Plate Layout tab.
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.
      Note: If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click Show a legend for the plot (default).
   Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. Check the FAM dye signal. In the example experiment, the FAM dye signal increases throughout the PCR process, indicating normal amplification.
6. Check the ROX dye signal. In the example experiment, the ROX dye signal remains constant throughout the PCR process indicating typical data.

7. Select the negative control wells one at time and check for amplification. In the example experiment, there is no amplification in any of the negative control wells.

Tips for confirming dye accuracy in your own experiment

When you analyze your own Relative Standard Curve experiment, look for:

- **Passive reference** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.
- **Reporter dye** – The reporter dye fluorescence level should display a flat region corresponding to the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.
- **Irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.
- **Negative Control wells** – There should not be any amplification in the negative control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter for the selected wells during each cycle of the real-time PCR.

About the example experiment

In the Relative Standard Curve example experiment, you review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data Plot

1. From the Experiment Menu pane, select **Analysis** ➔ **Raw Data Plot**.
   
   **Note:** If no data are displayed, click **Analyze**.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.
3. Click Show a legend for the plot (default). The legend displays the color code for each row of the reaction plate (see the legend in the Raw Data Plot shown below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example experiment, there is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.

The filters used for the example experiment are:

![Raw Data Plot](image)

Tips for determining signal accuracy in your own experiment

When you analyze your own Relative Standard Curve experiment, look for the following in each filter:

- Characteristic signal growth
- No abrupt changes or dips
View the endogenous control profile using the QC Plot

In the Relative Standard Curve experiment, the QC Plot screen displays the Endogenous Control Profile plot for all the targets in the experiment. The QC Plot serves as a tool to help users choose the best endogenous control for that experiment. The endogenous control profile plot is a visual display of the Ct values of the endogenous control across each sample. You can view up to four endogenous controls at a time. The sample is plotted on the X-axis, and the Ct is plotted on the Y-axis. Each candidate control is viewed as a color and shape combination in the plot. Endogenous controls are also known as reference genes.

To view the QC Plot:

1. From the Experiment Menu pane, select Analysis \(\Rightarrow\) QC Plot.
   **Note:** If no data are displayed, click Analyze.

2. In the QC Plot screen, click Target Table to select a target to profile:
   a. In the Candidate Control column, select the check box of the target of the endogenous control profile to plot. In the example experiment, the endogenous control is FAS.
   b. Select a color from the Color drop-down menu.
   c. Select a shape from the Shape drop-down menu.

3. Click the View Replicate Results Table.

4. Select the check box of the samples you want to plot.

5. Click Show a legend for the plot (default).
   **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

The QC Plot in the Relative Standard Curve example experiment looks like this.
This example experiment does not define Biological Groups.

**Review the QC flags in the QC Summary**

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags, including the flag frequency and location for the open experiment.

**View the QC Summary**

1. From the Experiment Menu pane, select **Analysis ▸ QC Summary**.
   - **Note:** If no data are displayed, click **Analyze**.

2. Review the Flags Summary.
   - **Note:** A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment. If the frequency is > 0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.
   
   In the example experiment, there are no flagged wells.

3. In the Flag Details table, click each flag with a frequency > 0 to display detailed information about the flag. In the example experiment, the Frequency column displays 0 for all flags.

4. *(Optional)* For those flags with frequency > 0, click the troubleshooting link to view information on correcting the flag.

The QC Summary screen for the example experiment looks like this:
Possible flags

The flags listed below may be triggered by the experiment data.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pre-processing flag</strong></td>
<td></td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td><strong>Primary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>C&lt;sub&gt;T&lt;/sub&gt; algorithm failed</td>
</tr>
<tr>
<td>AMPSCORE</td>
<td>Amplification in the linear region is below a certain threshold, corresponding to the score set in the analysis settings</td>
</tr>
<tr>
<td><strong>Secondary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>OUTLIERRG</td>
<td>Outlier in replicate group</td>
</tr>
<tr>
<td>AMPNC</td>
<td>Amplification in the negative control</td>
</tr>
<tr>
<td>HIGHSD</td>
<td>High standard deviation in replicate group</td>
</tr>
</tbody>
</table>

**Note:** When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing data</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.</em></td>
<td>4470050</td>
</tr>
</tbody>
</table>
Chapter 5  Review Results and Adjust Experiment Parameters

For more information
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle (C_T), flags, and advanced options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.
2. Click Analysis ➤ Analysis Settings to open the Analysis Settings dialog box.
   In the example experiment, the default analysis settings are used for each tab:
   • C_T Settings
   • Flag Settings
   • Relative Quantification Settings
   • Advanced Settings
   • Standard Curve Settings
   The Analysis Settings dialog box for a Relative Standard Curve experiment looks like this:
3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” below).

   Note: You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

4. Click Apply Analysis Settings to apply the current analysis settings.

   Note: You can go back to the default analysis settings, by clicking Revert to Default Analysis Settings.

Adjust analysis settings

CT Settings

• Data Step Selection
   Use this feature to select one stage/step combination for CT analysis when there is more than one data collection point in the run method.

• Algorithm Settings
   You can select the algorithm that determines the CT values. There are two algorithms: Baseline Threshold (the default) and Relative Threshold.
   The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for quantification.
   The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no dependence on targets, thereby reducing variability. It is not necessary to set either a baseline or a threshold when you use the Relative Threshold algorithm, so any settings for baseline or threshold will not affect the analysis.

• Default CT Settings
   Use the default CT settings feature to calculate CT for the targets that do not have custom settings. To edit the default settings, click Edit Default Settings.

• CT Settings for Target
   When you manually set the threshold and baseline, Life Technologies recommends:

   **Note:** This setting is applicable only to the Baseline Threshold algorithm.

   **Note:** Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Recommendation</th>
</tr>
</thead>
</table>
| Threshold | Enter a value for the threshold so that the threshold is:  
• Above the background.  
• Below the plateau and linear regions of the amplification curve.  
• Within the exponential phase of the amplification curve. |
| Baseline | Select the Start Cycle and End Cycle values so that the baseline ends before significant fluorescent signal is detected. |
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

Flag Settings

Use the Flag Settings tab to:

- Adjust the sensitivity so that more wells or fewer wells are flagged.
- Change the flags that are applied by the QuantStudio™ 12K Flex Software.

To adjust the flag settings

1. In the Use column, select the check boxes for flags to apply during analysis.
2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.
   
   Note: If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.
   
   Note: After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments using the Standard Deviation calculations may change the result of CT SD. For some flags, analysis results calculated before the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.

The Flag Settings tab looks like this:
Relative Quantification Settings

Use the Relative Quantification Settings tab to:

- Change the type of analysis, singleplex or multiplex.
- Change the reference sample and/or endogenous control.
- Reject Outliers with ΔC_T values less than or equal to the entered value.

**Note:** The Outlier Rejection settings apply only to multiplex reactions.

- Select the algorithm to use to determine the relative quantification minimum and maximum values (error bars):
  - **Confidence Level** - Select to calculate the RQ minimum and maximum values based on the selected confidence level. Select the confidence level to use.
  - **Standard Deviations** - Select to calculate the RQ minimum and maximum values based on the selected number of standard deviations. Select the number of standard deviations to use.

Advanced Settings

Use the Advanced Settings tab to change baseline settings well-by-well.

**Note:** The baseline and threshold values do not affect the analysis using the Relative Threshold setting.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.
2. Deselect the **Use C_T Settings Defined for Target** check box.
3. Define the custom baseline settings:
   - For automatic baseline calculations, select the **Automatic Baseline** check box.
   - To define the baseline, deselect the **Automatic Baseline** check box, then enter the baseline start cycle and baseline end cycle.

Standard Curve Settings

Use this tab to review the settings of the current standard curve experiment or to import the standard curve from an external experiment (with the same samples and targets) and apply it to this current experiment.

**Note:** The run method must be the same. Life Technologies recommends using the standard curve from the current experiment.
Section 5.2 Adjust parameters for re-analysis of your own experiments

Improve $C_T$ precision by omitting wells

For the example experiment, the settings from the current experiment have been used.

**Improve $C_T$ precision by omitting wells**

Experimental error may cause some wells to be amplified insufficiently or not at all. These wells typically produce $C_T$ values that differ significantly from the average for the associated replicate wells. If included in the calculations, these outliers can result in erroneous measurements; to ensure $C_T$ precision, omit the outliers from the analysis.

**Note:** In the Relative Standard Curve example experiment, there are no outliers. No wells need to be removed from analysis.

1. From the Experiment Menu pane, select **Analysis** $\rightarrow$ **Amplification Plot**.
   **Note:** If no data are displayed, click **Analyze**.

2. In the Amplification Plot screen, select **$C_T$ vs Well** from the Plot Type drop-down menu.

3. Select the **Well Table** tab, select replicates to omit:

4. In the Well Table:
   a. From the Group By drop-down menu, select **Replicate**.
   b. Look for outliers in the replicate group (make sure they are flagged).
c. Select the **Omit** check box next to outlying well(s), as shown below.

![Plate Layout](image)

5. Click **Analyze** to reanalyze the experiment data with the outlying well(s) removed from the analysis.

**Note:** You can also omit undesirable wells in an experiment from the Plate Layout screen. To omit a well from the Plate Layout screen, right-click the well and select **Omit**.

**For more information**

<table>
<thead>
<tr>
<th>For more information on</th>
<th>Refer to</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification efficiency</td>
<td>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</td>
<td>127AP05-03</td>
</tr>
</tbody>
</table>
Export Analysis Results

1. Open the Relative Standard Curve example experiment file that you analyzed in Chapter 5.

2. In the Experiment Menu, click Export.
   
   **Note:** To export data automatically after analysis, select the Auto Export check box during experiment setup or before running the experiment. Auto export is unchecked for the example experiment.

3. Select QuantStudio™ 12K Flex format.
   
   **Note:** Select 7900 Format if you want to export the Clipped Data.

4. Complete the Export dialog box as shown below:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export/ Select Content</td>
<td>Results</td>
</tr>
<tr>
<td>Export Data To</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>96-Well Relative Std Curve Example_QuantStudio_export</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td>&lt;drive&gt;:\Applied Biosystems\QuantStudio 12K Flex Software\experiments</td>
</tr>
</tbody>
</table>
Chapter 6  Export Analysis Results

Your Export screen should look like this:

Your exported file when opened in Notepad should look like this:
PART II
Running Comparative $C_T$ Experiments
About Comparative C_T Experiments

This chapter covers:

- About Comparative C_T experiments ............................................................. 69
- About the example experiment ................................................................. 71

IMPORTANT! First-time users of the QuantStudio™ 12K Flex System, please read Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments and Booklet 7, QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments - Appendixes of this binder thoroughly. The booklets provide information and general instructions that are applicable to all the experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ 12K Flex Software by pressing F1, clicking in the toolbar, or selecting Help QuantStudio™ 12K Flex Software Help.

About Comparative C_T experiments

The Comparative CT (ΔΔC_T) method is used to determine the relative target quantity in samples. With the comparative C_T method, the QuantStudio™ 12K Flex Software measures amplification of the target and of the endogenous control in samples and in a reference sample. Measurements are normalized using the endogenous control. The software determines the relative quantity of target in each sample by comparing normalized C_T (ΔC_T) in each sample to normalized C_T (ΔC_T) in the reference sample.

Comparative C_T experiments are commonly used to:

- Compare expression levels of a gene in different tissues.
- Compare expression levels of a gene in a treated sample and an untreated sample.
- Compare expression levels of wild-type alleles and mutated alleles.
- Analyze the gene expression changes over time under specific treatment conditions.

Assemble required components

- **Sample** – The tissue group that you are testing for a target gene.
- **Reference sample (also called a calibrator)** – The sample used as the basis for relative quantification results. For example, in a study of drug effects on gene expression, an untreated control is an appropriate reference sample.
- **Endogenous control** – A gene that is used to normalize template input differences, and sample-to-sample or run-to-run variation.
Chapter 7: About Comparative CT Experiments

7

• **Replicates** – The total number of identical reactions containing identical components and identical volumes.

• **Negative Controls** – Wells that contain water or buffer instead of sample template. No amplification of the target should occur in negative control wells.

**PCR options**

When performing real-time PCR, choose between:

• Singleplex and multiplex PCR (below)

and

• 1-step and 2-step RT-PCR (page 70)

**Singleplex and Multiplex PCR**

You can perform a PCR reaction using either:

• **Singleplex PCR** – In singleplex PCR a single primer and probe set is present in the reaction tube or well. Only one target or endogenous control can be amplified per reaction.

Or

• **Multiplex PCR** – In multiplex PCR, two or more primer and probe sets are present in the reaction tube or well. Each set amplifies a specific target or endogenous control. Typically, a probe labeled with FAM™ dye detects the target and a probe labeled with VIC® dye detects the endogenous control.

**IMPORTANT!** SYBR® Green reagents cannot be used for multiplex PCR.

**1- and 2-Step RT-PCR**

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in separate reactions (2-step). The reagent configuration you use depends on whether you are performing 1- or 2-step RT-PCR:

• **1-step RT-PCR** – In 1-step RT-PCR, RT and PCR take place in one buffer system. Using one buffer system provides the convenience of a single-tube preparation for RT and PCR amplification. However, you cannot use Fast PCR Master Mix or the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

• **2-step RT-PCR** – 2-step RT-PCR is performed in two separate reactions: First, total RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful for detecting multiple transcripts from a single cDNA template or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be used to prevent carryover contamination.
About the example experiment

To illustrate how to perform comparative CT experiment, this guide leads you through the process of designing and performing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with the QuantStudio™ 12K Flex System.

The objective of the comparative CT example experiment is to compare the expression of GH1, LPIN1, TGFB1, LIPC, ACTB, and CCKAR in liver, heart, brain, and lung tissues.

- The samples are liver, heart, lung, and brain tissues.
- The targets are GH1, LPIN1, TGFB1, LIPC, ACTB, and CCKAR.
- The reference sample is brain.
- The endogenous control is ACTB.
- The experiment is designed for singleplex PCR, where the targets and endogenous control assays are performed in separate wells.
- Reactions are set up for 2-step RT-PCR. The Invitrogen VILO™ Kit is used for reverse transcription; the TaqMan® Fast Universal PCR Master Mix is used for PCR.
- Primer and probe sets are selected from the Life Technologies TaqMan® Gene Expression Assays product line:
  - GH1 Assay Mix: Hs00236859_m1
  - LPIN1 Assay Mix: Hs00299515_m1
  - LIPC Assay Mix: Hs00165106_m1
  - ACTB Assay Mix: Hs99999903_m1
  - TGFB1 Assay Mix: Hs00998133_m1
  - CCKAR Assay Mix: Hs00167891_m1
Chapter 7 About Comparative C<sub>T</sub> Experiments

About the example experiment
Design the Experiment

This chapter explains how to design the example experiment from the Experiment Setup menu.

This chapter covers:

- Define the experiment properties ................................................................. 73
- Define targets, samples and biological replicates ........................................... 74
- Assign targets, samples and biological groups .............................................. 75
- Set up the run method ..................................................................................... 77
- Tips for designing your own experiment ....................................................... 78
- For more information ....................................................................................... 79

Note: To automatically export the analyzed data to a specified location, select the Auto Export task from the Export screen, before running the experiment. For more information on Auto Export, refer to Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

Define the experiment properties

Click Experiment Setup ➤ Experiment Properties to create a new experiment in the QuantStudio™ 12K Flex Software. Enter:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Name</td>
<td>96-Well Fast Comparative C&lt;sub&gt;T&lt;/sub&gt; Example.edds</td>
</tr>
<tr>
<td>Barcode</td>
<td>Leave field empty</td>
</tr>
<tr>
<td>User Name</td>
<td>Example User</td>
</tr>
<tr>
<td>Comments</td>
<td>Comparative C&lt;sub&gt;T&lt;/sub&gt; example</td>
</tr>
<tr>
<td>Block</td>
<td>96-Well (0.2mL)</td>
</tr>
<tr>
<td>Experiment Type</td>
<td>Comparative C&lt;sub&gt;T&lt;/sub&gt; (ΔΔC&lt;sub&gt;T&lt;/sub&gt;)</td>
</tr>
<tr>
<td>Reagents</td>
<td>TaqMan&lt;sup&gt;®&lt;/sup&gt; Reagents</td>
</tr>
<tr>
<td>Ramp speed</td>
<td>Fast</td>
</tr>
</tbody>
</table>

Save the experiment.
Define targets, samples and biological replicates

Click Define to access the Define screen. Enter:

1. **Targets**

<table>
<thead>
<tr>
<th>Target name</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>GH1</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>LP1N1</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>TGFB1</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>L1PC</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>ACTB</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>CCKAR</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
</tbody>
</table>

2. **Samples**

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brain</td>
<td></td>
</tr>
<tr>
<td>Lung</td>
<td></td>
</tr>
<tr>
<td>Liver</td>
<td></td>
</tr>
<tr>
<td>Heart</td>
<td></td>
</tr>
</tbody>
</table>

3. Dye to be used as a Passive Reference

ROX
4. **Analysis Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Sample</td>
<td>Brain</td>
</tr>
<tr>
<td>Endogenous Control</td>
<td>ACTB</td>
</tr>
</tbody>
</table>

Your Define screen should look like this:

![Define screen example](image)

**Note:** This example experiment does not define biological replicate groups. Leave Biological Replicate Groups blank.

**Assign targets, samples and biological groups**

Click **Assign** to access the Assign screen. Enter the targets and samples:
### Chapter 8 Design the Experiment

Assign targets, samples and biological groups

<table>
<thead>
<tr>
<th>Target name</th>
<th>Well number</th>
<th>Task</th>
<th>Sample name</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>GH1</strong></td>
<td>A1, B1, C1</td>
<td>Unknown</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>A2, B2, C2</td>
<td>Unknown</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>E1, F1, G1</td>
<td>Unknown</td>
<td>Lung</td>
</tr>
<tr>
<td></td>
<td>E2, F2, G2</td>
<td>Unknown</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>D1, D2, H1, H2</td>
<td>Negative</td>
<td>Heart, Brain, Lung, Liver</td>
</tr>
<tr>
<td><strong>LP1N1</strong></td>
<td>A3, B3, C3</td>
<td>Unknown</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>A4, B4, C4</td>
<td>Unknown</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>E3, F3, G3</td>
<td>Unknown</td>
<td>Lung</td>
</tr>
<tr>
<td></td>
<td>E4, F4, G4</td>
<td>Unknown</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>D3, D4, H3, H4</td>
<td>Negative</td>
<td>Heart, Brain, Lung, Liver</td>
</tr>
<tr>
<td><strong>TGFB1</strong></td>
<td>A5, B5, C5</td>
<td>Unknown</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>A6, B6, C6</td>
<td>Unknown</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>E5, F5, G5</td>
<td>Unknown</td>
<td>Lung</td>
</tr>
<tr>
<td></td>
<td>E6, F6, G6</td>
<td>Unknown</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>D5, D6, H5, H6</td>
<td>Negative</td>
<td>Heart, Brain, Lung, Liver</td>
</tr>
<tr>
<td><strong>L1PC</strong></td>
<td>A7, B7, C7</td>
<td>Unknown</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>A8, B8, C8</td>
<td>Unknown</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>E7, F7, G7</td>
<td>Unknown</td>
<td>Lung</td>
</tr>
<tr>
<td></td>
<td>E8, F8, G8</td>
<td>Unknown</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>D7, D8, H7, H8</td>
<td>Negative</td>
<td>Heart, Brain, Lung, Liver</td>
</tr>
<tr>
<td><strong>ACTB</strong></td>
<td>A9, B9, C9</td>
<td>Unknown</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>A10, B10, C10</td>
<td>Unknown</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>E9, F9, G9</td>
<td>Unknown</td>
<td>Lung</td>
</tr>
<tr>
<td></td>
<td>E10, F10, G10</td>
<td>Unknown</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>D9, D10, H9, H10</td>
<td>Negative</td>
<td>Heart, Brain, Lung, Liver</td>
</tr>
<tr>
<td><strong>CCKAR</strong></td>
<td>A11, B11, C11</td>
<td>Unknown</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>A12, B12, C12</td>
<td>Unknown</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>E11, F11, G11</td>
<td>Unknown</td>
<td>Lung</td>
</tr>
<tr>
<td></td>
<td>E12, F12, G12</td>
<td>Unknown</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>D11, D12, H11, H12</td>
<td>Negative</td>
<td>Heart, Brain, Lung, Liver</td>
</tr>
</tbody>
</table>
Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- Reaction Volume Per Well: 20 µl
- Thermal Profile

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold Stage</td>
<td>Step 1</td>
<td>2.05°C/s</td>
<td>95°C</td>
<td>20 seconds</td>
</tr>
<tr>
<td>PCR Stage</td>
<td>Step 1</td>
<td>2.05°C/s</td>
<td>95°C</td>
<td>1 second</td>
</tr>
<tr>
<td>Number of Cycles: 40</td>
<td>Step 2</td>
<td>1.71°C/s</td>
<td>60°C</td>
<td>22 seconds</td>
</tr>
</tbody>
</table>

Enable AutoDelta: Unchecked (default)
Starting Cycle: Disabled when Enable AutoDelta is unchecked
Your Run Method screen should look like this:

---

## Tips for designing your own experiment

Life Technologies recommends that you:

- Identify each target assay with a unique name and color. You can enter up to 100 characters in the Target Name field.
- Identify each sample using a unique name and color. You can enter up to 100 characters in the Sample Name field.
- Select an endogenous control for each sample. The endogenous control is a target that is present in all samples under investigation. It should be expressed equally in all sample types, regardless of treatment or tissue origin (examples of endogenous controls are β-actin, GAPDH, and 18S ribosomal RNA [18S rRNA]). The endogenous control is used to normalize the PCR results; the endogenous control corrects for variable sample mass, nucleic acid extraction efficiency, reverse transcription efficiency, and pipette calibration errors. Note that:
  - Each sample type (for example, each tissue in a study comparing multiple tissues) requires an endogenous control.
  - If samples are spread across multiple plates, each plate must have an endogenous control. Additionally, every plate must include an endogenous control for every sample type on the plate.
• Select an endogenous control from your previously defined target assays. Amplification results from the endogenous control are used to normalize the amplification results from the target for differences in the amount of template added to each reaction.

• Select a reference sample from your previously defined samples. Amplification results from the samples and from the reference sample are compared to determine relative expression.

For more information

<table>
<thead>
<tr>
<th>For more information on</th>
<th>Refer to</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumables</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em> Appendix A in Booklet 7, <em>QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments - Appendixes</em></td>
<td>4470050</td>
</tr>
<tr>
<td>Using the Relative Standard Curve quantification method</td>
<td>Part 1 of this booklet</td>
<td>4470050</td>
</tr>
<tr>
<td>Selecting an endogenous control</td>
<td>Application Note <em>Using TaqMan® Endogenous Control Assays to Select an Endogenous Control for Experimental Studies</em></td>
<td>127AP05-03</td>
</tr>
<tr>
<td>Reference samples (also known as calibrators) and endogenous controls</td>
<td><em>User Bulletin #2: Relative quantification of Gene Expression</em></td>
<td>4303859</td>
</tr>
<tr>
<td>Using alternative setup</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
</tbody>
</table>
Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Comparative $C_T$ ($\Delta\Delta C_T$) example experiment.

This chapter covers:

- Assemble required materials ................................................................. 81
- Prepare the template .............................................................................. 81
- Prepare the sample dilutions ................................................................. 82
- Prepare the reaction mix (“cocktail mix”) ................................................. 82
- Prepare the reaction plate ....................................................................... 83
- Tips for preparing reactions for your own experiments ......................... 84
- For more information ............................................................................ 85

Assemble required materials

- Items listed in Booklet 1, *Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments*.
- Samples - Total RNA isolated from liver, heart, brain, and lung tissues.
- Example experiment reaction mix components:
  - TaqMan® Fast Universal PCR Master Mix (2X.)
  - ACTB Assay Mix (20X)
  - TGFB1 Assay Mix (20X)
  - GH1 Assay Mix (20X)
  - LIPN1 Assay Mix (20X)
  - LIPC Assay Mix (20X)
  - CCKAR Assay Mix (20X)

Prepare the template

Prepare the template for the PCR reactions using the High-Capacity cDNA Reverse Transcription Kit or one of the Invitrogen VILO™ kits to carry out the reverse transcription.

For the Comparative $C_T$ example experiment, the template for the PCR reactions is cDNA reverse-transcribed from total RNA samples using one of the Invitrogen VILO™ kits, SuperScript® VILO™ cDNA Synthesis Kit (PN 4453650).
Chapter 9 Prepare the Reactions

Prepare the template

Use the Invitrogen VILO™ kits to reverse-transcribe cDNA from the total RNA samples. Follow the procedures in the *Invitrogen VILO Kits Protocol* (PN 100002284) to:

1. Prepare the RT master mix.
2. Prepare the cDNA reactions.
3. Perform reverse transcription on a thermal cycler.

Prepare the sample dilutions

For the Comparative Ct example experiment, no more than 10% of your reaction should consist of the undiluted RT product.

1. Label a separate microcentrifuge tube for each diluted sample:
   - Liver
   - Heart
   - Brain
   - Lung

2. Add the required volume of water (diluent) to each empty tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample name</th>
<th>Diluent volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Liver</td>
<td>19</td>
</tr>
<tr>
<td>2</td>
<td>Heart</td>
<td>19</td>
</tr>
<tr>
<td>3</td>
<td>Brain</td>
<td>19</td>
</tr>
<tr>
<td>4</td>
<td>Lung</td>
<td>19</td>
</tr>
</tbody>
</table>

3. Add the required volume of cDNA sample stock (100 ng/µL) to each empty tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample name</th>
<th>Volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Liver</td>
<td>1.0</td>
</tr>
<tr>
<td>2</td>
<td>Heart</td>
<td>1.0</td>
</tr>
<tr>
<td>3</td>
<td>Brain</td>
<td>1.0</td>
</tr>
<tr>
<td>4</td>
<td>Lung</td>
<td>1.0</td>
</tr>
</tbody>
</table>

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:
   - ACTB Reaction Mix
   - TGFB1 Reaction Mix
   - GH1 Reaction Mix
• LPIN1 Reaction Mix
• LIPC Reaction Mix
• CCKAR Reaction Mix

2. For the ACTB assay, add the required volumes of each component to the ACTB Reaction Mix tube:

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume (µL) for 1 reaction</th>
<th>Volume (µL) for 16 reactions (plus 10% excess)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® Fast Universal PCR Master Mix (2X)</td>
<td>10.0</td>
<td>176.0</td>
</tr>
<tr>
<td>ACTB Assay Mix (20X)</td>
<td>1.0</td>
<td>17.6</td>
</tr>
<tr>
<td>Water</td>
<td>8</td>
<td>140.8</td>
</tr>
<tr>
<td>Total Reaction Mix Volume</td>
<td>19.0</td>
<td>158.4</td>
</tr>
</tbody>
</table>

3. Mix the reaction mix in each tube by gently pipetting up and down, then cap each tube.

4. Centrifuge the tubes briefly to remove air bubbles.

5. Place the reaction mixes on ice until you prepare the reaction plate.

6. Repeat steps 2 through 5 for the TGFB1, GH1, LPIN1, LIPC, and CCKAR assays.

Note: Do not add the sample at this time.

Prepare the reaction plate

The reaction plate for the Comparative C<sub>T</sub> example experiment contains:
• A MicroAmp® Optical 96-Well Reaction Plate
• Reaction volume: 20 µL/well
• The reaction plate contains:
  – 72 Unknown wells
  – 24 Negative Control wells
  – 0 Empty wells
Chapter 9  Prepare the Reactions

Tips for preparing reactions for your own experiments

The plate layout experiment looks like this:

To prepare the reaction plate components

1. Add 1 µL of each cDNA to the appropriate wells.
2. Pipette 1 µL of sterile water into the NTC wells.
3. Add 19 µL of the appropriate assay-specific cocktail to the wells.
4. Seal the reaction plate with optical adhesive film.
5. Centrifuge the reaction plate briefly to remove air bubbles.
6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the reaction plate again at a higher speed and for a longer period of time.
7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

Tips for preparing reactions for your own experiments

Tips for preparing templates

When you prepare your own Comparative C<sub>T</sub> experiment, Life Technologies recommends the following templates:

- Complementary DNA (cDNA) – cDNA reverse-transcribed from total RNA samples.
- Genomic DNA (gDNA) – Purified gDNA already extracted from tissue or sample.
**Tips for preparing the reaction mix**

If your experiment includes more than one target assay, prepare the reaction mix for each target assay separately.

**Tips for preparing the reaction plate**

When you prepare your own Comparative C_T experiment, make sure the arrangement of the PCR reactions matches the plate layout displayed in the QuantStudio™ 12K Flex Software.

---

**For more information**

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning the reaction plate components</td>
<td>Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</td>
<td>4470050</td>
</tr>
<tr>
<td>Sealing the reaction plate</td>
<td>Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</td>
<td>4470050</td>
</tr>
</tbody>
</table>
Chapter 9  Prepare the Reactions

For more information
Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K Flex Instrument.

This chapter covers:

- Start the run ................................................................. 87
- Monitor the run ............................................................... 87

**IMPORTANT!** Run the experiment at the same ambient temperature at which you calibrated the instrument. Extreme variations in ambient temperature can affect the heating and cooling of the instrument and influence experimental results.

**IMPORTANT!** Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 12K Flex Instrument is in operation.

### Start the run

1. Open the Comparative $C_T$ example file that you created using instructions in Chapter 8.
2. Load the reaction plate into the instrument.
3. Start the run.

### Monitor the run

Monitor the example experiment run:

- From the QuantStudio™ 12K Flex Software using the Run screen, while the experiment is in progress.
- From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor an experiment started from another computer or from the QuantStudio™ 12K Flex Instrument touchscreen).
- From the QuantStudio™ 12K Flex Instrument touchscreen.

**From the Instrument Console of the QuantStudio™ 12K Flex Software**

1. In the Instrument Console screen, select the instrument icon.
2. Click **Manage Instrument** or double-click on the instrument icon.
3. In the Manage Instrument screen, click **Monitor Running Experiment** to access the Run screen.
View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all the three plots available from the QuantStudio™ 12K Flex Software for potential problems.

Click **Amplification Plot** from the Run Experiment Menu, select the Plate Layout tab, then select the wells to view.

The figure below shows the Amplification Plot screen as it appears at the end of the example experiment.
View the Temperature Plot

Click **Temperature Plot** from the Run Experiment Menu.

The figure below shows the Temperature Plot screen as it appears during the example experiment.

Note: The Sample temperature displayed in the Current Temperatures group is an estimated value.

View the Run Method

Click **Run Method** from the Run Experiment Menu.

The figure below shows the Run Method screen as it appears in the example experiment.
View Run Data

Click View Run Data from the Run Experiment Menu.

Your View Run Data screen should like this:

From the QuantStudio™ 12K Flex Instrument touchscreen

You can also view the progress of the run from the touchscreen of the QuantStudio™ 12K Flex Instrument.

The Run Method screen on the QuantStudio™ 12K Flex Instrument touchscreen looks like this:

Experiment view

Note: The above screenshot is for visual representation only. Actual results will vary with the experiment.
Chapter 10  Run the Experiment

Monitor the run

Time View

Run Started: December 08 2011 - 12:05AM
Reaction Volume: 20 µL
Sample: 59.5 °C
Heated Cover (Set Point): 105.0 °C (105.0 °C)
Stage / Step / Cycle: 2 / 2 / 5

01:11:22

Remaining Time  Elapsed Time

Plot View

Fast 96-Well

Taqman  ΔRn

Heated cover reached target temperature.
In Section 11.1 of this chapter you review the analyzed data using several of the analysis screens and publish the data. Section 11.2 of this chapter walks you through the process of modifying experiment parameters to troubleshoot problems with experiment results before rerunning an experiment.

This chapter covers:

**Section 11.1 Review Results** ................................................................. 95
- Analyze the example experiment ......................................................... 95
- Assess the gene expression profile using the Gene Expression Plot ........ 95
- Identify well problems using the Well Table ....................................... 97
- Assess amplification results using the Amplification Plot ................. 99
- Confirm accurate dye signal using the Multicomponent Plot ............. 106
- Determine signal accuracy using the Raw Data Plot ....................... 108
- View the endogenous control profile using the QC Plot ..................... 110
- Review the flags in the QC Summary ................................................. 111
- For more information ................................................................. 113

**Section 11.2 Adjust parameters for re-analysis of your own experiments** 115
- Adjust analysis settings ................................................................. 115
- Improve $C_T$ precision by omitting wells ...................................... 118
Section 11.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 10.
2. Click Analyze. The software analyzes the data using the default analysis settings.
   Note: You can also access the experiment to analyze from the Home screen.

Assess the gene expression profile using the Gene Expression Plot

The Gene Expression Plot screen displays the results of relative quantification calculations in the gene expression profile. There are two plots available:

- **RQ vs Target** – Groups the relative quantification (RQ) values by target. Each sample is plotted for each target. You can view the plot as the linear, log10, Ln, and log2 graph types. The Gene Expression plot when viewed as a linear graph type looks like this:
Chapter 11  Review Results and Adjust Experiment Parameters

Assess the gene expression profile using the Gene Expression Plot

- **RQ vs Sample** – Groups the relative quantification (RQ) values by sample. Each target is plotted for each sample. You can view the plot as the following graph types: linear, log10, Ln, log2.

Example experiment values

Review each target in the Gene Expression Plot screen for the expression level (or fold change) of the target sample relative to the reference sample.

View the Gene Expression Plot

1. From the Experiment Menu pane, select Analysis ➤ Gene Expression.
   
   **Note:** If no data are displayed, click Analyze.

2. In the Gene Expression Plot screen, select:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>RQ vs Sample (default)</td>
</tr>
<tr>
<td>Graph Type</td>
<td>Log10</td>
</tr>
<tr>
<td>Orientation</td>
<td>Vertical Bars</td>
</tr>
</tbody>
</table>

3. Click **Show a legend for the plot** (default).
   
   **Note:** This is a toggle button. When the legend is displayed, the button changes to **Hide the plot legend**.
In the example experiment, as shown below, the expression level of each target gene in liver, heart, and lung is displayed relative to its respective expression level in the reference sample (brain). Since the reference sample is compared to itself, the relative expression level is 1. When the result is displayed in the Log10 graph type, the expression level of the reference sample appears as 0 in the graph (log10 of 1 = 0).

### Gene Expression

**Plot Settings**
- Plot Type: RQ vs Sample
- Graph Type: Log10
- Orientation: Vertical Bars

![RQ vs Sample](image)

**Well Summary:**
- In Plate: 96
- Set Up: 96
- Analyzed: 96
- Flagged: 0
- Calculated by Analysis: 0
- Calculated Manually: 0
- Sample Used: 4
- Targets Used: 0

### Assessing the gene expression plot your own experiments

When you analyze your own Comparative C\textsubscript{T} experiment, look for differences in gene expression (as a fold change) relative to the reference sample.

### Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including:
- The sample name, target name, task, and dyes
- The calculated threshold cycle (C\textsubscript{T}), normalized fluorescence (Rn), and quantity values
- Flags

**Example experiment values and flags**

Review the Well Table to evaluate the C\textsubscript{T} precision of the replicate groups.
View the well table

1. From the Experiment Menu pane, select Analysis ▶ Amplification Plot, then click the Well Table tab.

2. From the Group By drop-down menu, select Replicate.

3. Look at the CT SD column to evaluate the CT precision of the replicate groups. In the example experiment, there are ten outliers. You will omit these wells in the troubleshooting section (“Improve CT precision by omitting wells” on page 118).

### Assessing the well table in your own experiments

When you analyze your own Comparative CT experiment, look for standard deviation in the replicate groups (CT SD values). If needed, omit outliers (see “Improve CT precision by omitting wells” on page 118).

### Note:
To show/hide columns in the Well Table, select/deselect the column name from the Show in Table drop-down menu.
Assess amplification results using the Amplification Plot

Amplification plots available for viewing

The Amplification Plot screen displays amplification of all samples in the selected wells. There are three plots available:

- **ΔRn vs Cycle** – ΔRn is the magnitude of normalized fluorescence signal generated by the reporter at each cycle during the PCR amplification. This plot displays ΔRn as a function of cycle number. You can use this plot to identify and examine irregular amplification and to view threshold and baseline values for the run.

- **Rn vs Cycle** – Rn is the fluorescence signal from the reporter dye normalized to the fluorescence signal from the passive reference. This plot displays Rn as a function of cycle number. You can use this plot to identify and examine irregular amplification.

- **C_T vs Well** – C_T is the PCR cycle number at which the fluorescence meets the threshold in the amplification plot. This plot displays C_T as a function of well position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

Purpose

The purpose of viewing the amplification plot for the example experiment is to identify:

- Correct baseline and threshold values
- Outliers

View the Amplification Plot

1. From the Experiment Menu pane, select Analysis ▶ Amplification Plot.
   
   **Note:** If no data are displayed, click Analyze.

2. Display the LP1N1 wells in the Amplification Plot screen:
   a. Click the Plate Layout tab.
   b. From the Select Wells drop-down menus, select Target, then LP1N1.
Chapter 11 Review Results and Adjust Experiment Parameters

Assess amplification results using the Amplification Plot

The Plate Layout screen should look like this:

3. In the Amplification Plot screen, enter:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>ΔRn vs Cycle (default)</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Well (default)</td>
</tr>
<tr>
<td></td>
<td>(This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.)</td>
</tr>
</tbody>
</table>

4. View the baseline values:
   a. From the Graph Type drop-down menu, select Linear.
   b. Select the Baseline check box to show the start cycle and end cycle.
c. Verify that the baseline is set correctly: The end cycle should be set a few cycles before the cycle number where significant fluorescent signal is detected. In the example experiment, the baseline is set correctly.

5. View the threshold values:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Type</td>
<td>Log</td>
</tr>
<tr>
<td>Target</td>
<td>LP1N1</td>
</tr>
</tbody>
</table>

a. Select the **Threshold** check box to show the threshold.

b. Verify that the threshold is set correctly. In the example experiment, the threshold is in the exponential phase.
Chapter 11  Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

6. Locate any outliers:
   a. From the Plot Type drop-down menu, select \( C_T \) vs Well.
   b. Look for outliers from the amplification plot. In the example experiment, there are no outliers for LP1N1.

7. Repeat steps 2 through 6 for the GH1, TGFBI, LIPC, ACTB, and CCKAR wells. In the example experiment, there is seven outliers for CCKAR and three outliers for GH1. You will omit these wells in the troubleshooting section (“Improve \( C_T \) precision by omitting wells” on page 118).

Tips for analyzing your own experiments
When you analyze your own Comparative \( C_T \) experiment, look for:

- **Outliers**
- A typical amplification plot – The QuantStudio™ 12K Flex Software automatically calculates baseline and threshold values based on the assumption that the data exhibit a typical amplification plot. A typical amplification plot has four distinct sections:
  - Plateau phase
  - Linear phase
Exponential (geometric phase)
Baseline
A typical amplification plot should look like this:

**IMPORTANT!** Experimental error (such as contamination or pipetting errors) can produce atypical amplification curves that can result in incorrect baseline and threshold value calculations by the QuantStudio™ 12K Flex Software. Therefore, Life Technologies recommends that you examine the Amplification Plot screen and review the assigned baseline and threshold values for each well after analysis completes.

**Note:** If you use the Relative Threshold algorithm to analyze an experiment that includes amplification, select to view the analysis results using the $\Delta R_n$ vs Cycle, $R_n$ vs Cycle, or $C_R$ vs Well plot type and Linear or Log graph type. Also select the **Show Crt** check box to view the derived fractional cycle on the amplification plot.
Chapter 11  Review Results and Adjust Experiment Parameters

Assess amplification results using the Amplification Plot

• Correct threshold values

**Threshold Set Correctly**

The threshold is set in the exponential phase of the amplification curve. Threshold settings above or below the optimum increase the standard deviation of the replicate groups.

**Threshold Set Too Low**

The threshold is set below the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar up into the exponential phase of the curve.

**Threshold Set Too High**

The threshold is set above the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar down into the exponential phase of the curve.
• Correct baseline values

**Baseline Set Correctly**
The amplification curve begins after the maximum baseline.

**Baseline Set Too Low**
The amplification curve begins too far to the right of the maximum baseline. Increase the End Cycle value.

**Baseline Set Too High**
The amplification curve begins before the maximum baseline. Decrease the End Cycle value.

• View the analyzed data using the relative threshold settings
The QuantStudio™ 12K Flex Software provides the Relative Threshold method to view the analyzed data. The relative threshold algorithm lets you compare the data per well and per target. These options allow analysis of a single gene across samples or, alternatively, a single sample across genes with no dependency on targets, thereby reducing variability.

To view the analyzed data using the relative threshold settings, see “Adjust analysis settings” on page 115.
If your experiment does not meet the guidelines above, troubleshoot as follows:

- Omit wells (see “Improve CT precision by omitting wells” on page 118).
  
  Or

- Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on page 115).

**Confirm accurate dye signal using the Multicomponent Plot**

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

**Purpose**

In the Comparative CT example experiment, you review the Multicomponent Plot screen for:

- ROX™ dye (passive reference)
- FAM™ dye (reporter)
- Spikes, dips, and/or sudden changes
- Amplification in the negative control wells

**View the Multicomponent Plot**

1. From the Experiment Menu pane, select **Analysis › Multicomponent Plot**.
   
   **Note:** If no data are displayed, click **Analyze**.

2. Display the unknown and standard wells one at a time in the Multicomponent Plot screen:
   a. Click the **Plate Layout** tab.
   
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.
   
   **Note:** If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select **Dye**.

4. Click **Show a legend for the plot** (default).
   
   **Note:** This is a toggle button. When the legend is displayed, the button changes to **Hide the plot legend**.
5. Check the FAM dye signals. In the example experiment, the FAM dye signal increases throughout the PCR process, indicating normal amplification.

6. Select the negative control wells one at time and check for amplification. In the example experiment, there is no amplification in the negative control wells.
Chapter 11 Review Results and Adjust Experiment Parameters

Determine signal accuracy using the Raw Data Plot

Tips for confirming dye accuracy in your own experiment

When you analyze your own Comparative Ct experiment, look for:

- **Passive reference** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.
- **Reporter dye** – The reporter dye fluorescence level should display a flat region corresponding to the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.
- **Irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.
- **Negative Control wells** – There should not be any amplification in the negative control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter for the selected wells during each cycle of the real-time PCR.

About the example experiment

In the Comparative Ct example experiment, you review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data Plot

1. From the Experiment Menu pane, select Analysis ➤ Raw Data Plot.
   **Note:** If no data are displayed, click Analyze.

2. Display all 48 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.

3. Click Show a legend for the plot (default).
   **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.
   **Note:** The legend displays the color code for each row of the reaction plate (see the legend in the Raw Data Plot shown below).
4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example experiment, there is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.
Tips for determining signal accuracy in your own experiment

When you analyze your own Comparative C_T experiment, look for the following in each filter:

- Characteristic signal growth
- No abrupt changes or dips

View the endogenous control profile using the QC Plot

In the Comparative C_T experiment, the QC Plot screen displays the Endogenous Control Profile plot for all the targets in the experiment. The QC Plot serves as a tool to help you choose the best endogenous control for that experiment. The endogenous control profile plot is a visual display of the C_T level of the endogenous control across the sample. You can view up to four endogenous controls at a time. The sample is plotted on the X-axis, and C_T is plotted on the Y-axis. The expression is viewed as a color and shape combination in the plot. Endogenous controls are also known as reference genes.

Example experiment settings

In the example experiment, you can view the endogenous control profile of GH1, LP1N1, TGFB1, L1PC, ACTB, and CCKAR in the QC Plot screen.

View the QC Plot

1. From the Experiment Menu pane, select Analysis › QC Plot.
   
   Note: If no data are displayed, click Analyze.

2. In the QC Plot screen, click Target Table.
   
   a. In the Candidate Control column, select the check box of the target of the endogenous control profile to plot. In the example experiment, the endogenous controls selected are GH1, LP1N1, TGFB1, and L1PC.

   b. Select a color for each target, from the Color drop-down menu.

   c. Select a shape for each target, from the Shape drop-down menu.

3. Click the View Replicate Results Table.

4. Select the check box of the samples to plot. In the example experiment, all the four samples, Brain, Heart, Liver, and Lung are selected.

5. Click Show a legend for the plot (default).

   Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.
The QC Plot in the Comparative $C_T$ example experiment looks like this:

Note: This example experiment does not define Biological Groups.

**Review the flags in the QC Summary**

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags, including the flag frequency and location for the open experiment.

Review the QC Summary screen in the Comparative $C_T$ example experiment for any flags triggered by the experiment data. Wells A11, B11, C11, E1, F1, and G1 have data that triggered the HIGHSD flag; wells E11, E12, F11, and F12 have data that triggered the NOAMP flag, and wells E11, E12, F12, and G12 have data that triggered the EXPFAIL flag.

**View the QC Summary**

1. From the Experiment Menu pane, select **Analysis > QC Summary**.
   
   Note: If no data are displayed, click **Analyze**.

2. Review the Flags Summary.
   
   Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment. If the frequency is > 0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.

   In the example experiment, there are ten flagged wells.
3. In the Flag Details table, click each flag with a frequency >0 to display detailed information about the flag. In the example experiment. The HIGHSD flag appears six times, in the wells A11, B11, C11, E1, F1, and G1, indicating high standard deviation in the replicate group. The NOAMP flag appears four times, in the wells E11, E12, F1, and F12, indicating no amplification in the replicate group. The EXPFAIL flag appears in the wells E11, E12, F12, and G12, indicating that the exponential algorithm failed.

**Note:** The HIGHSD flag appears because the $C_T$ values exceed the expected range due to low expression of the CCKAR gene in the Heart sample and the GH1 gene in the Lung sample.

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view information on correcting the flag.

The QC Summary for the example experiment looks like this:

Possible flags

The flags listed below may be triggered by the experiment data.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Pre-processing flag</strong></td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td></td>
<td><strong>Primary analysis flags</strong></td>
</tr>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
</tbody>
</table>
### Flag | Description
--- | ---
NOISE | Noise higher than others in plate
SPIKE | Noise spikes
NOSIGNAL | No signal in well
EXPFAIL | Exponential algorithm failed
BLFAIL | Baseline algorithm failed
THOLDFAIL | Thresholding algorithm failed
CTFAIL | Cₜ algorithm failed
AMPSOCRE | Amplification in the linear region is below a certain threshold, corresponding to the score set in the analysis settings

#### Secondary analysis flags
- OUTLIERRG | Outlier in replicate group
- AMPNC | Amplification in the negative control
- HIGHSD | High standard deviation in replicate group

**Note:** When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

---

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing data</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
</tbody>
</table>
Section 11.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle (C_T), flags, and advanced options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.
2. Click Analysis ▶ Analysis Settings to open the Analysis Settings dialog box.
   In the example experiment, the default analysis settings are used for each tab:
   • C_T Settings
   • Flag Settings
   • Relative Quantification Settings
   • Advanced Settings
   The Analysis Settings dialog box for a Comparative C_T experiment looks like this:
3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” below).

Note: You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to Default Analysis Settings.

Adjust analysis settings

- **CT Settings**

  - Data Step Selection
    Use this feature to select one stage/step combination for CT analysis when there is more than one data collection point in the run method.

  - Algorithm Settings
    You can select the algorithm that determines the CT values. There are two algorithms: Baseline Threshold (the default) and Relative Threshold.
    
    The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for quantification.
    
    The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no dependence on targets, thereby reducing variability. It is not necessary to set either a baseline or a threshold when you use the Relative Threshold algorithm, so any settings for baseline or threshold will not affect the analysis.

  - Default CT Settings
    Use the default CT settings feature to calculate CT for the targets that do not have custom settings. To edit the default settings, click Edit Default Settings.

  - CT Settings for Target
    When you manually set the threshold and baseline, Life Technologies recommends:

    | Setting    | Recommendation                                                                 |
    |------------|-------------------------------------------------------------------------------|
    | Threshold  | Enter a value for the threshold so that the threshold is:                      |
    |            | • Above the background.                                                        |
    |            | • Below the plateau and linear regions of the amplification curve.             |
    |            | • Within the exponential phase of the amplification curve.                    |
    | Baseline   | Select the Start Cycle and End Cycle values so that the baseline ends          |
    |            | before significant fluorescent signal is detected.                           |

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.
Flag Settings

Use the Flag Settings tab to:

- Adjust the sensitivity so that more wells or fewer wells are flagged.
- Change the flags that are applied by the QuantStudio™ 12K Flex Software.

To adjust the flag settings

1. In the Use column, select the check boxes for flags to apply during analysis.
2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.
   
   Note: If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.
3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.
   
   Note: After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments using the Standard Deviation calculations may change the result of $C_T$ SD. For some flags, analysis results calculated before the well is rejected are maintained.
4. Click **Apply Analysis Settings** in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.

The Flag Settings tab looks like this:

![Flag Settings Tab](image-url)
Relative Quantification Settings

Use the Relative Quantification Settings tab to:

- Change the type of analysis, singleplex or multiplex.
- Change the reference sample and/or endogenous control.
- Reject Outliers with \( \Delta C_T \) values less than or equal to the entered value.
  
  **Note:** The Outlier Rejection settings apply only to multiplex reactions.
- Select the algorithm to use to determine the relative quantification minimum and maximum values (error bars):
  - **Confidence Level** - Select to calculate the RQ minimum and maximum values based on the selected confidence level. Select the confidence level to use.
  - **Standard Deviations** - Select to calculate the RQ minimum and maximum values based on the selected number of standard deviations. Select the number of standard deviations to use.

Advanced Settings

Use the Advanced Settings tab to change baseline settings well-by-well.

**Note:** The baseline and threshold values do not affect the analysis using the Relative Threshold setting.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.
2. Deselect the **Use C_T Settings Defined for Target** check box.
3. Define the custom baseline settings:
   - For automatic baseline calculations, select the **Automatic Baseline** check box.
   - To define the baseline, deselect the **Automatic Baseline** check box, then enter the baseline start cycle and baseline end cycle.

**Improve \( C_T \) precision by omitting wells**

Experimental error may cause some wells to be amplified insufficiently or not at all. These wells typically produce \( C_T \) values that differ significantly from the average for the associated replicate wells. If included in the calculations, these outliers can result in erroneous measurements; to ensure \( C_T \) precision, omit the outliers from the analysis.

In the Comparative \( C_T \) example experiment, there are seven outliers. To remove these wells from analysis:

1. From the Experiment Menu pane, select **Analysis › Amplification Plot**.
   
   **Note:** If no data are displayed, click **Analyze**.
2. In the Amplification Plot screen, select **C_T vs Well** from the Plot Type drop-down menu.
3. Select the **Well Table** tab.
4. In the Well Table, identify outliers:
   a. From the Group By drop-down menu, select Replicate.
   b. Look for outliers in the replicate group (make sure they are flagged). In the example experiment, wells A11, B11, C11, E1, F1, E11, E12, F11, F12, and G12 have outliers.
   c. Select the Omit check box next to outlying well(s).
Chapter 11  Review Results and Adjust Experiment Parameters

Improve $C_T$ precision by omitting wells

5. Click **Analyze** to reanalyze the experiment data with the outlying well(s) removed from the analysis.

**Note:** You can also omit undesirable wells in an experiment from the Plate Layout screen. To omit a well from the Plate Layout screen, right-click the well and select **Omit.**
1. Open the Comparative C\textsubscript{T} example experiment file that you analyzed in Chapter 11.

2. In the Experiment Menu, click Export.
   
   **Note:** To export data automatically after analysis, select the Auto Export check box during experiment setup or before running the experiment. Auto export is unchecked for the example experiment.

3. Select QuantStudio™ 12K Flex format.
   
   **Note:** Select 7900 Format if you want to export the Clipped Data.

4. Complete the Export dialog box as shown below:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export/ Select Content</td>
<td>Results</td>
</tr>
<tr>
<td>Export Data To</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>96-Well Fast Comparative Ct Example_QuantStudio_export</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td>&lt;drive&gt;:\Applied Biosystems\QuantStudio 12K Flex Software\experiments</td>
</tr>
</tbody>
</table>
Chapter 12  Export Analysis Results

Your Export screen should look like this:

![Image of Export screen]

Your exported file when opened in Notepad should look like this:

![Image of exported file in Notepad]

---

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
Experiments User Guide for Relative Standard Curve and Comparative Ct Experiments
Index

A
adjusting parameters, re-analyzing own experiments 59, 115
Advanced Settings tab 62, 118
Algorithm Settings
  Baseline Threshold 60, 116
  Relative Threshold 60, 116
amplification efficiency, factors affecting
  PCR inhibitors 39
  standard quantities 39
  standard replicates 39
amplification plot
  amplification efficiency 19, 39, 64
  assessing amplification results 40, 99
  reviewing baseline values 41, 100
  reviewing outliers 43, 102
  reviewing threshold values 42, 101
  tips for analyzing own experiments 44, 103
  viewing 30, 40, 88, 99
AMPNC flag 57, 114
AMPSCORE flag 57, 114
analysis settings
  adjusting 59, 115
  Advanced Settings 59, 115
  C_T Settings 59, 115
  defining 14, 75
  Flag Settings 59, 115
  Relative Quantification Settings 59, 115
  Standard Curve Settings 59
Analyze
  Amplification Plot 40, 99
  Gene Expression Plot 47, 95
  Multicomponent Plot 51, 107
  QC Plot 55, 111
  QC Summary 56, 112
  Raw Data Plot 53, 109
  Standard Curve Plot 37
  Well Table 49, 97
Auto Export 65, 121
Automatic Baseline, advanced settings 62, 118
Automatic Threshold 60, 116

B
BADROX flag 57, 113
baseline values, correcting 46, 105
BLFAIL flag 57, 114

C
cocktail mix 23, 82
comparative CT experiments
  example experiment 71
  overview 69
  PCR options 70
  required components, assemble 69
C_T settings
  algorithm settings 60, 116
  data step, selecting 60, 116
  default 60, 116
  target 60, 116
  C_T Settings tab 60, 116, 57, 114

D
defining samples 14, 74
defining targets 14, 74
designing experiment
  assigning targets, samples, and biological groups 15, 75
  defining and setting up standards 15
  defining experiment properties 13, 73
  defining targets, samples, and biological replicates 14, 74
  setting up run method 17, 77
  tips for designing own experiment 18, 78
dye accuracy
  irregularities in the signal 53, 109
  negative control wells 53, 109
  passive reference 53, 109
  reporter dye 53, 109

E
endogenous control, selecting 18, 78
experiment properties, defining 13, 73
EXPFAIL flag 57, 114
Export 65, 121

F
Flag Settings tab 61, 117
flags, QC
  AMPNC 57, 114
  AMPSCORE 57, 114
  BADROX 57, 113
  BLFAIL 57, 114
  CTFAIL 57, 114
  EXPFAIL 57, 114
  HIGHSD 57, 114
  NOAMP 57, 113
  NOISE 57, 114
  NOSIGNAL 57, 114
  OFFSCALE 57, 113
  OUTLIERRG 57, 114
  SPIKE 57, 114
  THOLDFAIL 57, 114

G
gene expression plot
  assessing gene expression profile 47, 95
  assessing own experiments 49, 97
  viewing 48, 96
gene expression plots available
  RQ vs Sample 48, 96
  RQ vs Target 47, 95

H
HIGHSD flag 57, 114

I
improving C_T precision, omitting wells 63, 118

M
multicomponent plot
  confirming dye accuracy 51, 107
  tips for analyzing own experiment 53, 109
  viewing 51, 107

N
NOAMP flag 57, 113
NOISE flag 57, 114
NOSIGNAL flag 57, 114

O
OFFSCALE flag 57, 113
OUTLIERRG flag 57, 114

P
PCR options
  1-step PCR 11, 70
  2-step PCR 11, 70
  Multiplex PCR 10, 70
  Singleplex PCR 10, 70
preparing reactions
  reaction mix 23, 82
  reaction plate 24, 83
  required materials 21, 81
  sample dilutions 22, 82
  standard dilution series 22
  template 21, 81
tips for your own experiment 26, 84
preparing template
  Complementary DNA 26
  Genomic DNA 26
Pre-processing flag
  OFFSCALE 57, 113
Primary analysis flags
  AMPSCORE 57, 114
  BADROX 57, 113
  BLFAIL 57, 114
  CTFAIL 57, 114
  EXPFAIL 57, 114
  NOAMP 57, 113
  NOISE 57, 114
  NOSIGNAL 57, 114
  SPIKE 57, 114
  THOLDFAIL 57, 114
publishing data 58, 114

Q
QC plots
  viewing endogenous control profile 55, 111
QC Summary
  reviewing flags 56, 112
## Contents

- **CHAPTER 1**  About Genotyping Experiments  ........................................... 5
  - About data collection ........................................................................ 5
    - About TaqMan® SNP Genotyping assays ........................................ 6
    - About TaqMan® MGB probes ......................................................... 6
  - 5’ nuclease assay ............................................................................ 6
  - Minimizing non-specific fluorescence .............................................. 7
  - Reading and analyzing the plates ..................................................... 7
  - About the example experiment ...................................................... 8

- **CHAPTER 2**  Design the Experiment ....................................................... 11
  - Define the experiment properties .................................................... 11
  - Define SNPs and samples ............................................................... 12
  - Assign markers and samples .......................................................... 14
  - Set up the run method ................................................................. 16
  - For more information .................................................................... 17

- **CHAPTER 3**  Prepare the Reactions ......................................................... 19
  - Assemble required materials ......................................................... 19
  - Prepare the sample dilutions .......................................................... 19
  - Prepare the reaction mix ("cocktail mix") ..................................... 20
  - Prepare the reaction plate .............................................................. 20
    - Example experiment reaction plate components .......................... 20
    - To prepare the reaction plate: dried gDNA ................................. 21
    - To prepare the reaction plate: wet gDNA .................................. 22
  - Tips for preparing reactions for your own experiments ................. 22
    - Tips for preparing samples .......................................................... 22
    - Tips for preparing the reaction mix ............................................. 22
    - Tips for preparing the reaction plate ......................................... 22
  - For more information .................................................................... 22

- **CHAPTER 4**  Run the Experiment ........................................................... 23
  - Start the run .................................................................................. 23
  - Monitor the run ............................................................................. 23
    - From the Instrument Console of the QuantStudio™ 12K Flex Software ......................................................... 24
    - From the QuantStudio™ 12K Flex Instrument touchscreen ......................................................... 27

- **CHAPTER 5**  Review Results and Adjust Experiment Parameters .......... 29
  - Analyze the example experiment .................................................. 31
  - View clusters in the Allelic Discrimination Plot ............................ 31
    - To view and assess the allelic discrimination plot ........................ 31
### Contents

- Troubleshoot clustering on the Allelic Discrimination Plot ................................................................. 33
- Confirm setup accuracy using Plate Layout .................................................................................................. 34
  - Example experiment plate layout values .................................................................................................. 34
  - View the layout ........................................................................................................................................ 34
  - Tips for troubleshooting plate setup in your own experiment ................................................................ 36
- Assess amplification results using the Amplification Plot .................................................................................. 36
  - About amplification plots .......................................................................................................................... 37
  - View the ΔRn vs. Cycle plot ..................................................................................................................... 37
- Identify well problems using the Well Table ...................................................................................................... 40
  - Example experiment values and flags ......................................................................................................... 40
  - View the well table ...................................................................................................................................... 40
  - Identify quality control (QC) problems ........................................................................................................ 41
  - Tips for analyzing your own experiments .................................................................................................. 42
- Confirm accurate dye signal using the Multicomponent Plot .................................................................................... 43
  - Purpose .................................................................................................................................................... 43
  - View the Multicomponent Plot .................................................................................................................. 43
  - Tips for confirming dye accuracy in your own experiment .......................................................................... 44
- Determine signal accuracy using the Raw Data Plot ............................................................................................... 45
  - Purpose .................................................................................................................................................... 45
  - View the Raw Data Plot ............................................................................................................................ 45
  - Tips for determining signal accuracy in your own experiment ................................................................... 46
- Review the flags in the QC Summary ..................................................................................................................... 46
  - View the QC Summary .............................................................................................................................. 47
  - Possible flags ............................................................................................................................................ 48
- For more information ......................................................................................................................................... 48
- Adjust analysis settings ....................................................................................................................................... 49
  - View the analysis settings .......................................................................................................................... 49
  - Adjust analysis settings .............................................................................................................................. 50
- For more information ......................................................................................................................................... 53

#### CHAPTER 6  Export Analysis Results ................................................................. 55

Index ................................................................................................................................................................. 57
1

About Genotyping Experiments

This chapter covers:

■ About data collection ................................................................. 5
■ About TaqMan® SNP Genotyping assays ........................................ 6
■ About TaqMan® MGB probes ....................................................... 6
■ 5′ nuclease assay ........................................................................ 6
■ Minimizing non-specific fluorescence ......................................... 7
■ Reading and analyzing the plates ................................................ 7
■ About the example experiment .................................................... 8

IMPORTANT! First-time users of the QuantStudio™ 12K Flex System please read Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments and Booklet 7, QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments - Appendixes of this binder thoroughly. The booklets provide information and general instructions that are applicable to all the experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ 12K Flex Software by pressing F1, clicking ? in the toolbar, or selecting Help » QuantStudio™ 12K Flex Software Help.

About data collection

Genotyping experiments are performed to detect single nucleotide polymorphism (SNP) variants of a target nucleic acid sequence in samples. The PCR reactions contain primers designed to amplify the sequence containing the SNP and reagents to detect two different alleles.

You can collect the results of a genotyping experiment in two different ways: At the end of the experiment, or continuously during the experiment. Data collection at the end of the experiment is called end-point data collection. Data collection during the experiment run is considered real-time PCR. The real-time data helps further data analysis.

In end-point data collection, the normalized intensity of the reporter dye, or Rn, is the data collected. Some end-point experiments also include pre-PCR (data collected before the amplification process) data collection. The system calculates the delta Rn (ΔRn) value per the following formula:

ΔRn = Rn (post-PCR read) – Rn (pre-PCR read), where Rn = normalized readings.
About TaqMan® SNP Genotyping assays

A Genotyping assay detects variants of a single nucleic acid sequence, without quantifying the target. The presence of two probes in each reaction allows Genotyping of the two possible variants at the single nucleotide polymorphism (SNP) site in a target sequence.

Each TaqMan® SNP Genotyping Assay consists of a single, ready-to-use tube containing:

- Two sequence-specific primers for amplifying the polymorphism of interest
- Two allele-specific TaqMan® MGB probes for detecting the alleles for the specific polymorphism of interest

About TaqMan® MGB probes

Each allele-specific TaqMan® MGB probe has:

- A reporter dye at its 5’ end:
  - VIC® dye is linked to the 5’ end of the Allele 1 probe.
  - FAM™ dye is linked to the 5’ end of the Allele 2 probe.

The Allele 1 VIC® dye-labeled probe corresponds to the first nucleotide inside the square brackets of the context sequence in the assay information file (AIF) shipped with each order. The Allele 2 FAM™ dye-labeled probe corresponds to the second nucleotide inside the square brackets of the context sequence in the AIF. For the context sequence ATCGATT[G/T]ATCC, the VIC® dye-labeled probe binds to the G allele, and the FAM™ dye-labeled probe to the T allele.

- A minor groove binder (MGB), which increases the melting temperature (Tm) for a given probe length and allows the design of shorter probes. The use of shorter probes results in greater differences in Tm values between matched and mismatched probes, and more robust genotyping.

- A non-fluorescent quencher (NFQ) at its 3’ end, which allows for detection of the reporter dye fluorescence with greater sensitivity than with a fluorescent quencher.

5’ nuclease assay

The figure below is a schematic depiction of the 5’ nuclease assay. During PCR:

- Each TaqMan® MGB probe anneals specifically to its complementary sequence between the forward and reverse primer sites.

- When the oligonucleotide probe is intact, the proximity of the quencher dye to the reporter dye quenches the reporter signal.

- AmpliTaq Gold® DNA polymerase extends the primers bound to the genomic DNA template.
• AmpliTaq Gold® DNA polymerase (with its 5’ nuclease activity) cleaves probes that are hybridized to the target sequence.

• Cleavage of the probes hybridized to the target sequence separates the quencher dye from the reporter dye, resulting in increased fluorescence by the reporter. The fluorescence signal generated by PCR amplification indicates which alleles are present in the sample.

Minimizing non-specific fluorescence

In TaqMan® assays, fluorescence from nonspecifically bound probes is reduced, because nucleotide mismatches between a probe and a sequence reduce the chances that the probe will be cleaved. The probe’s short length means that a one-base-pair mismatch will have a larger negative effect on the binding. The mismatched probe will not bind tightly to the allele; the AmpliTaq Gold® DNA polymerase will likely displace the probe without cleaving the dye.

Reading and analyzing the plates

The QuantStudio™ 12K Flex Software genotypes the DNA samples from the reaction plate simultaneously. First, the software normalizes the fluorescence of the reporter dyes to the fluorescence of the passive reference dye in each well. Next, the software plots the normalized intensities (Rn) of the reporter dyes in each sample well on an
Allelic Discrimination Plot, which contrasts the reporter dye intensities of the allele-specific probes. Finally, the QuantStudio™ 12K Flex Software algorithmically clusters the sample data, and assigns a genotype call to the samples of each cluster according to its position on the plot.

**Note:** The QuantStudio™ 12K Flex Software clustering algorithm does not call genotypes when only one genotype is present in an experiment.

The clustering of datapoints can vary along the horizontal axis (Allele 1), vertical axis (Allele 2), or diagonal (Allele 1/Allele 2). This variation results from differences in the extent of reporter dye fluorescent intensity after PCR amplification. The table below shows the correlation between fluorescence signals and sequences in a sample.

<table>
<thead>
<tr>
<th>A substantial increase in...</th>
<th>Indicates...</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIC® dye-labeled probe fluorescence only</td>
<td>Homozygosity for Allele 1</td>
</tr>
<tr>
<td>FAM™ dye-labeled probe fluorescence only</td>
<td>Homozygosity for Allele 2</td>
</tr>
<tr>
<td>Both VIC® and FAM™ dye-labeled probes fluorescence</td>
<td>Allele 1-Allele 2 heterozygosity</td>
</tr>
</tbody>
</table>

**About the example experiment**

To illustrate how to perform Genotyping experiments, this guide leads you through the process of designing and performing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with a QuantStudio™ 12K Flex System.

The objective of the example Genotyping experiment is to investigate SNP rs8039, where possible genotypes are AA, AC, and CC. In the example, 19 unknown genomic DNA (gDNA) samples were genotyped using TaqMan® Drug Metabolism Genotyping Assay ID C___1240647_1_ and C___1213693_10. The reactions were set up so that the
PCR primers and probes that target both alleles of SNP rs8039 were present in the same well. The PCR was performed using the TaqMan® Genotyping Master Mix and run according to the protocol that is described in the *Performing a TaqMan® Drug Metabolism Genotyping Assay*. 
Chapter 1 About Genotyping Experiments

About the example experiment
Design the Experiment

This chapter explains how to design the example experiment from the Experiment Setup menu.

This chapter covers:

- Define the experiment properties .......................................................... 11
- Define SNPs and samples ......................................................................... 12
- Assign markers and samples ..................................................................... 14
- Set up the run method ............................................................................. 16
- For more information ............................................................................... 17

Note: To automatically export the analyzed data to a specified location, select the Auto Export task from the Export screen, before running the experiment. For more information on Auto Export, refer to Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

Define the experiment properties

Click Experiment Setup → Experiment Properties to create a new experiment in the QuantStudio™ Software. Enter:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Name</td>
<td>96-Well Genotyping Example</td>
</tr>
<tr>
<td>Barcode</td>
<td>Leave field empty</td>
</tr>
<tr>
<td>User Name</td>
<td>Example User</td>
</tr>
<tr>
<td>Comments</td>
<td>Genotyping example</td>
</tr>
<tr>
<td>Block</td>
<td>96-Well (0.2mL)</td>
</tr>
<tr>
<td>Experiment Type</td>
<td>Genotyping</td>
</tr>
<tr>
<td>Reagents</td>
<td>TaqMan® Reagents</td>
</tr>
<tr>
<td>Ramp speed</td>
<td>Standard</td>
</tr>
</tbody>
</table>

Select all three data-collection check boxes: Pre-PCR, Amplification, and Post-PCR collection methods:

<table>
<thead>
<tr>
<th>Pre-PCR Read</th>
<th>Checked</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification</td>
<td>Checked</td>
</tr>
<tr>
<td>Post-PCR Read</td>
<td>Checked</td>
</tr>
</tbody>
</table>
Save the experiment.

Your Experiment Properties screen should look like this:

![Experiment Properties Screen](image)

### Define SNPs and samples

Click **Define** to access the Define screen. Enter:

1. **SNP Assays**

<table>
<thead>
<tr>
<th>SNP assay name</th>
<th>NCBI SNP reference</th>
<th>Context sequence</th>
<th>Allele 1</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Allele 2</th>
<th>Reporter</th>
<th>Quencher</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNP Assay 1</td>
<td></td>
<td></td>
<td>Allele1</td>
<td>VIC</td>
<td>NFQ-MGB</td>
<td>Allele2</td>
<td>FAM</td>
<td>NFQ-MGB</td>
</tr>
<tr>
<td>SNP Assay 2</td>
<td></td>
<td></td>
<td>Allele1</td>
<td>VIC</td>
<td>NFQ-MGB</td>
<td>Allele2</td>
<td>FAM</td>
<td>NFQ-MGB</td>
</tr>
</tbody>
</table>

**Note:** The NCBI SNP reference and Context sequence fields are optional fields and are used for reference. They are not required to run an experiment.

2. **Samples**

<table>
<thead>
<tr>
<th>Sample name</th>
<th>Color</th>
<th>Sample name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample 1</td>
<td><img src="image" alt="Red" /></td>
<td>Sample 11</td>
<td><img src="image" alt="Yellow" /></td>
</tr>
<tr>
<td>Sample 2</td>
<td><img src="image" alt="Red" /></td>
<td>Sample 12</td>
<td><img src="image" alt="Orange" /></td>
</tr>
<tr>
<td>Sample 3</td>
<td><img src="image" alt="Blue" /></td>
<td>Sample 13</td>
<td><img src="image" alt="Green" /></td>
</tr>
<tr>
<td>Sample 4</td>
<td><img src="image" alt="Green" /></td>
<td>Sample 14</td>
<td><img src="image" alt="Red" /></td>
</tr>
</tbody>
</table>
Chapter 2  Design the Experiment

Define SNPs and samples

3. Dye to be used as a Passive Reference
   ROX

Your Define screen should look like this:

<table>
<thead>
<tr>
<th>Sample name</th>
<th>Color</th>
<th>Sample name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample 5</td>
<td></td>
<td>Sample 15</td>
<td></td>
</tr>
<tr>
<td>Sample 6</td>
<td></td>
<td>Sample 16</td>
<td></td>
</tr>
<tr>
<td>Sample 7</td>
<td></td>
<td>Sample 17</td>
<td></td>
</tr>
<tr>
<td>Sample 8</td>
<td></td>
<td>Sample 18</td>
<td></td>
</tr>
<tr>
<td>Sample 9</td>
<td></td>
<td>Sample 19</td>
<td></td>
</tr>
<tr>
<td>Sample 10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: This example experiment does not define biological replicate groups. Leave Biological Replicate Groups blank.
## Assign markers and samples

Click **Assign** to access the Assign screen. Enter the SNP assays and samples:

- **SNP Assay 1**

<table>
<thead>
<tr>
<th>Target name</th>
<th>Well number</th>
<th>Task</th>
<th>Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNP Assay 1</td>
<td>A1, E1</td>
<td>Unknown</td>
<td>Sample 1</td>
</tr>
<tr>
<td></td>
<td>A2, E2</td>
<td></td>
<td>Sample 2</td>
</tr>
<tr>
<td></td>
<td>A3, E3</td>
<td></td>
<td>Sample 3</td>
</tr>
<tr>
<td></td>
<td>A4, E4</td>
<td></td>
<td>Sample 4</td>
</tr>
<tr>
<td></td>
<td>A5, E5</td>
<td></td>
<td>Sample 5</td>
</tr>
<tr>
<td></td>
<td>A6, E6</td>
<td></td>
<td>Sample 6</td>
</tr>
<tr>
<td></td>
<td>B1, F1</td>
<td></td>
<td>Sample 7</td>
</tr>
<tr>
<td></td>
<td>B2, F2</td>
<td></td>
<td>Sample 8</td>
</tr>
<tr>
<td></td>
<td>B3, F3</td>
<td></td>
<td>Sample 9</td>
</tr>
<tr>
<td></td>
<td>B4, F4</td>
<td></td>
<td>Sample 10</td>
</tr>
<tr>
<td></td>
<td>B5, F5</td>
<td></td>
<td>Sample 11</td>
</tr>
<tr>
<td></td>
<td>B6, F6</td>
<td></td>
<td>Sample 12</td>
</tr>
<tr>
<td></td>
<td>C1, G1</td>
<td></td>
<td>Sample 13</td>
</tr>
<tr>
<td></td>
<td>C2, G2</td>
<td></td>
<td>Sample 14</td>
</tr>
<tr>
<td></td>
<td>C3, G3</td>
<td></td>
<td>Sample 15</td>
</tr>
<tr>
<td></td>
<td>C4, G4</td>
<td></td>
<td>Sample 16</td>
</tr>
<tr>
<td></td>
<td>C5, G5</td>
<td></td>
<td>Sample 17</td>
</tr>
<tr>
<td></td>
<td>C6, G6</td>
<td></td>
<td>Sample 18</td>
</tr>
<tr>
<td></td>
<td>D1, H1</td>
<td></td>
<td>Sample 19</td>
</tr>
<tr>
<td>SNP Assay 1</td>
<td>D2 - D6</td>
<td>No Template Control</td>
<td></td>
</tr>
<tr>
<td></td>
<td>H2 - H6</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Assign markers and samples

### SNP Assay 2

<table>
<thead>
<tr>
<th>Target name</th>
<th>Well number</th>
<th>Task</th>
<th>Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNP Assay 2</td>
<td>A7, E7</td>
<td>Unknown</td>
<td>Sample 1</td>
</tr>
<tr>
<td></td>
<td>A8, E8</td>
<td></td>
<td>Sample 2</td>
</tr>
<tr>
<td></td>
<td>A9, E9</td>
<td></td>
<td>Sample 3</td>
</tr>
<tr>
<td></td>
<td>A10, E10</td>
<td></td>
<td>Sample 4</td>
</tr>
<tr>
<td></td>
<td>A11, E11</td>
<td></td>
<td>Sample 5</td>
</tr>
<tr>
<td></td>
<td>A12, E12</td>
<td></td>
<td>Sample 6</td>
</tr>
<tr>
<td></td>
<td>B7, F7</td>
<td></td>
<td>Sample 7</td>
</tr>
<tr>
<td></td>
<td>B8, F8</td>
<td></td>
<td>Sample 8</td>
</tr>
<tr>
<td></td>
<td>B9, F9</td>
<td></td>
<td>Sample 9</td>
</tr>
<tr>
<td></td>
<td>B10, F10</td>
<td></td>
<td>Sample 10</td>
</tr>
<tr>
<td></td>
<td>B11, F11</td>
<td></td>
<td>Sample 11</td>
</tr>
<tr>
<td></td>
<td>B12, F12</td>
<td></td>
<td>Sample 12</td>
</tr>
<tr>
<td></td>
<td>C7, G7</td>
<td></td>
<td>Sample 13</td>
</tr>
<tr>
<td></td>
<td>C8, G8</td>
<td></td>
<td>Sample 14</td>
</tr>
<tr>
<td></td>
<td>C9, G9</td>
<td></td>
<td>Sample 15</td>
</tr>
<tr>
<td></td>
<td>C10, G10</td>
<td></td>
<td>Sample 16</td>
</tr>
<tr>
<td></td>
<td>C11, G11</td>
<td></td>
<td>Sample 17</td>
</tr>
<tr>
<td></td>
<td>C12, H12</td>
<td></td>
<td>Sample 18</td>
</tr>
<tr>
<td></td>
<td>D7, H7</td>
<td></td>
<td>Sample 19</td>
</tr>
<tr>
<td>SNP Assay 2</td>
<td>D8 - D12</td>
<td>No Template Control</td>
<td></td>
</tr>
<tr>
<td></td>
<td>H8 - H12</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Set up the run method

Click **Run Method** to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- **Reaction Volume Per Well**: 50 µL
- **Thermal Profile**

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp Rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Read Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Hold Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>10 minutes</td>
</tr>
<tr>
<td>PCR Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>15 seconds</td>
</tr>
<tr>
<td></td>
<td>Step 2</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>1 minute</td>
</tr>
<tr>
<td>Post-Read Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>30 seconds</td>
</tr>
</tbody>
</table>
Your Run Method screen should look like this:

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
</table>
| Consumables               | Chapter 1 in Booklet 1, *Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments*  
Appendix A in Booklet 7, *QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments - Appendixes* | 4470050       |
| Data collection           | Chapter 1 in Booklet 1, *Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments* | 4470050       |
| Amplification efficiency  | *Amplification Efficiency of TaqMan® Gene Expression Assays Application Note* | 127AP05-03    |
| Using alternative setup   | Chapter 2 in Booklet 1, *Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments* | 4470050       |
Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Genotyping example experiment.

This chapter covers:
- Assemble required materials .................................................. 19
- Prepare the sample dilutions .................................................... 19
- Prepare the reaction mix (“cocktail mix”). .............................. 20
- Prepare the reaction plate ....................................................... 20
- Tips for preparing reactions for your own experiments .............. 22
- For more information .............................................................. 22

Assemble required materials

- Items listed in Booklet 1, *Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments*
- Samples - Sample 1 - Sample 19
- Example experiment reaction mix components:
  - TaqMan® Genotyping Master Mix (2X)
  - SNP 1 Assay Mix (20X)
  - SNP 2 Assay Mix (20X)

Prepare the sample dilutions

For the example experiment, two targets are assigned to 38 wells each. Each well contains 20 ng of Coriell DNA. The stock concentration is 10 ng/µL.

To prepare the sample dilutions:
1. Label a separate microcentrifuge tube for each sample to be diluted.
   
   **Note:** You can also use a MicroAmp® Optical 96-Well Reaction Plate to prepare the sample dilutions.

2. Add 2 µL of sample stock to each empty tube.
3. Add 48 µL of sterile water (diluent) to each tube, such that each working stock tube has a final concentration of 10 ng/µL
4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.
5. Place the diluted samples on ice until you prepare the reaction plate.
Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:
   • SNP 1 Reaction Mix
   • SNP 2 Reaction Mix

2. For SNP Assay 1, prepare a cocktail by adding the required volumes of each component to the SNP 1 reaction tube, as detailed below.

3. Gently pipette the reaction mix up and down, then cap the tube.
4. Centrifuge the tube briefly.
5. Place the reaction mixes on ice until you prepare the reaction plate.
6. Repeat step 2 through 5 for the SNP 2 assay.
   *Note:* Do not add the sample at this time.

Prepare the reaction plate

The reaction plate for the Genotyping example experiment contains:
• A MicroAmp® Optical 96-Well Reaction Plate
• Reaction volume: 50 µL/well
• 76 Unknown wells

<table>
<thead>
<tr>
<th>Reaction component</th>
<th>Reaction volume</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Per well (µL)</td>
</tr>
<tr>
<td></td>
<td>Dry</td>
</tr>
<tr>
<td>TaqMan® Genotyping Master Mix (2X)</td>
<td>10.0</td>
</tr>
<tr>
<td>SNP Assay Mix (20X)</td>
<td>1.0</td>
</tr>
<tr>
<td>H2O, DNase-free</td>
<td>39.0</td>
</tr>
<tr>
<td>Total Reaction Mix Volume</td>
<td>50.00</td>
</tr>
</tbody>
</table>
The reaction plate for the example experiment looks like this:

To prepare the reaction plate: dried gDNA

1. Pipette 2.0 µL of the appropriate sample (20 ng of purified genomic DNA) into each well of the reaction plate.
   All wells belonging to the same Genotyping assay must contain approximately the same quantity of sample or control.
   **Note:** While preparing the reaction plate for your own Genotyping experiment, add between 1 and 20 ng of purified DNA per reaction.

2. Dry down the samples by evaporation at room temperature in a dark, amplicon-free location. (Cover the reaction plate with a lint-free tissue while drying.)

3. Transfer 48 µL of reaction mix to each well.

   **IMPORTANT!** Make sure that no cross-contamination occurs from well to well.

4. Seal the reaction plate with adhesive film.

5. Vortex the reaction plate for 3 to 5 sec.

6. Briefly centrifuge the reaction plate.

7. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the plate again at a higher speed and for a longer period of time.
To prepare the reaction plate: wet gDNA
1. Add 2 µL of DNA to the appropriate wells.
2. Add 2 µL of water to wells containing the NTCs.
3. Transfer 48 µL of reaction mix to the appropriate wells.
4. Seal the reaction plate with optical adhesive film.
5. Vortex the reaction plate for 3 to 5 seconds, then briefly centrifuge it.
6. Centrifuge the reaction plate briefly.
7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

Tips for preparing reactions for your own experiments

Tips for preparing samples
When you prepare the samples for your own experiment:
• Use DNase-free water to dilute the samples.
• Use the same quantity of DNA per well for each experiment.

Tips for preparing the reaction mix
When you prepare the reaction mix for your own experiment, make sure you prepare the reactions for each SNP separately.
Prior to use:
• Mix the master mix thoroughly by swirling the bottle.
• Resuspend the assay mix by vortexing, then centrifuge the tube briefly.
• Thaw frozen samples by placing them on ice. When thawed, resuspend the samples by vortexing, then centrifuge the tubes briefly.

Tips for preparing the reaction plate
When you prepare the reaction plate for your own experiment:
• Make sure the reaction locations match the plate layout in the QuantStudio™ 12K Flex Software.
• Load 1 to 20 ng of purified genomic DNA per reaction
• All wells belonging to the same Genotyping assay must contain approximately the same quantity of sample or control.
• Multiple assays may be run on one reaction plate, but must be analyzed separately.

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning the reaction plate components</td>
<td>Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</td>
<td>4470050</td>
</tr>
<tr>
<td>Sealing the reaction plate</td>
<td>Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</td>
<td>4470050</td>
</tr>
</tbody>
</table>
Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K Flex Instrument.

This chapter covers:

- Start the run................................................................. 23
- Monitor the run............................................................. 23

**IMPORTANT!** Run the experiment at the same ambient temperature at which you calibrated the instrument. Extreme variations in ambient temperature can affect the heating and cooling of the instrument and influence experimental results.

**IMPORTANT!** Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 12K Flex Instrument is in operation.

**Start the run**

1. Open the Genotyping example file that you created using instructions in Chapter 2.
2. Load the reaction plate into the instrument.
3. Start the run.

   **Note:** To collect real-time data during a run, click the button on the Run Method screen in the Experiment Setup menu.

**Monitor the run**

Monitor the example experiment run:

- From the QuantStudio™ 12K Flex Software using the Run screen, while the experiment is in progress.
- From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor an experiment started from another computer or from the QuantStudio™ 12K Flex Instrument touchscreen).
- From the QuantStudio™ 12K Flex Instrument touchscreen.
1. In the Instrument Console screen, select the instrument icon.

2. Click **Manage Instrument** or double-click on the instrument icon.

3. On the Manage Instrument screen, click **Monitor Running Instrument** to access the Run screen.

**View the Amplification Plot**

You can view the progress of the run in real time. During the run, periodically view all the three plots available from the QuantStudio™ 12K Flex Software for potential problems.

Click **Amplification Plot** from the Run Experiment Menu, select the Plate Layout tab, then select the wells to view.

The figure below shows the Amplification Plot screen as it appears at the end of the example experiment.

**Note:** The Amplification Plot is not available for experiments that do not include the PCR process.
View the Temperature Plot

Click **Temperature Plot** from the Run Experiment Menu.

The figure below shows the Temperature Plot screen as it appears during the example experiment.

![Temperature Plot](image)

**Note:** The sample temperature displayed in the Current Temperatures group is a calculated value.

View the Run Method

Click **Run Method** from the Run Experiment Menu.

The figure below shows the Run Method screen as it appears in the example experiment.
Chapter 4 Run the Experiment

Monitor the run

View run data

Click View Run Data from the Run Experiment Menu.

The figure below shows the View Run Data screen as it appears in the example experiment.

![Run Data Report](image)

From the QuantStudio™ 12K Flex Instrument touchscreen

You can also view the progress of the run from the touchscreen of the QuantStudio™ 12K Flex Instrument.

The Run Method screen on the QuantStudio™ 12K Flex Instrument touchscreen looks like this:

![Run Method Screen](image)

Note: The above screenshot is for visual representation only. Actual results will vary with the experiment.
Chapter 4  Run the Experiment
Monitor the run

Time View

<table>
<thead>
<tr>
<th>Time View</th>
<th>Plot View</th>
<th>Experiment View</th>
</tr>
</thead>
</table>

- Run Started: December 08 2011 - 12:05AM
- Reaction Volume: 20 µL
- Sample: 50.5 ºC
- Heated Cover (Set Point): 105.0 ºC (105.0 ºC)
- Stage / Step / Cycle: 2 / 2 / 5

01:11:22

Remaining Time  Elapsed Time

Note: You will see the Plot View only if your experiment includes the PCR process.

Plot View

- Experiment View
- Time View
- Plot View

Fast 96-Well

Taqman  ΔRn

Cycle

December 08 2011 - 12:07AM

Heated cover reached target temperature.
Monitor the run
Review Results and Adjust Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis screens and publish the data. Section 5.2 of this chapter walks you through the process of modifying experiment parameters to troubleshoot problems with experiment results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ................................................. 31
  ▪ Analyze the example experiment .................................. 31
  ▪ View clusters in the Allelic Discrimination Plot ................. 31
  ▪ Confirm setup accuracy using Plate Layout ..................... 34
  ▪ Assess amplification results using the Amplification Plot .......... 37
  ▪ Identify well problems using the Well Table ................... 40
  ▪ Confirm accurate dye signal using the Multicomponent Plot .... 43
  ▪ Determine signal accuracy using the Raw Data Plot .............. 46
  ▪ Review the flags in the QC Summary .............................. 47
  ▪ For more information ............................................... 49

Section 5.2 Adjust parameters for re-analysis of your own experiments .... 51
  ▪ Adjust analysis settings ............................................. 51
  ▪ For more information ............................................... 55
Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.
2. Click Analyze. The software analyzes the data using the default analysis settings.
   Note: You can also access the experiment to analyze from the Home screen.

View clusters in the Allelic Discrimination Plot

The Allelic Discrimination Plot contrasts the normalized reporter dye fluorescence (Rn) for the allele-specific probes of the SNP assay.

View the allelic discrimination plot to identify:
- Clusters for the three possible genotypes (Allele 1 homozygous, Allele 2 homozygous, and Allele 1/2 heterozygous).
- A cluster for the no template controls.

To view and assess the allelic discrimination plot

1. From the Experiment menu pane, select Analysis ▶ Allelic Discrimination Plot.
2. Click the Plate Layout tab, then click any empty well to select it.
   Note: In the Allelic Discrimination Plot, the software highlights all wells that are selected in the Plate Layout tab. If the plot displays a single color for all wells, then all wells in the plate layout are selected.
3. In the allelic discrimination plot, select SNP Assay 1 from the SNP Assay menu, then enable Autocaller.

The Allelic Discrimination Plot displays allele symbols for each sample evaluated for the selected SNP. The samples are grouped on the plot as follows:

<table>
<thead>
<tr>
<th>Genotype</th>
<th>Symbol</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Homozygous for Allele 1 of the selected SNP assay</td>
<td>● (red)</td>
<td>X-axis of the plot</td>
</tr>
<tr>
<td>Homozygous for Allele 2 of the selected SNP assay</td>
<td>● (blue)</td>
<td>Y-axis of the plot</td>
</tr>
<tr>
<td>Heterozygous for both alleles of the selected SNP assay (Allele 1 and Allele 2)</td>
<td>● (green)</td>
<td>Midway between the homozygote clusters</td>
</tr>
<tr>
<td>No Template Control</td>
<td>■ (black)</td>
<td>Bottom-left corner of the plot</td>
</tr>
<tr>
<td>Undetermined</td>
<td>✷ (black)</td>
<td>Anywhere on plot</td>
</tr>
</tbody>
</table>

Note: If the Autocaller is not enabled, the Allelic Discrimination Plot displays a crossmark (X – Undetermined) for each sample.
4. Review each cluster in the plot:
   
a. Click and drag a box around the cluster to select the associated wells in the plate layout and well table.

b. Confirm that the expected wells are selected in the well table. For example, if you select the cluster at the bottom-left corner of the plot, only the no template controls should be selected. The presence of an unknown among the no template controls may indicate that the sample failed to amplify.

c. Repeat steps a and b for all other clusters in the plot.

d. The table below describes the elements of the Allelic Discrimination Plot.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNP Assay drop-down menu</td>
<td>Determines the SNP assay data that the QuantStudio™ 12K Flex Software displays in the plot.</td>
</tr>
<tr>
<td>Plot Type drop-down menu</td>
<td>Determines the type of plot (Cartesian or Polar) that the QuantStudio™ 12K Flex Software uses to display the data.</td>
</tr>
<tr>
<td>Apply Call drop-down menu</td>
<td>When a datapoint is selected, this menu allows you to assign an allele call to the datapoint within the scatterplot.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Contains tools for manipulating the scatterplot:</td>
</tr>
<tr>
<td></td>
<td>- Selection tool.</td>
</tr>
<tr>
<td></td>
<td>- Selection tool.</td>
</tr>
<tr>
<td></td>
<td>- Repositioning tool.</td>
</tr>
<tr>
<td></td>
<td>- Zooms in.</td>
</tr>
<tr>
<td></td>
<td>- Zooms out.</td>
</tr>
<tr>
<td>Legend</td>
<td>Explains the symbols in the scatterplot.</td>
</tr>
<tr>
<td>Options</td>
<td>The Reveal Traces option allows you to trace the clusters throughout the PCR process. This option is not activated for the example experiment. To activate the feature, see “Adjust analysis settings” on page 52.</td>
</tr>
</tbody>
</table>
The Allelic Discrimination plot for the example experiment looks like this:

**Troubleshoot clustering on the Allelic Discrimination Plot**

**Do all controls have the correct genotype?**

In the example experiment and in your own experiments, confirm that data points cluster as expected.

**Clustering in positive controls**

1. From the well table, select the wells containing a positive control to highlight the corresponding data points (symbols) in the Allelic Discrimination Plot.

2. Check that the data points for the positive controls cluster along the expected axis of the plot. For example, if you select the Positive Control Allele 1/Allele 1, then the controls should cluster along the X-axis.

3. Repeat steps 1 and 2 for the wells containing the other positive controls.

**Failed amplification in the unknown samples**

1. Select the data points of the cluster in the lower left corner of the Allelic Discrimination Plot to select the corresponding wells in the well table.

2. Check that the selected wells in the well table are the no template controls, and not unknown samples.
Samples clustered with the no template controls

Samples that clustered with the no template controls may:
  - Contain no DNA
  - Contain PCR inhibitors
  - Be homozygous for a sequence deletion

Confirm the results of these samples by retesting them.

**Are outliers present?**

If the Allelic Discrimination Plot contains clusters other than the three representative genotype clusters (heterozygous, homozygous allele 1, and homozygous allele 2), then those can be classified as outliers.

Confirm the results of the associated samples by retesting them.

**Note:** The results displays are synchronized. For example, selecting a well in the plate layout selects the corresponding data in the well table and Allelic Discrimination Plot.

---

**Confirm setup accuracy using Plate Layout**

Review the experiment results in the Plate Layout. The plate layout displays the assay-specific setup and analysis properties for the experiment in a well format corresponding to the type of reaction plate used for the run.

### Example experiment plate layout values

For the example experiment, confirm that the QuantStudio™ 12K Flex Software called:
  - 24 samples as Allele 1 homozygous (●)
  - 38 samples as Allele 2 homozygous (●)
  - 14 samples as heterozygous (●)
  - 0 samples as undetermined (X)

Confirm that no wells of the reaction plate triggered QC flags (▲). The example experiment does not display any flags.

### View the layout

1. Click the icon beside the Allelic Discrimination Plot to maximize the plate layout.
2. Click **Show in Wells**, then select or deselect a parameter that you want the wells to display. Repeat this step until the plate layout contains all of the desired parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Name</td>
<td>The name of the sample applied to the well.</td>
</tr>
</tbody>
</table>
### Section 5.1 Review Results

Confirm setup accuracy using Plate Layout

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>The task assigned to the well:</td>
</tr>
<tr>
<td></td>
<td>U  – Unknown</td>
</tr>
<tr>
<td></td>
<td>N  – No Template Control</td>
</tr>
<tr>
<td></td>
<td>1  – Positive Control - Allele 1</td>
</tr>
<tr>
<td></td>
<td>2  – Positive Control - Allele 2</td>
</tr>
<tr>
<td></td>
<td>2  – Positive Control - Allele 1/2</td>
</tr>
<tr>
<td>SNP Assay Name</td>
<td>The name of the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Assay ID</td>
<td>The Assay ID number of the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Allele 1 / Allele 2</td>
<td>The name of the associated allele for the SNP evaluated by the well</td>
</tr>
<tr>
<td>Allele 1 Dyes / Allele 2 Dyes</td>
<td>The name of the reporter and quencher dyes of the associated allele for the SNP evaluated by the well</td>
</tr>
<tr>
<td>SNP Assay Color</td>
<td>The color of the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Sample Color / Task Color</td>
<td>The color of the sample or task applied to the well.</td>
</tr>
<tr>
<td>Genotype Call</td>
<td>The allele call assigned to the sample:</td>
</tr>
<tr>
<td></td>
<td>● Homozygous 1/1</td>
</tr>
<tr>
<td></td>
<td>● Homozygous 2/2</td>
</tr>
<tr>
<td></td>
<td>● Heterozygous 1/2</td>
</tr>
<tr>
<td></td>
<td>■ No Template Control</td>
</tr>
<tr>
<td></td>
<td>X Undetermined</td>
</tr>
<tr>
<td>Flag</td>
<td>The number of QC flags the well triggered as listed in the ▲ symbol.</td>
</tr>
</tbody>
</table>
The following figure shows the plate layout of the example Genotyping experiment.

Tips for troubleshooting plate setup in your own experiment

You can adjust your view of the plate layout:

- Note the location of any samples that trigger QC flags. Understanding the position of errors can aid in diagnosing any failures that may occur.
- You can select the entire reaction plate, areas of the reaction plate, or specific wells:
  - Click the upper left corner of the reaction plate to select all 96 wells.
  - Left-click the mouse and drag across the area to select it.
  - Select Sample, SNP Assay, or Task from the Select Wells menu in the Plate Layout tab to select wells of a specific type using the well-selection criteria.
- Use the (Zoom In), (Zoom Out), and (Fit Plate) buttons to magnify or compress the view of the wells shown.
- Use the arrow tabs to expand the plate layout to cover the entire screen.
Assess amplification results using the Amplification Plot

**IMPORTANT!** Amplification plots are not used to make SNP calls. Examine the plots to help with troubleshooting and quality control.

If you collected real-time data for your experiment, review the amplification data to further understand the flags triggered by the experiment data.

**About amplification plots**

The Amplification Plot screen displays amplification of all samples in the selected wells. Use the amplification plots to confirm the results of the experiment:

- **ΔRn vs. Cycle** – ΔRn is the difference in normalized fluorescence signal generated by the reporter between the pre-PCR read and the post-PCR read. This plot displays ΔRn as a function of cycle number. You can use this plot to identify and examine irregular amplification and to view threshold and baseline values for the run.

  **Note:** Viewing the ΔRn vs. Cycle plot is discussed in this booklet as an example of how to view the plot.

- **Rn vs. Cycle** – Rn is the fluorescence signal from the reporter dye normalized to the fluorescence signal from the passive reference. This plot displays Rn as a function of cycle number. You can use this plot to identify and examine irregular amplification.

- **C_T vs. Well** – C_T is the PCR cycle number at which the fluorescence meets the threshold in the amplification plot. This plot displays C_T as a function of well position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.
View the \( \Delta R_n \) vs. Cycle plot

1. From the Experiment Menu pane, select **Analysis > Amplification Plot**.
   
   **Note**: If no data are displayed, click **Analyze**.

2. Select the plot type and format:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>( \Delta R_n ) vs. Cycle</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Target</td>
</tr>
<tr>
<td></td>
<td>Check (default)</td>
</tr>
</tbody>
</table>

   (This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.)

3. View the baseline values:
   
   a. From the Graph Type drop-down menu, select **Linear**.
b. Select Baseline to show the start cycle and end cycle.

4. View the threshold values:
   a. From the Graph Type drop-down menu, select Log.
   b. From the Target drop-down menu, select SNP Assay 1-Allele 2.
   c. Select the Threshold check box to show the threshold.
**Identify well problems using the Well Table**

Review the details of the experiment results in the Well Table and identify any flagged wells. The Well Table displays the assay-specific setup and analysis properties for the experiment in a tabular format.

**Example experiment values and flags**

For the example experiment, look for wells that triggered QC flags (▲). The example experiment has no flags.

**View the well table**

1. Select the **Well Table** tab.
2. Click the **Flag** column header to sort the data so that the wells that triggered flags appear at the top of the table.
3. Confirm the integrity of the controls:
   a. From the Group By menu, select **Task** to organize the table rows by their function on the reaction plate.
   b. Confirm that each of the controls do not display flags (▲).
   c. Click the □ icon to collapse the negative and positive controls.
The figure below shows the well table of the example Genotyping experiment.

The following table gives the names and description of the columns in the well table:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>The position of the well on the reaction plate.</td>
</tr>
<tr>
<td>Omit</td>
<td>A check mark indicates that the well has been removed from the analysis.</td>
</tr>
<tr>
<td>Flag</td>
<td>A (▲) indicates that the well triggered the number of flags listed inside the symbol.</td>
</tr>
<tr>
<td>Sample Name</td>
<td>The name of the sample.</td>
</tr>
<tr>
<td>SNP Assay Name</td>
<td>The name of the SNP assay evaluated by the well.</td>
</tr>
<tr>
<td>Assay ID</td>
<td>The Assay ID number of the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Task</td>
<td>The task assigned to the well [Unknown, No Template Control, or Positive Control].</td>
</tr>
<tr>
<td>Allele 1 / 2</td>
<td>The name of the associated allele for the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Allele 1 / 2 Dyes</td>
<td>The name of the reporter and quencher dyes of the associated allele for the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Allele 1 / 2 Rn</td>
<td>Normalized signal (Rn) of the reporter dye of the associated allele for the SNP evaluated by the well.</td>
</tr>
</tbody>
</table>
Chapter 5  Review Results and Adjust Experiment Parameters
Identify well problems using the Well Table

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pass Ref</td>
<td>The signal of the passive reference dye for the well.</td>
</tr>
<tr>
<td>Call</td>
<td>The allele call assigned to the sample, where possible calls are:</td>
</tr>
<tr>
<td></td>
<td>• ● Homozygous 1/1 - Homozygous for allele 1</td>
</tr>
<tr>
<td></td>
<td>• ● Homozygous 2/2 - Homozygous for allele 2</td>
</tr>
<tr>
<td></td>
<td>• ● Heterozygous 1/2 - Heterozygous</td>
</tr>
<tr>
<td></td>
<td>• ■ No Template Control</td>
</tr>
<tr>
<td></td>
<td>• ✗ Undetermined</td>
</tr>
<tr>
<td>Quality (%)</td>
<td>The quality value calculated for the genotype call.</td>
</tr>
<tr>
<td>Method</td>
<td>The method used to assign the call to the sample [Auto if assigned by the QuantStudio™ 12K Flex Software, or Manual if applied by a user].</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments entered for the associated sample well.</td>
</tr>
<tr>
<td>Allele 1 / 2 C_T</td>
<td>Threshold cycle [C_T] of the sample for the associated allele for the SNP evaluated by the well.</td>
</tr>
</tbody>
</table>

Identify quality control (QC) problems

The Well Table displays columns for QC flags that are triggered by the experimental data. If the experiment data does not trigger a QC flag, then the QuantStudio™ 12K Flex Software does not display a corresponding column for the flag.

A (▲) in one of the following columns indicates that the associated well triggered the flag.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BADROX</td>
<td>The well produced a passive reference signal greater than the limit defined in the analysis settings.</td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>The well produced a level of fluorescence greater than the QuantStudio™ 12K Flex System can measure.</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>The well did not produce a detectable level of fluorescence.</td>
</tr>
<tr>
<td>CLUSTER#</td>
<td>For the SNP evaluated by the well, the number of clusters generated from the experiment data is greater than the limit defined in the analysis settings.</td>
</tr>
<tr>
<td>PCFAIL</td>
<td>The positive control did not produce an R_n for the associated allele greater than the limit defined in the analysis settings indicating that the control may have failed to amplify.</td>
</tr>
<tr>
<td>SMCLUSTER</td>
<td>The number of data points in the associated cluster is less than the limit defined in the analysis settings.</td>
</tr>
<tr>
<td>AMPNC</td>
<td>The negative control has produced an R_n greater than the limit defined in the analysis settings indicating possible amplification.</td>
</tr>
<tr>
<td>NOAMP</td>
<td>The well did not produce an R_n for either allele that is greater than the limit defined in the analysis settings indicating that the well may have failed to amplify.</td>
</tr>
<tr>
<td>NOISE</td>
<td>The background fluorescence [noise] produced by the well is greater than the other wells on the reaction plate by a factor greater than the limit defined in the analysis settings.</td>
</tr>
</tbody>
</table>
Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

## Tips for analyzing your own experiments

### Confirm the integrity of positive controls

When you analyze the example experiment or your own experiment, if you are using positive controls, confirm the integrity of the positive controls:

1. From the Group By menu, select **Task** to organize the table rows by their function on the reaction plate.

2. Confirm that the positive controls do not display flags (▲) and that their normalized reporter dye fluorescence ($R_n$) is appropriate for the genotype (for example, if evaluating the Positive Control Allele 1/Allele 1, you would expect to see significant increase in $R_n$ for the Allele 1 probe and very little for the Allele 2 probe).

### Adjust the Well Table

- Review the data for the Unknown samples. For each row that displays (▲) in the Flag column, note the data and the flag(s) triggered by the associated well.

- Select areas of the table or wells of a specified type by:
  - Left-clicking the mouse and dragging across the area you want to select an area of the table.
  - Selecting **Sample**, **SNP Assay**, or **Task** from the Select Wells menu in the Well Table tab to select wells of a specific type using the well-selection tool.

- Group the rows of the plate layout by selecting an option from the Group By menu. You can then collapse or expand the lists either by clicking the +/- icon next to individual lists, or by clicking **Collapse All** or **Expand All**.

- Omit a well from the analysis by selecting the **Omit** check box for that well. To include the well in the analysis, deselect the **Omit** check box.

**Note:** You must reanalyze the experiment each time you omit or include a well.

### Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

### Flag Description

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPIKE</td>
<td>The amplification plot for the well contains one or more data points inconsistent with the other points in the plot.</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>The software cannot identify the exponential region of the amplification plot for the well.</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>The software cannot calculate the best fit baseline for the data for the well.</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>The software cannot calculate a threshold for the associated well.</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>The software cannot calculate a threshold cycle ($C_T$) for the associated well.</td>
</tr>
<tr>
<td>AMPSCORE</td>
<td>Amplification in the linear region is below a certain threshold, corresponding to the score set in the analysis settings</td>
</tr>
</tbody>
</table>
In the example experiment, you review the Multicomponent Plot screen for:

- ROX™ dye (passive reference)
- FAM™ dye (reporter)
- VIC® dye (reporter)
- Spikes, dips, and/or sudden changes
- Amplification in the no template control wells

View the Multicomponent Plot

1. From the Experiment Menu pane, select Analysis ➤ Multicomponent Plot.  
   **Note:** If no data are displayed, click Analyze.

2. Display the unknown wells in the plate layout to display the corresponding data in the Multicomponent Plot screen:
   a. Click the Plate Layout tab.
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.
      **Note:** If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click Show a legend for the plot (default).
   **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal remains constant throughout the PCR process; a constant ROX dye signal indicates typical data.
6. Check the FAM dye signal. In the example experiment, the FAM dye signal increases throughout the PCR process; increase in FAM dye signal indicates normal amplification.

![Multicomponent Plot](image)

7. Select the no template control wells one at a time and check for amplification. Wells with the no template control should not show amplification. In the example experiment the wells with no template controls do not show any amplification.

**Tips for confirming dye accuracy in your own experiment**

When you analyze your own Genotyping experiment, look for:

- **Passive Reference** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.
- **Reporter Dye** – The reporter dye fluorescence level should display a flat region corresponding to the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.
- **Irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.
- **No Template Control wells** – There should not be any amplification in the no template control wells.
Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter for the selected wells during each cycle of the real-time PCR.

**Purpose**

In the Genotyping example experiment, you review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

**View the Raw Data Plot**

1. From the Experiment Menu pane, select Analysis ➤ Raw Data Plot.
   - **Note:** If no data are displayed, click Analyze.

2. Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.

3. Click Show a legend for the plot (default). The legend displays the color code for each row of the reaction plate (see the legend in the Raw Data Plot shown below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 42. In the example experiment, there is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.
The filters are:

Tips for determining signal accuracy in your own experiment

When you analyze your own Genotyping experiment, look for the following in each filter:

- Characteristic signal growth
- No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags, including the flag frequency and location for the open experiment.

For Genotyping experiments, flag appearance is triggered by experiment data or the assay. If a flag has been triggered by the assay, the Plate Layout does not display the ▲ icon. The flag details appear in the QC Summary.

In the example experiment, there are no flags.
Chapter 5  Review Results and Adjust Experiment Parameters

Review the flags in the QC Summary

1. From the Experiment Menu pane, select **Analysis > QC Summary**.
   **Note:** If no data are displayed, click **Analyze**.

2. Review the Flags Summary.
   **Note:** A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment. If the frequency is >0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed information about the flag.

4. *(Optional)* For those flags with frequency >0, click each flag with a frequency >0 to display detailed information about the flag.
Possible flags

The flags listed below may be triggered by the experiment data or the assay.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pre-processing flag</strong></td>
<td></td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td><strong>Primary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>(C_T) algorithm failed</td>
</tr>
<tr>
<td>AMPSCORE</td>
<td>Amplification in the linear region is below a certain threshold, corresponding to the score set in the analysis settings</td>
</tr>
</tbody>
</table>

**Secondary analysis flags**

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMPNC</td>
<td>Amplification in negative control</td>
</tr>
<tr>
<td>PCFAIL</td>
<td>Positive Control failed</td>
</tr>
<tr>
<td>SMCLUSTER#</td>
<td>Small number of samples in clusters</td>
</tr>
</tbody>
</table>

**Note:** When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

---

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing data</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
</tbody>
</table>
Chapter 5  Review Results and Adjust Experiment Parameters
For more information
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the call, threshold cycle (C_T), flags, and advanced options.

You can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.
2. Click Analysis › Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:
- Call Settings
- C_T Settings
- Flag Settings
- Advanced Settings

The Analysis Settings dialog box for a Genotyping experiment looks like this:
3. View and, if necessary, change the analysis (see “Adjust analysis settings” below).

   **Note:** You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, *Getting Started with QuantStudio™ 12K Flex System Experiments*.

4. Click **Apply Analysis Settings** to apply the current analysis settings.

   **Note:** You can go back to the default analysis settings, by clicking **Revert to Default Analysis Settings**.

### Adjust analysis settings

#### Call Settings

Use the Call Settings tab to:

- Change the default data analysis settings. You can select from:
  - Analyze data from Post-PCR Read only - Select if you do not want to use data from the pre-PCR read to determine genotype calls.
  - Analyze data from Pre-PCR Read and Post-PCR Read - If you included the pre-PCR read in the run, select if you want to use data from the pre-PCR read to determine genotype calls.
  - Analyze Real-Time Rn Data - If you included amplification in the run, select if you want to use the normalized reporter (Rn) data from the cycling stage to determine genotype calls.
  - Analyze data from Rn - Avg (Rna to Rnb) - If you included amplification in the run, select if you want to use the subtracted median of the normalized reporter (Rn) data from the cycling stage to determine genotype calls, where Rna to Rnb refers to all the cycles from the Start Cycle Number to the End Cycle Number. The average subtraction provides improved data accuracy.

   **Note:** To activate the Reveal Traces feature on the Allelic Discrimination Plot screen, select either **Analyze Real-Time Rn Data** or **Analyze data from Rn - Avg (Rna - Rnb)**.

- Edit the default call settings. Click **Edit Default Settings**, then specify the default settings:
  - **Autocaller Enabled** - Select for the software to make genotype calls using the autocaller algorithm.
  - **Keep Manual Calls from Previous Analysis** - If the autocaller is enabled, select to maintain manual calls after reanalysis
  - **Quality Value** - Enter a value to use to make genotype calls. If the confidence value is less than the call setting, the call is undetermined.

- Use custom call settings for a SNP assay.
  - Select one or more SNP assays in the table, then deselect the **Default Settings** checkbox.
  - **Define the custom call settings**.

#### CT Settings

- **Data Step Selection**
  
  Use this feature to select one stage/step combination for CT analysis when there is more than one data collection point in the run method.

- **Algorithm Settings**
You can select the algorithm that determines the C_T values. There are two algorithms: Baseline Threshold (the default) and Relative Threshold.

The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for quantification.

The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no dependence on targets, thereby reducing variability. It is not necessary to set either a baseline or a threshold when you use the Relative Threshold algorithm, so any settings for baseline or threshold will not affect the analysis.

- **Default C_T Settings**
  Use the default C_T settings feature to calculate C_T for the alleles that do not have custom settings. To edit the default settings, click **Edit Default Settings**.

- **C_T Settings for Target**
  When you manually set the threshold and baseline, Life Technologies recommends:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Recommendation</th>
</tr>
</thead>
</table>
  | Threshold | Enter a value for the threshold so that the threshold is:  
  |          | • Above the background.  
  |          | • Below the plateau and linear regions of the amplification curve.  
  |          | • Within the exponential phase of the amplification curve.  
  | Baseline | Select the Start Cycle and End Cycle values so that the baseline ends before significant fluorescent signal is detected.  

**Note:** This setting is applicable only to the Baseline Threshold algorithm.

**Note:** Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.

**Flag Settings**

Use the Flag Settings tab to:

- Adjust the sensitivity so that more wells or fewer wells are flagged.
- Change the flags that are applied by the QuantStudio™ 12K Flex Software.

To adjust the flag settings:

1. In the Use column, select the check boxes for flags to apply during analysis.
2. *(Optional)* If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.

**Note:** If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.
3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.

**Note:** After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments using the Standard Deviation calculations may change the result of C\textsubscript{T} SD. For some flags, analysis results calculated before the well is rejected are maintained.

4. Click **Apply Analysis Settings** in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.

The Flag Settings tab looks like this:

![Flag Settings Tab](image)

**Advanced Settings**

Use the Advanced Settings tab to change baseline settings well-by-well.

**Note:** The baseline and threshold values do not affect the analysis using the Relative Threshold setting.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.
2. Deselect the **Use C\textsubscript{T} Settings Defined for Target** check box.
3. Define the custom baseline settings:
   - For automatic baseline calculations, select the **Automatic Baseline** check box.
   - To define the baseline, deselect the **Automatic Baseline** check box, then enter the baseline start cycle and baseline end cycle.

### For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification efficiency</td>
<td><em>Amplification Efficiency of TaqMan® Gene Expression Assays</em></td>
<td>127AP05-03</td>
</tr>
<tr>
<td></td>
<td><em>Application Note</em></td>
<td></td>
</tr>
</tbody>
</table>

---

For more information on... Refer to... Part number

Amplification efficiency Amplification Efficiency of TaqMan® Gene Expression Assays Application Note 127AP05-03
Chapter 5  Review Results and Adjust Experiment Parameters

For more information
Export Analysis Results

1. Open the Genotyping example experiment file that you analyzed in Chapter 5.
2. In the Experiment Menu, click Export.
   **Note:** To export data automatically after analysis, select the Auto Export check box during experiment setup or before running the experiment. Auto export is unchecked for the example experiment.
3. Select QuantStudio™ 12K Flex format.
4. Complete the Export dialog box as shown below:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export/ Select Content</td>
<td>Results</td>
</tr>
<tr>
<td>Export Data To</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>96-Well Genotyping Example_QuantStudio_export</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td>&lt;drive&gt;\Applied Biosystems\QuantStudio 12K Flex Software\experiments</td>
</tr>
</tbody>
</table>
Your Export screen should look like this:

Your exported file when opened in Notepad should look like this:
Numerics
5′ Nuclease Assay 6

A
adjusting analysis settings 50
adjusting parameters, re-analyzing own experiments 49
Advanced Settings tab 52
Algorithm Settings
  Baseline Threshold 51
  Relative Threshold 51
allele-specific probes 8, 31
allelic discrimination plot
  troubleshooting 33
  viewing and assessing 31
amplification plot
  amplification efficiency 17, 53
  assessing amplification results 36
  reviewing baseline values 38
  reviewing threshold values 38
  viewing 24
AMPNC flag 42
AMPSCORE flag 42
analysis settings
  Advanced Settings 49
  Call Settings 49
  C_T Settings 49
  Flag Settings 49
Analyze
  Allelic Discrimination Plot 31
  Amplification Plot 36
  Multicomponent Plot 43
  QC Summary 46
  Raw Data Plot 45
Auto Export 55
Autocaller 31
Automatic Baseline, advanced settings 53
Automatic Threshold 51

B
BADROX flag 42, 48
baseline settings
  end cycle 53
  start cycle 53
BLFAIL flag 42

C
Call Settings tab 50
CLUSTER# flag 42
clusters
  troubleshooting 33
  viewing 8, 31
cocktail mix 20
C_T settings
  algorithm settings 50
  data step, selecting 50
  default 51
  target 51
C_T Settings tab 50, 42

D
data collection, about 5
designing experiment
  assigning markers and samples 14
  defining experiment properties 11
  defining SNPs and samples 12
  setting up run method 16
DNAse-free water 22
dye accuracy
  irregularities in the signal 45
  no template control wells 45
  passive reference 44
  reporter dye 6, 44

E
e.example experiment 8
experiment properties, defining 11
EXPFAIL flag 42

F
Flag Settings tab 51
flags, QC
  AMPNC 42
  AMPSCORE 42
  BADROX 42
  BLFAIL 42
  CLUSTER# 42
  CTFAIL 42
  EXPFAIL 42
  NOAMP 42
  NOISE 42
  NOISIGNAL 42
Index

OFFSCALE 42
PCFAIL 42
SMCLUSTER 42
SPIKE 42
THOLDFAIL 42
fluorescence signal 37

G
gDNA
dried 21
wet 22
genotype
  heterozygous 31
  homozygous 31
genotype calls 50

I
irregular amplification 37

M
markers and samples, assigning 14
minor groove 6
multicomponent plot
  confirming dye accuracy 43
  tips for analyzing own experiment 44
  viewing 43

N
NOAMP flag 42, 48
NOISE flag 42
non-specific fluorescence, minimizing 7
normalized reporter (Rn) data 50
normalized reporter dye fluorescence 31
NOSIGNAL flag 42, 48
Allele 1 / Allele 2 35
Allele 1 Dyes / Allele 2 Dyes 35
Assay ID 35
confirming setup accuracy 34
Flag 35
Genotype Call 35
Sample Color / Task Color 35
Sample Name 34
SNP Assay Color 35
SNP Assay Name 35
Task 35
plates, reading and analyzing 7
Post-PCR read, analyzing data 50
preparing reactions
  reaction mix 20
  reaction plate 20
  required materials 19
  sample dilutions 19
  tips for your own experiments 22
Pre-PCR read, analyzing data 50
Pre-processing flag
  OFFSCALE 48
Primary analysis flags
  AMPSCORE 48
  BLFAIL 48
  CTFAIL 48
  EXPFAIL 48
  NOISE 48
  THOLDFAIL 48

O
OFFSCALE flag 42
oligonucleotide probe 6
optical filter 45
outliers 34

P
PCFAIL flag 42
plate layout parameters 34
raw data plot
  confirming signal accuracy 45
  tips for analyzing own experiment 46
  viewing 45
reaction mix
  components 19
  preparing reactions 20
reaction plate
  dried gDNA 21
  preparing reactions 20
reviewing QC summary 46
troubleshooting 36
well table 40

Q
QC flags
  reviewing QC summary 46
wet gDNA  22
reactions, assembling materials for  19
real-time data
   analyzing data  50
   running experiment  23
reporter dye  6
reporter signal  6
required materials, preparing reactions  19
reveal traces, call settings  50
review results  31
Rna to Rnb  50
run
   monitoring  23
   starting  23
run method
   setting up  16
   thermal profile  16
   viewing  26
Run screen
   Amplification Plot  24
   Run Method  26
   Temperature Plot  25
   View Run Data  26
S
sample dilutions, preparing reactions  19
samples, defining  12
scatterplot  32
Secondary analysis flags
   AMPNC  48
   PCFAIL  48
   SMCLUSTER#  48
signal accuracy  45
single nucleotide polymorphism. See SNP  5
SMCLUSTER flag  42
SNP  5
SNPs and samples, defining  12
SPIKE flag  42, 48
spikes  45
T
TaqMan® MGB probes  6
TaqMan® SNP Genotyping assays  6
temperature plot, viewing  25
THOLDFAIL flag  42
touchscreen, running the experiment from

Experiment View  27
Plot View  28
Time View  27
troubleshooting, plate setup  36
W
well table
   identifying well problems  40
tips for analyzing own experiments  42
   viewing  40
well table columns  40
   Allele 1 / 2  41
   Allele 1 / 2 CT  41
   Allele 1 / 2 Dyes  41
   Allele 1 / 2 Rn  41
   Assay ID  41
   Call  41
   Comments  41
   Flag  41
   Method  41
   Omit  41
   Pass Ref  41
   Quality(%)  41
   Sample Name  41
   SNP Assay Name  41
   Task  41
   Well  41
Contents

■ CHAPTER 1  About Presence/Absence Experiments ............... 5
  About data collection .......................................................... 5
  End-point PCR Data .............................................................. 5
  Real-Time PCR Data ............................................................. 5
  Setting up PCR reactions ......................................................... 6
  IPC setup .............................................................................. 6
  No IPC, singleplex setup ......................................................... 6
  About the instrument run ........................................................ 6
  About the analysis ................................................................. 7
  About the example experiment ............................................... 7

■ CHAPTER 2  Design the Experiment ................................. 9
  Define the experiment properties .............................................. 9
  Define targets and samples ...................................................... 10
  Assign targets and samples ..................................................... 11
  Set up the run method ............................................................ 12
  For more information ............................................................ 13

■ CHAPTER 3  Prepare the Reactions ................................. 15
  Assemble required materials ..................................................... 15
  Prepare the reaction mix (“cocktail mix”) .................................. 15
  Prepare the reaction plate ......................................................... 17
  For more information ............................................................ 18

■ CHAPTER 4  Run the Experiment ................................. 19
  Start the run .......................................................................... 19
  Monitor the run ...................................................................... 19
    From the Instrument Console of the QuantStudio™ 12K Flex Software 19
    From the QuantStudio™ 12K Flex Instrument touchscreen ........... 21

■ CHAPTER 5  Review Results and Adjust Experiment Parameters . . . 23
  Section 5.1 Review Results ..................................................... 25
    Analyze the example experiment ............................................ 25
    View the Presence/Absence Plot .......................................... 25
      Purpose ............................................................................ 25
      To view and assess the Presence/Absence Plot ....................... 25
      Tips for viewing Presence/Absence plots in your own experiments 27
    Assess amplification results using the Amplification Plot .......... 27
      Amplification plots available for viewing ............................... 27
      Purpose ............................................................................ 28
Contents

View the Amplification Plot .................................................. 28
Tips for viewing amplification plots in your own experiments ................. 30
View the Well Table ............................................................ 32
Purpose ................................................................. 32
To view the Well Table ...................................................... 32
Tips for analyzing your own experiments .................................... 35
Confirm accurate dye signal using the Multicomponent Plot .................. 35
Purpose ................................................................. 35
View the Multicomponent Plot ........................................... 35
Tips for confirming dye accuracy in your own experiment ................... 38
Determine signal accuracy using the Raw Data Plot ......................... 38
Purpose ................................................................. 38
View the Raw Data Plot .................................................... 38
Tips for determining signal accuracy in your own experiments ............ 40
Review the flags in the QC Summary ...................................... 40
View the QC Summary .................................................... 40
Possible flags .............................................................. 41
For more information ....................................................... 42

Section 5.2 Adjust parameters for re-analysis of your own experiments ....... 43
Adjust analysis settings ..................................................... 43
View the analysis settings .................................................. 43
Adjust analysis settings .................................................... 44
For more information ....................................................... 47

CHAPTER 6 Export Analysis Results ......................................... 49

Index ................................................................. 51
About Presence/Absence Experiments

This chapter covers:
- About data collection ................................................................. 5
- Setting up PCR reactions ............................................................. 6
- About the instrument run ............................................................ 6
- About the analysis ................................................................. 7
- About the example experiment ................................................. 7

IMPORTANT! First-time users of the QuantStudio™ 12K Flex System, please read Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments and Booklet 7, QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments - Appendixes of this binder thoroughly. The booklet provides information and general instructions that are applicable to all the experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ 12K Flex Software by pressing F1, clicking in the toolbar, or selecting Help QuantStudio™ 12K Flex Software Help.

About data collection

Presence/Absence experiments are end-point experiments that are performed to detect a target nucleic acid sequence in a sample.

You can collect the experiment data at the end of the run or continuously in real time.

End-point PCR Data

The QuantStudio™ 12K Flex System collects data at an end-point, that is after the process has completed.

The data collected is the normalized intensity of the reporter dye, or Rn.

Note: Some end-point experiments also include pre-PCR (data collected before the amplification process) datapoints. If so, the system calculates the delta Rn (ΔRn) value per the following formula:

ΔRn = Rn (post-PCR read) – Rn (pre-PCR read), where Rn = normalized readings.

Real-Time PCR Data

The QuantStudio™ 12K Flex System provides the option of collecting real-time data, during the PCR process.

Note: Real-time data collection is used only for troubleshooting, and not for Presence/Absence analysis.
Setting up PCR reactions

With Presence/Absence experiments, you prepare PCR reactions that contain primers and probes to amplify the target and a reagent to detect amplification of the target. You can set up the PCR reactions for the Presence/Absence experiments two different ways.

**Note:** The example experiment uses IPC setup for setting up the PCR reactions.

### IPC setup

Use an internal positive control (IPC) to monitor the PCR progress and ensure that a negative result is not caused by failed PCR in the sample. PCR reactions contain two primer/probe sets: One to detect the unknown target (unknown target primer set and TaqMan® probe to detect the unknown target) and one to detect the IPC (IPC primer set and a VIC dye-labeled TaqMan® probe to detect the IPC template). With this setup, there are three well types:

- **Unknown-IPC wells** contain sample template and IPC template; the presence of the target is not known.
- **Negative control-IPC wells** contain IPC template and water or buffer instead of sample template in the PCR reaction. Only the IPC template should amplify in negative control-IPC wells because the reaction contains no sample template. Also called IPC+.
- **Negative control-blocked IPC wells** do not contain sample template in the PCR reaction. Amplification is prevented by a blocking agent. As a result, no amplification should occur in negative control-blocked IPC wells because the reaction contains no sample template and amplification of the IPC is blocked. Negative control-blocked IPC is called no amplification control (NAC).

If the run method includes amplification, real-time data are plotted in an amplification plot.

### No IPC, singleplex setup

Omit the IPC from your Presence/Absence experiment. PCR reactions contain one primer/probe set. PCR reactions do not contain the IPC. With this setup, there are two well types:

- **Unknown wells** – Wells contain sample template; the presence of the target is not known.
- **Negative controls** – Wells contain water or buffer instead of sample template.

### About the instrument run

With Presence/Absence experiments, the instrument runs can include:

- **Pre-PCR read** – Perform the pre-PCR read on the QuantStudio™ 12K Flex Software before PCR amplification to collect baseline fluorescence data.
- **Amplification** – Perform amplification on the QuantStudio™ 12K Flex Software to collect fluorescence data during PCR amplification. If you do not include amplification in the run method, perform amplification on another instrument.
- **Post-PCR read** – To determine the results for Presence/Absence experiments, perform the post-PCR read on the instrument after PCR amplification to collect endpoint fluorescence data.
Chapter 1  About Presence/Absence Experiments

About the analysis

Data from the instrument run are used to determine Presence/Absence calls. Results are plotted in a Presence/Absence plot. If the experiment includes amplification, results are plotted in an amplification plot.

- **Pre-PCR read** – If included, the data collected from the pre-PCR read can be used to normalize data collected from the post-PCR read.
- **Amplification** – If included, the data collected from the amplification can be used to troubleshoot.
- **Post-PCR read** – The data collected from the post-PCR read are used to make Presence/Absence calls:
  - **Presence** – The target amplified above the target’s threshold. The target is present in the sample.
  - **Absence** – The target did not amplify above the target’s threshold. The target is absent in the sample.
  - **Unconfirmed** – The data collected is below the target threshold, and the intensity of IPC is below the IPC threshold.

With the IPC setup, the data collected from the post-PCR read are used to make the following calls:

- **IPC Failed** – The IPC target did not amplify in the IPC wells and/or the IPC target amplified in the blocked IPC wells.
- **IPC Succeeded** – The IPC target amplified in the IPC wells and the IPC target did not amplify in the blocked IPC wells.

About the example experiment

To illustrate how to perform Presence/Absence experiments, this guide leads you through the process of designing and performing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with a QuantStudio™ 12K Flex System.

The objective of the Presence/Absence example experiment is to determine if a pathogen is present or absent in each batch of ground beef.

In the Presence/Absence example experiment:

- DNA is extracted from samples using the PrepMan® Ultra Sample Preparation Reagent (PN 4318930). The DNA is extracted from each of the four samples of ground beef or from the bacteria found in the ground beef.
- The target is a pathogen.
- The experiment is designed for duplex PCR, where each reaction contains two primer/probe sets. One set detects the pathogen sequence, TGFB (primer set and FAM™ dye-labeled probe to detect the TGFB sequence). The other primer/probe set detects the IPC primer set and VIC® dye-labeled TaqMan® probe detects the IPC template.
Chapter 1 About Presence/Absence Experiments

About the example experiment
Design the Experiment

This chapter explains how to design the example experiment from the Experiment Setup menu.

This chapter covers:

- Define the experiment properties .................................................. 9
- Define targets and samples ................................................................. 10
- Assign targets and samples ................................................................. 11
- Set up the run method ................................................................. 12
- For more information ................................................................. 13

Note: To automatically export the analyzed data to a specified location, select the Auto Export task from the Export screen, before running the experiment. For more information on Auto Export, refer to Chapter 1 in Booklet 1, *Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments*.

**Define the experiment properties**

Click **Experiment Setup > Experiment Properties** to create a new experiment in the QuantStudio™ 12K Flex Software. Enter:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Name</td>
<td>96-Well Presence Absence Example</td>
</tr>
<tr>
<td>Barcode</td>
<td>Leave field empty</td>
</tr>
<tr>
<td>User Name</td>
<td>Example User</td>
</tr>
<tr>
<td>Comments</td>
<td>Presence/Absence example</td>
</tr>
<tr>
<td>Block</td>
<td>96-Well (0.2mL)</td>
</tr>
<tr>
<td>Experiment Type</td>
<td>Presence/Absence</td>
</tr>
<tr>
<td>Reagents</td>
<td>TaqMan® Reagents</td>
</tr>
<tr>
<td>Ramp speed</td>
<td>Standard</td>
</tr>
</tbody>
</table>

Select all three data-collection check boxes: Pre-PCR, Amplification, and Post-PCR collection methods:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-PCR Read</td>
<td>Checked</td>
</tr>
<tr>
<td>Amplification</td>
<td>Checked</td>
</tr>
<tr>
<td>Post-PCR Read</td>
<td>Checked</td>
</tr>
</tbody>
</table>
Define targets and samples

Click Define to access the Define screen. Enter:

1. Targets

<table>
<thead>
<tr>
<th>Target Name</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>TGFB</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>IPC</td>
<td>VIC</td>
<td>TAMRA</td>
<td></td>
</tr>
</tbody>
</table>

2. Samples

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>(+)</td>
<td></td>
</tr>
<tr>
<td>(-)</td>
<td></td>
</tr>
<tr>
<td>NAC</td>
<td></td>
</tr>
<tr>
<td>NTC</td>
<td></td>
</tr>
</tbody>
</table>

3. Dye to be used as a Passive Reference ROX
Assign targets and samples

Click **Assign** to access the Assign screen. Enter the targets and samples:

<table>
<thead>
<tr>
<th>Target Name</th>
<th>Well Number</th>
<th>Task</th>
<th>Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>TGFB IPC</td>
<td>A1 - A4 (Columns 1 - 4)</td>
<td>Negative</td>
<td>NAC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No IPC</td>
<td></td>
</tr>
<tr>
<td>TGFB IPC</td>
<td>A5 - A8 (Columns 5 - 8)</td>
<td>IPC</td>
<td>NTC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Negative</td>
<td></td>
</tr>
<tr>
<td>TGFB IPC</td>
<td>B1 - B10 (Columns 1 - 10)</td>
<td>Unknown IPC</td>
<td>(+)</td>
</tr>
<tr>
<td>TGFB IPC</td>
<td>C1 - C10 (Columns 1 - 10)</td>
<td>Unknown IPC</td>
<td>(-)</td>
</tr>
</tbody>
</table>
Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- Reaction Volume Per Well: 25 µL
- Thermal Profile

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp Rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Read Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>60 ºC</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Hold Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>10 minutes</td>
</tr>
<tr>
<td>PCR Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>15 seconds</td>
</tr>
<tr>
<td>Number of Cycles: 40 (default)</td>
<td>Step2</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>1 minute</td>
</tr>
<tr>
<td>Enable AutoDelta: Unchecked (default)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Starting Cycle: Disabled when Enable AutoDelta is unchecked</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 2 Design the Experiment

For more information

Your Run Method screen should look like this:

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp Rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post-Read</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>30 seconds</td>
</tr>
</tbody>
</table>

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to</th>
<th>Part number</th>
</tr>
</thead>
</table>
| Consumables                 | Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments  
|                             | Appendix A in Booklet 7, QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments - Appendixes   | 4470050     |
| Data collection             | Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments | 4470050     |
| Amplification efficiency    | Amplification Efficiency of TaqMan® Gene Expression Assays Application Note | 127AP05-03  |
| Using alternative setup     | Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments | 4470050     |
Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Presence/Absence example experiment.

This chapter covers:
- Assemble required materials .......................................................... 15
- Prepare the reaction mix (“cocktail mix”). ........................................ 15
- Prepare the reaction plate ............................................................... 17
- For more information................................................................. 18

Assemble required materials

- Items listed in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments
- Samples - DNA extracted from ground beef (100 ng/µL)
- Example experiment reaction mix components:
  - TaqMan® Universal PCR Master Mix
  - 10× IPC Mix
  - 50× IPC DNA
  - 20× Primer/Probe Mix

Prepare the reaction mix (“cocktail mix”)

For the Presence/Absence example experiment, four cocktail mixes are used; one each for:
- (+)
- (-)
- NTC/IPC+
- NAC/IPC-

The following tables list the universal assay conditions (volume and final concentration) for using the TaqMan® Universal PCR Master Mix for the four cocktail mixes.
### Chapter 3 Prepare the Reactions

#### Prepare the reaction mix ("cocktail mix")

<table>
<thead>
<tr>
<th>Cocktail Mix</th>
<th>Reaction component</th>
<th>Volume for 1 reaction (µL)</th>
<th>Volume for 11 reactions (10 wells + 10% excess) (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cocktail Mix 1 for Sample [+]</td>
<td>TaqMan® Universal PCR Master Mix (2.0X)</td>
<td>12.50</td>
<td>137.50</td>
</tr>
<tr>
<td></td>
<td>10X IPC Mix</td>
<td>2.50</td>
<td>27.5</td>
</tr>
<tr>
<td></td>
<td>50X IPC DNA</td>
<td>0.50</td>
<td>5.5</td>
</tr>
<tr>
<td></td>
<td>20X Primer/ Probe Mix</td>
<td>1.25</td>
<td>13.75</td>
</tr>
<tr>
<td></td>
<td>Water/ Buffer</td>
<td>5.75</td>
<td>63.25</td>
</tr>
<tr>
<td></td>
<td>Diluted unknown 1</td>
<td>2.5</td>
<td>27.5</td>
</tr>
<tr>
<td></td>
<td>Total reaction mix volume</td>
<td>25.0</td>
<td>275</td>
</tr>
<tr>
<td>Cocktail Mix 2 for Sample [-]</td>
<td>TaqMan® Universal PCR Master Mix (2.0X)</td>
<td>12.50</td>
<td>137.50</td>
</tr>
<tr>
<td></td>
<td>10X IPC Mix</td>
<td>2.50</td>
<td>27.5</td>
</tr>
<tr>
<td></td>
<td>50X IPC DNA</td>
<td>0.50</td>
<td>5.5</td>
</tr>
<tr>
<td></td>
<td>20X Primer/ Probe Mix</td>
<td>1.25</td>
<td>13.75</td>
</tr>
<tr>
<td></td>
<td>Water/ Buffer</td>
<td>5.75</td>
<td>63.25</td>
</tr>
<tr>
<td></td>
<td>Diluted unknown 2</td>
<td>2.5</td>
<td>27.5</td>
</tr>
<tr>
<td>Cocktail Mix 3 for NTC/ IPC+</td>
<td>TaqMan® Universal PCR Master Mix (2.0X)</td>
<td>12.50</td>
<td>62.5</td>
</tr>
<tr>
<td></td>
<td>10X IPC Mix</td>
<td>2.50</td>
<td>12.5</td>
</tr>
<tr>
<td></td>
<td>50X IPC DNA</td>
<td>0.50</td>
<td>2.5</td>
</tr>
<tr>
<td></td>
<td>20X Primer/ Probe Mix</td>
<td>1.25</td>
<td>6.25</td>
</tr>
<tr>
<td></td>
<td>Water/ Buffer</td>
<td>8.25</td>
<td>41.25</td>
</tr>
<tr>
<td></td>
<td>Total reaction mix volume</td>
<td>25.0</td>
<td>125.0</td>
</tr>
<tr>
<td>Cocktail Mix 4 for NAC/ IPC-</td>
<td>TaqMan® Universal PCR Master Mix (2.0X)</td>
<td>12.50</td>
<td>62.5</td>
</tr>
<tr>
<td></td>
<td>10X IPC Mix</td>
<td>2.50</td>
<td>12.5</td>
</tr>
<tr>
<td></td>
<td>50X IPC DNA</td>
<td>0.50</td>
<td>2.5</td>
</tr>
<tr>
<td></td>
<td>20X Primer/ Probe Mix</td>
<td>1.25</td>
<td>6.25</td>
</tr>
<tr>
<td></td>
<td>IPC Block</td>
<td>2.5</td>
<td>12.5</td>
</tr>
<tr>
<td></td>
<td>Water/ Buffer</td>
<td>5.75</td>
<td>28.75</td>
</tr>
<tr>
<td></td>
<td>Total reaction mix volume</td>
<td>25.0</td>
<td>125.0</td>
</tr>
</tbody>
</table>
To prepare the reaction mix for each of the four types:

1. Label four appropriately sized tubes for the reaction mixes: Sample (+), Sample (-), NTC, NAC.
2. Add the required volumes of each cocktail mix component to the tube.
3. Mix the cocktail thoroughly by gently pipetting up and down several times, then cap the tube.
4. Centrifuge the tube briefly to remove air bubbles.
5. Place the cocktail mix on ice until you prepare the reaction plate.

*Note:* You can separately add the sample to the reaction plate, as opposed to preparing individual reaction mixes for each sample.

### Prepare the reaction plate

The reaction plate for the Presence/Absence example experiment contains:

- A MicroAmp® Optical 96-Well Reaction Plate (0.2 mL)
- Reaction volume of 25 μL/well
- 10 (+) wells
- 10 Sample (-) wells
- 4 NTC/IPC+
- 4 NAC/IPC-

The plate layout looks like this:
To prepare the reaction plate:

1. Add 25 µL of Cocktail mix 1 to wells B1 - B10.
2. Add 25 µL of Cocktail mix 2 to wells C1 - C10.
3. Add 25 µL of Cocktail mix 3 to wells A5 - A8.
5. Seal the reaction plate with optical adhesive film.
6. Centrifuge the reaction plate briefly to remove air bubbles.
7. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the reaction plate again at a higher speed and for a longer period of time.
8. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning the reaction plate components</td>
<td>Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</td>
<td>4470050</td>
</tr>
<tr>
<td>Sealing the reaction plate</td>
<td>Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</td>
<td>4470050</td>
</tr>
</tbody>
</table>
Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K Flex Instrument.

This chapter covers:
- Start the run .......................................................... 19
- Monitor the run ...................................................... 19

IMPORTANT! Run the experiment at the same ambient temperature at which you calibrated the instrument. Extreme variations in ambient temperature can affect the heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 12K Flex Instrument is in operation.

Start the run

1. Open the Presence/Absence example file that you created using instructions in Chapter 2.
2. Load the reaction plate into the instrument.
3. Start the run.

Monitor the run

Monitor the example experiment run:
- From the QuantStudio™ 12K Flex Software using the Run screen, while the experiment is in progress.
- From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor an experiment started from another computer or from the QuantStudio™ 12K Flex Instrument).
- From the QuantStudio™ 12K Flex Instrument touchscreen.

From the Instrument Console of the QuantStudio™ 12K Flex Software

1. In the Instrument Console screen, select the instrument icon.
2. Click Manage Instrument or double-click on the instrument icon.
3. On the Manage Instrument screen, click Monitor Running Instrument to access the Run screen.
View the Temperature Plot

Click **Temperature Plot** from the Run Experiment Menu.

The figure below shows the Temperature Plot screen as it appears during the example experiment.

![Temperature Plot](image)

**Note:** The Sample temperature displayed in the Current Temperatures group is an estimated value.

View the Run Method

Click **Run Method** from the Run Experiment Menu.

The figure below shows the Run Method screen as it appears in the example experiment.

![Run Method](image)
View run data

Click View Run Data from the Run Experiment Menu.

The figure below shows the View Run Data screen as it appears in the example experiment.

![View Run Data Screen](image)

From the QuantStudio™ 12K Flex Instrument touchscreen

You can also view the progress of the run from the touchscreen of the QuantStudio™ 12K Flex Instrument.

The Run Method screen on the QuantStudio™ 12K Flex Instrument touchscreen looks like this:

![Run Method Screen](image)
Note: The above screenshot is for visual representation only. Actual results will vary with the experiment.

**Time View**

Note: You will see the Plot View only if your experiment includes the PCR process.
In Section 5.1 of this chapter you review the analyzed data using several of the analysis screens and publish the data. Section 5.2 of this chapter walks you through the process of modifying experiment parameters to troubleshoot problems with experiment results before rerunning an experiment.

This chapter covers:

Section 5.1  Review Results ......................................................... 25
- Analyze the example experiment ............................................. 25
- View the Presence/Absence Plot ............................................. 25
- Assess amplification results using the Amplification Plot ............ 27
- View the Well Table ........................................................... 32
- Confirm accurate dye signal using the Multicomponent Plot ....... 35
- Determine signal accuracy using the Raw Data Plot ................. 38
- Review the flags in the QC Summary ...................................... 40
- For more information ......................................................... 42

Section 5.2  Adjust parameters for re-analysis of your own experiments ...... 43
- Adjust analysis settings ....................................................... 43
- For more information ......................................................... 47
Section 5.1 Review Results

Analyze the example experiment

1. Open the Presence/Absence example experiment file that you ran in Chapter 4.
2. Click Analyze. The software analyzes the data using the default analysis settings.
   Note: You can also access the experiment to analyze from the Home screen.

View the Presence/Absence Plot

The Presence/Absence Plot displays the intensity of the fluorescence for each well position. There are four Presence/Absence plot views available:

- All Calls
- Presence calls only
- Absence calls only
- Unconfirmed calls

For each view you can choose to:

- Show IPC
- Show Controls

Purpose

The purpose of viewing the Presence/Absence Plot for the example experiment is to confirm that:

- The target is absent in samples NTC and Sample (-).
- The target is present in Sample (+).
- There are no unconfirmed wells.
- The IPC succeeded in all wells.
- There is no amplification in NAC wells.

To view and assess the Presence/Absence Plot

From the Experiment menu pane, select Analysis > Presence/Absence Plot.

Note: If no data are displayed, click Analyze.

1. Display all 96 wells in the Presence/Absence Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.

2. Enter the Plot Settings:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Reporter</td>
<td>TGFB</td>
</tr>
<tr>
<td>Control Reporter</td>
<td>IPC</td>
</tr>
<tr>
<td>Show Calls</td>
<td>All Calls</td>
</tr>
</tbody>
</table>
3. Click the **Show IPC** check box to view the fluorescence intensity of the IPC target in the Unknown-IPC wells.

4. Click the **Show Controls** check box to view the fluorescence intensity of the IPC target in the negative control-IPC wells and the negative control-Blocked IPC wells.

5. To view the fluorescence intensity of:
   - Presence calls—select **Presence** from the Show Calls drop-down menu.
   - Absence calls—select **Absence** from the Show Calls drop-down menu.
   - Unconfirmed calls—select **Unconfirmed** from the Show Calls drop-down menu.

   **Note:** The Presence/Absence example experiment does not contain any unconfirmed calls.

The Presence/Absence Plot for the example experiment looks like this:
Tips for viewing Presence/Absence plots in your own experiments

- **The IPC threshold** is calculated from the negative control- Blocked IPC reactions.
- **The Target Threshold** is calculated from the negative control- IPC reactions. If the target’s intensity is:
  - Above the target threshold, the call is present (regardless of the intensity of the IPC).
  - Below the target threshold, and the IPC’s intensity is above the IPC threshold, the call is absent.
  - Below the target threshold, and the IPC’s intensity is below the IPC threshold, the call is unconfirmed.

- **Target Calls:**
  - Presence
  - Absence
  - Unconfirmed

- **IPC Calls:**
  - IPC Succeeded
  - IPC Failed

- **Control Well Calls:**
  - negative control - IPC
  - negative control - Blocked IPC

Assess amplification results using the Amplification Plot

**IMPORTANT!** Amplification plots are not used to make Presence/Absence calls. Examine the plots to help with troubleshooting and quality control.

Amplification plots available for viewing

The Amplification Plot displays amplification of all samples in the selected wells. There are three amplification plot views available:

- **ΔRn vs Cycle** – ΔRn is the difference in normalized fluorescence signal generated by the reporter between the pre-PCR read and the post-PCR read. This plot displays ΔRn as a function of cycle number. You can use this plot to identify and examine irregular amplification and to view threshold and baseline values for the run.

- **Rn vs Cycle** – Rn is the fluorescence signal from the reporter dye normalized to the fluorescence signal from the passive reference. This plot displays Rn as a function of cycle number. You can use this plot to identify and examine irregular amplification.

- **Cₜ vs Well** – Cₜ is the PCR cycle number at which the fluorescence meets the threshold in the amplification plot. This plot displays Cₜ as a function of well position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.
Purpose

The purpose of viewing the amplification plot for the example experiment is to review the target to identify:

- Correct baseline and threshold values
- Irregular amplification
- Outliers

View the Amplification Plot

1. From the Experiment menu pane, select Analysis ▶ Amplification Plot.
   
   Note: If no data are displayed, click Analyze.

2. Display all 96 wells in the amplification plot by clicking the upper left corner of the plate layout in the Plate Layout tab.

3. Expand the Plate Layout tab by clicking the left facing arrow that is left of the tab.

4. In the Amplification Plot screen, enter:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>ΔRn vs Cycle</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Well</td>
</tr>
</tbody>
</table>
   |              | (This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.) | Check (default)

5. View the baseline values:
   
a. From the Graph Type drop-down menu, select Linear.

   b. Select the Baseline check box to show the start cycle and end cycle.

   c. Verify that the baseline is set correctly: The end cycle should be set a few cycles before the cycle number where significant fluorescent signal is detected. In the example experiment, the baseline is set correctly.
6. View the threshold values:
   a. From the Graph Type drop-down menu, select Log.
   b. Select the Threshold check box to show the threshold.
   c. Verify that the threshold is set correctly.

Your screen should look like this:
Chapter 5  Review Results and Adjust Experiment Parameters

Assign amplification results using the Amplification Plot

7. Locate any outliers:
   a. From the Plot Type drop-down menu, select \( C_T \) vs Well.
   b. Look for outliers from the amplification plot. In the example experiment, there are no outliers for IPC.

Your screen should look like this:

Tips for viewing amplification plots in your own experiments

When you analyze your own Presence/Absence experiment, look for:

- **Outliers**
- **A typical amplification plot** – The QuantStudio™ 12K Flex Software automatically calculates baseline and threshold values based on the assumption that the data exhibit a *typical* amplification plot. A typical amplification plot has four distinct sections:
  - Plateau phase
  - Linear phase
  - Exponential (geometric phase)
  - Baseline
A typical amplification plot should look like this:

**IMPORTANT!** Experimental error (such as contamination or pipetting errors) can produce atypical amplification curves that can result in incorrect baseline and threshold value calculations by the QuantStudio™ 12K Flex Software. Life Technologies recommends that you examine the Amplification Plot screen and review the assigned baseline and threshold values for each well after analysis.

**Note:** If you use the Relative Threshold algorithm to analyze an experiment that includes amplification, select to view the analysis results using the ΔRn vs Cycle, Rn vs Cycle, or CRT vs Well plot type and Linear or Log graph type. Also select the Show CRT check box to view the derived fractional cycle on the amplification plot.
View the Well Table

The well table displays results data for each well in the reaction plate, including:

- The well number, sample name, target name, task, and dyes
- The calculated values: ΔRn, ΔRn mean, and ΔRn SD
  
  **Note:** ΔRn, ΔRn mean, and ΔRn SD are calculated only when the analysis call settings specify to analyze data from the pre-PCR read and the post-PCR read.
- Target and IPC thresholds, Call, Comments
- Flags

**Purpose**

In the Presence/Absence example experiment, you review the well table for:

- Call
- ΔRn
- Flag

**To view the Well Table**

1. From the Experiment Menu pane, select **Analysis** ➤ **Amplification Plot**, then select the **Well Table** tab.
   
   **Note:** If no data are displayed, click **Analyze**.

2. Use the Group By drop-down menu to group wells by a specific category. For the example experiment, group the wells by flag, call, and ΔRn value.
   
   **Note:** You can select only one category at a time.
a. From the Group By drop-down menu, select Flag:
   - 30 wells are listed under Flagged.
   - 66 wells are listed under Unflagged.

b. From the Group By drop-down menu, select Call. Wells are listed in the order:
   - Absence
   - Blocked IPC Control
   - IPC Failed
   - IPC Succeeded
   - Negative Control
Chapter 5 Review Results and Adjust Experiment Parameters

View the Well Table

- Unconfirmed
- No Call

c. From the Group By drop-down menu, select None. In the table, click the column heading $\Delta R_n$. Wells are listed in order of increasing $\Delta R_n$. Click the column heading again to reverse the sort order.
Tips for analyzing your own experiments

When you analyze your own Presence/Absence experiment, group the wells by:

- **Flag** – The software groups the flagged and unflagged wells. A flag indicates that the software has found an error in the flagged well. For a description of the QuantStudio™ 12K Flex Software flags, see “Review the flags in the QC Summary” on page 40.

- **Call** – The software groups the wells by call: Negative Control, Blocked-IPC, Presence, Absence, Unconfirmed, IPC Succeeded, and IPC Failed.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

Purpose

In the Presence/Absence example experiment, you review the Multicomponent Plot screen for:

- ROX™ dye (passive reference)
- FAM™ dye (reporter)
- VIC® dye (reporter)
- TAMRA (reporter)
- Spikes, dips, and/or sudden changes
- Amplification in the negative control wells

View the Multicomponent Plot

1. From the Experiment Menu pane, select **Analysis ➤ Multicomponent Plot**.
   **Note:** If no data are displayed, click **Analyze**.

2. Display the wells **one at a time** in the Multicomponent Plot screen:
   a. Click the **Plate Layout** tab.
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.
      **Note:** If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select **Dye**.

4. Click **Show a legend for the plot** (default).
   **Note:** This is a toggle button. When the legend is displayed, the button changes to **Hide the plot legend**.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal remains constant throughout the PCR process; a constant ROX dye signal indicates typical data.
6. Check the VIC dye signal. In the example experiment the VIC dye signal should not amplify for NAC-Blocked IPC wells or if the IPC call for the Unknown-IPC well is IPC Failed.

7. Check the FAM dye signal. In the example experiment, for the sample (+), the FAM dye signal increases throughout the PCR process; increase in FAM dye signal indicates normal amplification.
8. Check the TAMRA dye signal. In the example experiment the TAMRA dye signal should not amplify for NAC-Blocked IPC wells or if the IPC call for the Unknown-IPC well is IPC Failed.

9. Select the negative control (NTC) wells one at time and check for amplification. In the example experiment, there is no amplification in the negative control wells.
Tips for confirming dye accuracy in your own experiment

When you analyze your own Presence/Absence experiment, look for:

- **Passive reference (ROX)** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.

- **Reporter dye (FAM)** – The reporter dye fluorescence level should display a flat region corresponding to the baseline. If target is present in the sample (a Presence call is made), the baseline will be followed by a rapid rise in fluorescence as the amplification proceeds.

- **Irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.

- **Negative control wells** – There should not be any amplification in the negative control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter for the selected wells during each cycle of the real-time PCR.

Purpose

In the Presence/Absence example experiment, review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data Plot

1. From the Experiment Menu pane, select Analysis > Raw Data Plot.
   
   **Note:** If no data are displayed, click Analyze.

2. Click Show a legend for the plot (default). The legend displays the color code for each row of the reaction plate (see the legend in the Raw Data Plot shown below).

3. Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.

4. Select wells corresponding to a replicate group:
   - (-) wells: From the Select Wells with drop-down menus, select sample (-).
   - (+) wells: From the Select Wells with drop-down menus, select sample (+).
   - Negative control-IPC wells: Select wells A5-A8.
5. Click and drag the Show Cycle pointer from cycle 1 to cycle 42. In the example experiment, there is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.

The filters used for the example experiment are:
Chapter 5  Review Results and Adjust Experiment Parameters

Review the flags in the QC Summary

Tips for determining signal accuracy in your own experiments

When you analyze your own Presence/Absence experiment, look for the following in each filter:

- Characteristic signal growth
- No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags, including the flag frequency and location for the open experiment. In the example experiment, 31 flags have been triggered.

**Note:** The flags triggered in the example experiment are seen in the (+) and (-) wells. The flag NOAMP indicates that the well containing the sample (+) did not amplify. The flags, NOAMP and EXPFAIL, indicate that the wells containing the sample (-) did not amplify and that the software could not identify the exponential region of the amplification plot (as amplification did not take place). The occurrence of these flags in the (-) wells in the example experiment is valid because it indicates the absence of the target in the sample.

**View the QC Summary**

1. From the Experiment Menu pane, select **Analysis ➤ QC Summary**.

   **Note:** If no data are displayed, click **Analyze**.

2. Review the Flags Summary

   **Note:** A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment. If the frequency is >0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.

   In the example experiment, there are 15 flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed information about the flag. In the example experiment:

   - The NOAMP flag appears 13 times, in the wells A5 - A8, B1, C3 - C10.
   - The EXPFAIL flag appears 14 times, in the same wells as the NOAMP flag, that is, A5 - A8, B1, C3 - C10. In addition, the flag EXPFAIL also appears in the B1 well.
   - The AMPNC flag appears 4 times, in the wells A5-A8.
4. **(Optional)** For those flags with frequency >0, click the troubleshooting link to view information on correcting the flag.

### Possible flags

For Presence/Absence experiments, the flags listed below may be triggered by the experiment data.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
<tr>
<td>CFAIL</td>
<td>C₇ algorithm failed</td>
</tr>
<tr>
<td>AMPSCORE</td>
<td>Amplification in the linear region is below a certain threshold, corresponding to the score set in the analysis settings</td>
</tr>
</tbody>
</table>
Note: If the experiment does not include amplification, then the only flags are BADROX, NOSIGNAL, and OFFSCALE.

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

### For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing data</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
</tbody>
</table>
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the call, threshold cycle (C_T), flags, and advanced options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.
2. Click Analysis ▶ Analysis Settings to open the Analysis Settings dialog box.
   In the example experiment, the default analysis settings are used for each tab:
   - Call Settings
   - C_T Settings
   - Flag Settings
   - Advanced Settings

The Analysis Settings dialog box for a Presence/Absence experiment looks like this:
3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” below).

Note: You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to Default Analysis Settings.

Adjust analysis settings

Call Settings

Use the Call Settings tab to:

- Change the default data analysis settings. You can select from:
  - Analyze data from Post-PCR Read only
  - Analyze data from Pre-PCR Read and Post-PCR Read
- Edit the default call settings.
  - Click Edit Default Settings, then select the confidence value to use to make presence/absence calls. If the confidence value is less than the call setting, the call is unconfirmed.
  - Click Save Changes.
- Use custom call settings for a target.
  - Select one or more targets in the table, then deselect the Default Settings checkbox.
  - Select the confidence value to use to make Presence/Absence calls for the selected target(s).

C<sub>T</sub> Settings

- Data Step Selection
  Use this feature to select one stage/step combination for C<sub>T</sub> analysis when there is more than one data collection point in the run method.
- Algorithm Settings
  You can select the algorithm that determines the C<sub>T</sub> values. There are two algorithms: Baseline Threshold (the default) and Relative Threshold.

The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for quantification.

The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no dependence on targets, thereby reducing variability. It is not necessary to set either a baseline or a threshold when you use the Relative Threshold algorithm, so any settings for baseline or threshold will not affect the analysis.
• **Default C\textsubscript{T} Settings**
  Use the default C\textsubscript{T} settings feature to calculate C\textsubscript{T} for the targets that do not have custom settings. To edit the default settings, click **Edit Default Settings**.

• **C\textsubscript{T} Settings for Target**
  When you manually set the threshold and baseline, Life Technologies recommends:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Enter a value for the threshold so that the threshold is:</td>
</tr>
<tr>
<td></td>
<td>• Above the background.</td>
</tr>
<tr>
<td></td>
<td>• Below the plateau and linear regions of the amplification curve.</td>
</tr>
<tr>
<td></td>
<td>• Within the exponential phase of the amplification curve.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Select the Start Cycle and End Cycle values so that the baseline ends before significant fluorescent signal is detected.</td>
</tr>
</tbody>
</table>

**Note:** This setting is applicable only to the Baseline Threshold algorithm.

**Note:** Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.

**Flag Settings**

Use the Flag Settings tab to:

• Adjust the sensitivity so that more wells or fewer wells are flagged.
• Change the flags that are applied by the QuantStudio™ 12K Flex Software.

To adjust the flag settings:

1. In the Use column, select the check boxes for flags to apply during analysis.
2. *(Optional)* If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.
   **Note:** If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.
3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.
   **Note:** After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments using the Standard Deviation calculations may change the result of C\textsubscript{T} SD. For some flags, analysis results calculated before the well is rejected are maintained.
4. Click **Apply Analysis Settings** in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.
Chapter 5  Review Results and Adjust Experiment Parameters

Adjust analysis settings

The Flag Settings tab looks like this:

![Image of Flag Settings tab]

Advanced Settings

Use the Advanced Settings tab to change baseline settings well-by-well.

**Note:** The baseline and threshold values do not affect the analysis using the Relative Threshold setting.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.
2. Deselect the **Use CT Settings Defined for Target** check box.
3. Define the custom baseline settings:
   - For automatic baseline calculations, select the **Automatic Baseline** check box.
   - To define the baseline, deselect the **Automatic Baseline** check box, then enter the baseline start cycle and baseline end cycle.
## For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification efficiency</td>
<td>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note.</td>
<td>127AP05-03</td>
</tr>
</tbody>
</table>
1. Open the Presence/Absence example experiment file that you analyzed in Chapter 5.

2. In the Experiment Menu, click **Export**.

   **Note:** To export data automatically after analysis, select the **Auto Export** check box during experiment setup or before running the experiment. Auto export is unchecked for the example experiment.

3. Select **QuantStudio™ 12K Flex format**.

4. Complete the Export dialog box as shown below:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export/ Select Content</td>
<td>Results</td>
</tr>
<tr>
<td>Export Data To</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>96-Well Presence Absence Example_QuantStudio_export</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td>&lt;drive&gt;\Applied Biosystems\QuantStudio 12K Flex Software\experiments</td>
</tr>
</tbody>
</table>
Your Export screen should look like this:

![Export Screen](image)

Your exported file when opened in Notepad should look like this:

![Notepad Output](image)
A
adjusting analysis settings 43
adjusting parameters, re-analyzing own experiments 43
Advanced settings tab 46
Algorithm Settings
  Baseline Threshold 44
  Relative Threshold 44
ambient temperature 19
amplification 6
amplification plot
  amplification efficiency 13, 47
  assessing amplification results 27
  reviewing baseline values 28
  reviewing outliers 30
  reviewing threshold values 29
tips for analyzing own experiment 30
viewing 28
AMPNC flag 42
AMPSCORE flag 41
analysis data
  amplification 7
  post-PCR read 7
  pre-PCR read 7
analysis settings 43
  Advanced Settings 43
  Call Settings 43
  C_T Settings 43
  Flag Settings 43
Analyze
  Amplification Plot 27
  Multicomponent Plot 35
  Presence/Absence Plot 25
  QC Summary 40
  Raw Data Plot 38
  Well Table 32
Auto Export 49
Automatic Baseline, advanced settings 46
Automatic Threshold 45

B
BADROX flag 41
BLFAIL flag 41
Blocked IPC 27
Blocked IPC Control 33

C
Call Settings tab 44
cocktail mix 15, 17
C_T settings 45
  algorithm settings 44
  data step, selecting 44
default 45
tab 44
target 45
cycle number 28

data collection, type
  end-point PCR data 5
  real-time PCR data 5
designing experiment
  assigning targets and samples 11
defining experiment properties 9
defining targets and samples 10
  setting up run method 12
dye accuracy
  irregularities in the signal 38
  negative control wells 38
  passive reference 38
  reporter dye 38

de
end-point PCR data 5
example experiment 7
experiment properties, defining 9
EXPFAIL flag 41
Export 49

F
Flag Settings tab 45
flags, QC
  AMPNC 42
  AMPSCORE 41
  BADROX 41
  BLFAIL 41
  CTFAIL 41
  EXPFAIL 41
  NOAMP 41
  NOISE 41
  NOSIGNAL 41
  OFFSCALE 41
Index

SPIKE 41
THOLDFAIL 41

I
include amplification, Primary analysis flags
AMPSCORE 41
instrument run
amplification 6
post-PCR read 6
pre-PCR read 6
IPC
failed 7
succeeded 7
IPC setup, well type
negative control-blocked IPC wells 6
negative control-IPC wells 6
unknown-IPC wells 6
irregular amplification 27

M
multicomponent plot
confirming dye signal 35
tips for analyzing own experiment 38
viewing 35

N
negative control-blocked IPC wells 6
negative control-IPC wells 6
negative controls 6
no IPC 6
well type, negative controls 6
well type, unknown wells 6
NOAMP flag 41
NOISE flag 41
NOSIGNAL flag 41

O
OFFSCALE flag 41
outliers 27

P
passive reference 27
PCR reactions, type
IPC setup 6
no IPC, singleplex setup 6
post-PCR read 6, 27
post-PCR read analysis data
absence 7
presence 7
unconfirmed 7
preparing reactions
reaction mix 15
reaction plate 17
required materials 15
pre-PCR read 6, 27
Pre-processing flag
OFFSCALE 41
presence/absence calls 27
Presence/Absence experiments
analysis, about 7
instrument run, about 6
overview 5
PCR reactions, setting up 6
presence/absence plot
tips for viewing own experiment 27
viewing and assessing 25
views, absence calls only 25
views, all calls 25
views, presence calls only 25
views, unconfirmed calls 25
Primary analysis flags
BADROX 41
BLFAIL 41
CTFAIL 41
EXPFAIL 41
NOAMP 41
NOISE 41
NOSIGNAL 41
SPIKE 41
THOLDFAIL 41

Q
QC Summary, reviewing flags 40

R
raw data plot
determining signal accuracy 38
tips for analyzing own experiment 40
viewing 38
reaction mix
components 15
preparing reactions 15

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
Experiments User Guide for Presence/Absence Experiments
reactions, assembling materials for  15
real-time PCR data  5
replicate group  38
review results  25
run
  monitoring  19
  starting  19
run method
  setting up  12
  thermal profile  12
  viewing  20
Run screen
  Run Method  20
  Temperature Plot  20
  View Run Data  21

S
samples, defining  10
Secondary analysis flags
  AMPNC  42
setting up PCR reactions  6
show controls  25
show IPC  25
singleplex setup  6
SPIKE flag  41

T
targets and samples, assigning  11
targets, defining  10
temperature plot, viewing  20
THOLDFAIL flag  41
tips for viewing presence/absence plot
  control well calls  27
  IPC calls  27
  IPC threshold  27
  target calls  27
  target threshold  27
touchscreen, running the experiment from
  Experiment View  21
  Plot View  22
  Time View  22

U
unconfirmed calls  26
unknown wells  6
unknown-IPC wells  6
For Research Use Only. Not intended for any animal or human therapeutic or diagnostic use.
Contents

CHAPTER 1  About Melt Curve Experiments .............................. 5
  Overview .............................................................................. 5
  About the Melt Curve reactions ........................................... 5
  About the example experiment .............................................. 6

CHAPTER 2  Design the Experiment ................................. 7
  Define the experiment properties ........................................ 7
  Define targets and samples ................................................. 8
  Assign targets and samples ............................................... 9
  Set up the run method ...................................................... 10
    Set the thermal profile .................................................. 10
    Edit the ramp increment ............................................... 10
  For more information .................................................... 12

CHAPTER 3  Prepare the Reactions ................................. 13
  Assemble required materials .............................................. 13
  Prepare the sample dilutions ............................................. 13
  Prepare the reaction mix ("cocktail mix") ............................ 14
    Procedure ........................................................................ 14
    Calculations ................................................................... 14
  Prepare the reaction plate ................................................. 14
  For more information .................................................... 15

CHAPTER 4  Run the Experiment ...................................... 17
  Start the run ..................................................................... 17
  Monitor the run .................................................................. 17
    From the Instrument Console of the QuantStudio™ Software .... 18
    From the QuantStudio™ 12K Flex Instrument touchscreen ...... 20
CHAPTER 5  Review Results and Adjust Experiment Parameters  . . 23

Section 5.1 Review Results ....................................................... 25
Analyze the example experiment ........................................... 25
View the Melt Curve Plot ....................................................... 25
  Purpose .............................................................................. 25
  To view and assess the Melt Curve ..................................... 25
  Tips for viewing melt curves in your own experiments .......... 26
Identify well problems using the Well Table .......................... 26
  Example experiment values and flags .................................. 26
  View the well table .......................................................... 26
  Tips for viewing well tables your own experiments ............... 28
Confirm accurate dye signal using the Multicomponent Plot .... 29
  Purpose .............................................................................. 29
  View the Multicomponent Plot .......................................... 29
  Tips for confirming dye accuracy in your own experiment ....... 30
Determine signal accuracy using the Raw Data Plot ............... 30
  About the example experiment .......................................... 30
  View the Raw Data Plot .................................................... 30
  Tips for determining signal accuracy in your own experiments . 32
Review the flags in the QC Summary ..................................... 32
  View the QC Summary ..................................................... 32
  Possible flags ..................................................................... 33
For more information ............................................................. 34

Section 5.2 Adjust parameters for re-analysis of your own experiments ........ 35
Adjust analysis settings ......................................................... 35
  View the analysis settings ................................................. 35
  Adjust analysis settings ..................................................... 36
For more information ............................................................. 39

CHAPTER 6  Export Analysis Results ................................. 41

Index ..................................................................................... 43
About Melt Curve Experiments

Overview

A Melt Curve, also known as dissociation curve, is a plot of data collected during the Melt Curve stage of an experiment. Melt Curve experiments are performed to determine the melting temperature (Tm) of a target nucleic acid sequence or to identify nonspecific PCR amplification.

Melting temperature (Tm) is the temperature at which 50% of the target DNA is double-stranded and 50% is dissociated into single-stranded DNA.

The melting temperature and non-specific PCR amplification can be identified as peaks in the melt curve stage of an experiment.

About the Melt Curve reactions

With Melt Curve experiments, the reactions consist of completed PCR reactions that contain amplified products and SYBR® Green dye to detect double-stranded DNA.

The QuantStudio™ 12K Flex Software detects the number of fluorescence peaks, determines the melting temperature (Tm) for each peak, and plots the results in a melt curve.

The fluorescence data collected during the QuantStudio™ 12K Flex Instrument run are stored in an experiment data file (*.eds).
Chapter 1 About Melt Curve Experiments

About the example experiment

There are two types of reactions in a Melt Curve experiment:

- **Unknowns** - Wells containing PCR product with unknown melting temperature(s).
- **Negative Controls** - Wells containing buffer or water instead of sample. The negative control wells should contain no double-stranded DNA.

To illustrate how to perform Melt Curve experiments, this guide leads you through the process of designing and performing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with a QuantStudio™ 12K Flex System.

The objective of the example Melt Curve experiment is to investigate the melting temperature of Target 1, and verify that no extraneous peaks appear. The SYBR® Green reagent is used to detect the melting temperature stage.

**Note:** The example experiment performs a melt curve analysis on PCR products from a PCR performed on the QuantStudio™ 12K Flex System or on another thermal cycler.
This chapter explains how to design the example experiment from the Experiment Setup menu.

This chapter covers:

- Define the experiment properties .................................................. 7
- Define targets and samples ................................................................. 8
- Assign targets and samples ................................................................. 9
- Set up the run method ................................................................. 10
- For more information ................................................................. 12

Note: To automatically export the analyzed data to a specified location, select the Auto Export task from the Export screen, before running the experiment. For more information on Auto Export, refer to Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

Define the experiment properties

Click **Experiment Setup → Experiment Properties** to create a new experiment in the QuantStudio™ Software. Enter:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Name</td>
<td>384-Well Melt Curve Example</td>
</tr>
<tr>
<td>Barcode</td>
<td>Leave field empty</td>
</tr>
<tr>
<td>User Name</td>
<td>Example User</td>
</tr>
<tr>
<td>Comments</td>
<td>Melt Curve example</td>
</tr>
<tr>
<td>Block</td>
<td>384-Well</td>
</tr>
<tr>
<td>Experiment Type</td>
<td>Melt Curve</td>
</tr>
<tr>
<td>Reagents</td>
<td>SYBR® Green Reagents</td>
</tr>
<tr>
<td>Ramp speed</td>
<td>Standard</td>
</tr>
<tr>
<td>Include PCR</td>
<td>Unchecked</td>
</tr>
</tbody>
</table>

Save the experiment.
Define targets and samples

Click Define to access the Define screen. Enter:

1. Targets

<table>
<thead>
<tr>
<th>Target Name</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target 1</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

2. Samples

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample 1</td>
<td></td>
</tr>
</tbody>
</table>

3. Dye to be used as a Passive Reference

ROX
Assign targets and samples

Click **Assign** to access the Assign screen. Enter the targets and samples:

<table>
<thead>
<tr>
<th>Target Name</th>
<th>Sample</th>
<th>Well Number</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYBR</td>
<td>Sample 1</td>
<td>A1-P2 (Columns 1 and 2), A3-G3 (Column 3)</td>
<td>Unknown</td>
</tr>
</tbody>
</table>

Your Define screen should look like this:
Set up the run method

Set the thermal profile

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- Reaction Volume Per Well: 20 µL
- Thermal Profile

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Melt Curve Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>15 seconds</td>
</tr>
<tr>
<td></td>
<td>Step 2</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>1 minute</td>
</tr>
<tr>
<td></td>
<td>Step 3 (Dissociation)</td>
<td>0.05°C/s</td>
<td>95°C</td>
<td>15 seconds</td>
</tr>
</tbody>
</table>

Edit the ramp increment

Edit the ramp increment for a melt curve (dissociation) step.

1. Select a melt curve ramp increment method:
   - **Step and Hold** – Increases or decreases the ramp temperature in 0.1 °C increments over the time (duration) for the melt curve ramp.
   - **Continuous (default)** – Increases or decreases the ramp rate in 0.005 °C per second increments.
2. If you selected the Step and Hold ramp increment method, edit the melt curve ramp time:
   - To increase or decrease the time in 1-minute or 1-second increments, click the **Step and Hold** field, select the minutes or seconds, then use the up or down arrow keys or click the up or down buttons in the field until you reach the desired time.
   - To enter the desired time, click the **Step and Hold** field, select the minutes or seconds, then enter the desired time.

3. Edit the melt curve ramp increment:
   - To increase or decrease the ramp increment, click the melt curve (dissociation) ramp increment in the thermal profile, then use the up or down arrow keys or click the up or down buttons in the field until you reach the desired value.
   - To enter the desired ramp increment, click the melt curve (dissociation) ramp increment in the thermal profile, select the value in the field, then enter the desired value.

   **Note:** To view the maximum and minimum allowed values, place the cursor over melt curve (dissociation) ramp increment in the thermal profile and wait for the tooltip to pop up.

Your Run Method screen should look like this:
### For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to</th>
<th>Part number</th>
</tr>
</thead>
</table>
| Consumables                | Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments  
Appendix A in Booklet 7, QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments - Appendixes | 4470050     |
| Using alternative setup   | Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments | 4470050     |
Prepare the Reactions

This chapter explains how to prepare the reactions for running a PCR prior to running a Melt Curve.

To perform a Melt Curve experiment without running a PCR, use the reaction plate containing the PCR product.

**Note:** The example experiment performs a melt curve analysis on PCR products from a PCR performed on the QuantStudio™ 12K Flex System or on another thermal cycler.

This chapter covers:

- Assemble required materials .................................................. 13
- Prepare the sample dilutions .................................................. 13
- Prepare the reaction mix (“cocktail mix”). .............................. 14
- Prepare the reaction plate ...................................................... 14
- For more information............................................................ 15

**Assemble required materials**

- Items listed in Booklet 1, *Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments*
- Sample 1
- Example experiment reaction mix components:
  - Power SYBR® Master Mix
  - Target - Assay Mix Forward primer (10µM)
  - Target - Assay Mix Reverse primer (10µM)

**Prepare the sample dilutions**

The stock concentration of each sample is 100 ng/µL. After you dilute the sample according to the Sample Dilutions Calculations table, the sample will have a concentration of 10 ng/µL. Add 2µL to each reaction.

<table>
<thead>
<tr>
<th>Sample name</th>
<th>Sample volume (µL)</th>
<th>Diluent volume (µL)</th>
<th>Total volume of diluted sample (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample 1 (Amplified PCR Product)</td>
<td>10</td>
<td>90</td>
<td>100</td>
</tr>
</tbody>
</table>
Chapter 3 Prepare the Reactions

Prepare the reaction mix ("cocktail mix")

The following table lists the universal assay conditions [volume and final concentration for using the Power SYBR® Master Mix (2X)].

<table>
<thead>
<tr>
<th>Reaction Component</th>
<th>Volume for 1 reaction (µL)</th>
<th>Volume for 40 reactions (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power SYBR® Green PCR Master Mix (2X)</td>
<td>10</td>
<td>400</td>
</tr>
<tr>
<td>Forward primer (10µM)</td>
<td>0.1</td>
<td>4</td>
</tr>
<tr>
<td>Reverse primer (10µM)</td>
<td>0.1</td>
<td>4</td>
</tr>
<tr>
<td>Water</td>
<td>7.8</td>
<td>312</td>
</tr>
<tr>
<td>Total reaction mix volume</td>
<td>18</td>
<td>720</td>
</tr>
</tbody>
</table>

Procedure

1. Label an appropriately sized tube for the reaction mix: Power SYBR® Reaction Mix.
2. Add the required volume of each cocktail mix component to the tube.
3. Mix the cocktail thoroughly by gently pipetting up and down several times, then cap the tube.
4. Centrifuge the tube briefly to remove air bubbles.
5. Place the cocktail mix on ice until you prepare the reaction plate.

Calculations

Determine the quantity of primer to be added to the reaction mix by performing the following calculation:

Concentration (initial) C1 x Volume (primer stock) V1 = Concentration (final) C2 x Volume (final reaction) V2

(10µM) x (V1) = (0.05µM) (20µL)

V1 = (0.05 x 20) / 10 = 0.1

Prepare the reaction plate

1. Add reaction mix and sample to a tube.
   a. To an appropriately sized tube, add the volumes of reaction mix and sample listed below.
b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.

2. Pipette 20 µL of the unknown (sample) reaction to each well in the reaction plate.

3. Seal the reaction plate with optical adhesive film.

4. Centrifuge the reaction plate briefly to remove air bubbles.

5. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the reaction plate again at a higher speed and for a longer period of time.

6. Until you are ready to perform the PCR run, place the reaction plate at 4°C, in the dark.

7. Run the PCR.

8. After the PCR is completed, use the same reaction plate containing the PCR product to run the Melt Curve as described in Chapter 4.

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning the reaction plate components</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
<tr>
<td>Sealing the reaction plate</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</em></td>
<td>4470050</td>
</tr>
</tbody>
</table>
Run the Experiment

This chapter explains how run the example experiment on the QuantStudio™ 12K Flex Instrument.

This chapter covers:

- Start the run. ............................................................... 17
- Monitor the run. .......................................................... 17

**IMPORTANT!** Run the experiment at the same ambient temperature at which you calibrated the instrument. Extreme variations in ambient temperature can affect the heating and cooling of the instrument and influence experimental results.

**IMPORTANT!** Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 12K Flex Instrument is in operation.

Start the run

1. Open the Melt Curve example file that you created using instructions in Chapter 2.

**IMPORTANT!** The example experiment includes the melt curve analysis of a PCR product from PCR on QuantStudio™ 12K Flex System or another thermal cycler. To run a Melt Curve on the example file you created in Chapter 2, ensure that PCR has already been performed on the reaction plate you load into the instrument. Absence of the PCR product will lead to no results in the Dissociation Step of the Melt Curve Stage.

2. Load the reaction plate, containing the PCR product, into the instrument.

3. Start the run.

Monitor the run

Monitor the example experiment run:

- From the QuantStudio™ Software using the Run screen, while the experiment is in progress.
- From the Instrument Console of the QuantStudio™ Software (to monitor an experiment started from another computer or from the QuantStudio™ 12K Flex Instrument touchscreen).
- From the QuantStudio™ 12K Flex Instrument touchscreen.
From the Instrument Console of the QuantStudio™ Software

1. In the Instrument Console screen, select the instrument icon.
2. Click Manage Instrument or double-click on the instrument icon.
3. On the Manage Instrument screen, click Monitor Running Instrument to access the Run screen.

View the Melt Curve

You can view the progress of the run in real time. During the run, periodically view all the three plots available from the QuantStudio™ Software for potential problems.

Click Melt Curve from the Run Experiment Menu, select the Plate Layout tab, then select the wells to view.

The figure below shows the Melt Curve as it appears at the end of the example experiment.
View the Temperature Plot

Click **Temperature Plot** from the Run Experiment Menu.

The figure below shows the Temperature Plot screen as it appears during the example experiment.

![Temperature Plot](image)

**Note:** The Sample temperature displayed in the Current Temperatures group is an estimated value.

View the Run Method

Click **Run Method** from the Run Experiment Menu.

The figure below shows the Run Method screen as it appears in the example experiment.

![Run Method](image)
4 Chapter 4 Run the Experiment

Monitor the run

View run data

Click View Run Data from the Run Experiment Menu.

The figure below shows the View Run Data screen as it appears in the example experiment.

From the QuantStudio™ 12K Flex Instrument touchscreen

You can also view the progress of the run from the touchscreen of the QuantStudio™ 12K Flex Instrument.

The Run Method screen on the QuantStudio™ 12K Flex Instrument touchscreen looks like this:

Experiment View

Note: The above screenshot is for visual representation only. Actual results will vary with the experiment.
Chapter 4  Run the Experiment

Monitor the run

Time View

![Time View](image)

Run Started: December 08 2011 - 12:05AM
Reaction Volume: 20 µL

Sample: 59.5 °C
Heated Cover (Set Point): 105.0 °C (105.0 °C)
Stage / Step / Cycle: 2 / 2 / 5

01:11:22

Remaining Time  Elapsed Time

Note: You will see the Plot View only if your experiment includes the PCR process.

Plot View

![Plot View](image)

December 08 2011 - 12:06AM
Error occurred during run. Details: Holdtime 60s exceeded. Actual Holdtime...
Chapter 4 Run the Experiment

Monitor the run
In Section 5.1 of this chapter you review the analyzed data using several of the analysis screens and publish the data. Section 5.2 of this chapter walks you through the process of modifying experiment parameters to troubleshoot problems with experiment results before rerunning an experiment.

This chapter covers:

**Section 5.1 Review Results** ......................................................... 25
- Analyze the example experiment ........................................... 25
- View the Melt Curve Plot ....................................................... 25
- Identify well problems using the Well Table .......................... 26
- Confirm accurate dye signal using the Multicomponent Plot ...... 29
- Determine signal accuracy using the Raw Data Plot ............... 30
- Review the flags in the QC Summary ..................................... 32
- For more information ............................................................ 34

**Section 5.2 Adjust parameters for re-analysis of your own experiments** ........ 35
- Adjust analysis settings ......................................................... 35
- For more information ............................................................ 39
Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.
2. Click Analyze. The software analyzes the data using the default analysis settings.
   Note: You can also access the experiment to analyze from the Home screen.

View the Melt Curve Plot

View the Melt Curve Plot as the Derivative Reporter (-Rn) versus the Temperature Plot generated by the target.

The Melt Curve screen displays the melt curve of the targets in the selected wells. Use the Melt Curve plots to confirm the results of the experiment:

- **Normalized Reporter (Rn) vs. Temperature** – This plot displays the fluorescence signal from the reporter dye normalized to the fluorescence signal of the passive reference. You can use this plot to see the change in Rn with change in the temperature. You cannot use this plot to determine the Tm of the target.

- **Derivative Reporter (-Rn) vs. Temperature** – This plot displays the derivative reporter signal in the y-axis. The peaks in the plot indicate significant decrease in SYBR® Green signal, and therefore the Tm of the target.

Purpose

The purpose of viewing the Melt Curve Plot for the example experiment is to review the melting temperature of the target.

To view and assess the Melt Curve

1. From the Experiment menu pane, select Analysis ➤ Melt Curve Plot.
   Note: If no data are displayed, click Analyze.

2. Enter the Plot Settings:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot</td>
<td>Derivative Reporter</td>
</tr>
<tr>
<td>Target</td>
<td>All</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Target</td>
</tr>
<tr>
<td><img src="image" alt="check box" /></td>
<td>Check (default)</td>
</tr>
</tbody>
</table>

(This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.)
The Melt Curve for the example experiment looks like this:

![Melt Curve Plot](image)

**Tips for viewing melt curves in your own experiments**

When you analyze your own Melt Curve experiment, look for wells with multiple peaks, indicating non-specific amplifications or primer dimer formation.

If your experiment does not amplify properly or indicates non-specific amplification, troubleshoot by manually adjusting the Melt Curve settings (see “Adjust analysis settings” on page 35).

**Identify well problems using the Well Table**

Review the details of the experiment results in the well table and identify any flagged wells. The well table displays the assay-specific setup and analysis properties for the experiment in a tabular format.

**Example experiment values and flags**

For the example experiment, confirm that no wells of the reaction plate triggered QC flags ▲.

**View the well table**

1. Select the Well Table tab.
2. Click the Flag column header to sort the data so that the wells that triggered flags appear at the top of the table.
3. Confirm the integrity of the controls:
   a. From the Group By menu, select Task to organize the table rows by their function on the reaction plate.
b. Confirm that each of the controls do not display flags (▲).

The figure below shows the well table of the example Melt Curve experiment.

The table below gives the description of each column in the well table.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>The position of the well on the reaction plate.</td>
</tr>
<tr>
<td>Omit</td>
<td>A check mark indicates that the well has been removed from the analysis.</td>
</tr>
<tr>
<td>Flag</td>
<td>A ▲ indicates that the well triggered the number of flags listed inside the symbol.</td>
</tr>
<tr>
<td>Sample Name</td>
<td>The name of the sample.</td>
</tr>
<tr>
<td>Target Name</td>
<td>The name of the target evaluated by the well.</td>
</tr>
<tr>
<td>Task</td>
<td>The task assigned to the well (Unknown, Negative Control, or Positive Control).</td>
</tr>
<tr>
<td>Dyes</td>
<td>The name of the reporter and quencher dyes of the associated sample for the target evaluated by the well.</td>
</tr>
<tr>
<td>Tm1</td>
<td>The melting temperature of the target.</td>
</tr>
<tr>
<td>Tm2</td>
<td>The second melting temperature (for targets with multiple melting temperatures).</td>
</tr>
<tr>
<td>Tm3</td>
<td>The third melting temperature (for targets with multiple melting temperatures).</td>
</tr>
</tbody>
</table>
Chapter 5  Review Results and Adjust Experiment Parameters
Identify well problems using the Well Table

Tips for viewing well tables your own experiments

When you analyze your own experiment:

- Review the data for the Unknown samples. For each row that displays ▲ in the Flag column, note the data and the flag(s) triggered by the associated well.
- Select areas of the table or wells of a specified type by:
  - Left-clicking the mouse and dragging across the area you want to select an area of the table.
  - Selecting Sample, Target, or Task from the Select Items menu in the Well Table tab, then selecting the sample, target, or task name from the second Select Items menu to select wells of a specific type using the well-selection tool.
- Group the rows of the plate layout by selecting an option from the Group By menu. You can then collapse or expand the lists either by clicking the +/- icon next to individual lists, or by clicking Collapse All or Expand All.
- Omit a well from the analysis by selecting the Omit check box for that well. To include the well in the analysis, deselect the Omit check box.
  
  Note: You must reanalyze the experiment each time you omit or include a well.
Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

Purpose

In the Melt Curve example experiment, you review the Multicomponent Plot screen for:

- ROX™ dye (passive reference)
- SYBR® dye (reporter)
- Spikes, dips, and/or sudden changes

View the Multicomponent Plot

1. From the Experiment Menu pane, select Analysis › Multicomponent Plot.
   Note: If no data are displayed, click Analyze.

2. Display the unknown wells in the plate layout to display the corresponding data in the Multicomponent Plot screen:
   a. Click the Plate Layout tab.
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.
      Note: If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click Show a legend for the plot (default).
   Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal remains constant throughout the PCR process; a constant ROX dye signal indicates typical data.

6. Check the SYBR® dye signal. In the example experiment, because the PCR run has already been completed, the SYBR® dye signal shows gradual decrease throughout the run and a sudden dip in the fluorescence at one point; the sudden drop in the SYBR® dye signal indicates the melting temperature of the target.
The Multicomponent Plot screen for the example experiment looks like this:

Tips for confirming dye accuracy in your own experiment

When you analyze your own Melt Curve experiment, look for:

- **Passive reference** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.

- **Reporter dye** – The reporter dye fluorescence level should display a flat region corresponding to the baseline, followed by a rapid rise in fluorescence as the amplification proceeds. If the Melt Curve is being performed post-PCR, then there should be a gradual decrease in fluorescence and a sudden dip indicating the melting temperature of the target.

- **Irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter for the selected wells during each cycle of the real-time PCR.

About the example experiment

In the Melt Curve example experiment, you review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data Plot

1. From the Experiment Menu pane, select **Analysis ➤ Raw Data Plot**.
   
   **Note:** If no data are displayed, click **Analyze**.
2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.

3. Click **Show a legend for the plot** (default). The legend displays the color code for each row of the reaction plate (see the legend in the Raw Data Plot shown below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 135. In the example experiment, the signal from filter 1, which corresponds to the SYBR® dye filter, is stable throughout.

   **Note:** The readings shown below are from the example experiment. Actual results will vary with individual experiment setup.

   **Note:** The cycle number in the Melt Curve represents the number of data collection points for that experiment.

The Raw Data plot for the example experiment looks like this:
The filters used for the example experiment are:

![Filter Table]

Tips for determining signal accuracy in your own experiments

- Characteristic signal growth
- No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags, including the flag frequency and location for the open experiment.

View the QC Summary

1. From the Experiment Menu pane, select Analysis ▶ QC Summary.
   
   Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.
   
   Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment. If the frequency is >0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.

   In the example experiment, there are no flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed information about the flag. In the example experiment, the Frequency column displays 0 for the three flags NOSIGNAL, OFFSCALE, and MTP.
4. *(Optional)* For those flags with frequency >0, click the troubleshooting link to view information on correcting the flag.

The QC Summary for the example experiment looks like this:

### Possible flags

For Melt Curve experiments that do not include amplification, the flags listed below may be triggered by the experiment data.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
</tbody>
</table>

For Melt Curve experiments that include amplification, the flags listed below may be triggered by the experiment data.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
</tbody>
</table>
### For more information on...

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing data</td>
<td>Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments</td>
<td>4470050</td>
</tr>
</tbody>
</table>

---

### Chapter 5 Review Results and Adjust Experiment Parameters

For more information

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>( C_T ) algorithm failed</td>
</tr>
<tr>
<td>AMPSCORE</td>
<td>Amplification in the linear region is below a certain threshold, corresponding to the score set in the analysis settings</td>
</tr>
</tbody>
</table>

**Secondary analysis flags**

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MTP</td>
<td>Multiple Tm peaks</td>
</tr>
<tr>
<td>OUTLIERRG</td>
<td>Outlier in replicate group</td>
</tr>
<tr>
<td>AMPNC</td>
<td>Amplification in negative control</td>
</tr>
<tr>
<td>HIGHSD</td>
<td>High standard deviation in replicate group</td>
</tr>
</tbody>
</table>

**Note:** When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the Melt Curve and flags.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.
2. Click Analysis ▸ Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:

- Melt Curve Settings
- Cₜ Settings
- Flag Settings
- Advanced Settings

Note: The Cₜ Settings and Advanced Settings tabs appear in the Analysis Settings dialog box only if the Melt Curve experiment you are performing includes the PCR process.

Note: Select the Include PCR check box on the Experiment Properties screen to include amplification in your Melt Curve experiment.

The Analysis Settings dialog box for a Melt Curve experiment looks like this:
3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” below).

Note: You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Experiments.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to Default Analysis Settings.

Adjust analysis settings

You may change the following settings:

Melt Curve Settings

Use this tab to:

- Enable or disable multi-peak calling.
  - Select the Enable Multi-Peak Calling check box if you expect to amplify more than 1 PCR product and you want to determine the Tm for more than one peak.
  - Deselect the Enable Multi-Peak Calling check box if you expect to amplify 1 PCR product and you do not want to determine the Tm for more than one peak.

- Enter a value (in percentage) for the peak level relative to the dominant peak.
  Specify a fractional level value as the peak detection threshold. The detected peaks are measured relative to the height of the tallest peak, which has a perfect fractional level 100%. The default value is initially set at 10%.
  For example, if you set a fractional level detection threshold value at 40, then only peaks above 40% of the tallest peak are reported and the peaks at lower height are regarded as noise.

C_T Settings

- Data Step Selection
  Use this feature to select one stage/step combination for C_T analysis when there is more than one data collection point in the run method.

- Algorithm Settings
  You can select the algorithm that determines the C_T values. There are two algorithms: Baseline Threshold (the default) and Relative Threshold.
  The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for quantification.
  The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no dependence on targets, thereby reducing variability. It is not necessary to set either a baseline or a threshold when you use the Relative Threshold algorithm, so any settings for baseline or threshold will not affect the analysis.

- Default C_T Settings
Use the default $C_T$ settings feature to calculate $C_T$ for the targets that do not have custom settings. To edit the default settings, click **Edit Default Settings**.

- **$C_T$ Settings for Target**
  When you manually set the threshold and baseline, Life Technologies recommends:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Enter a value for the threshold so that the threshold is:</td>
</tr>
<tr>
<td></td>
<td>• Above the background.</td>
</tr>
<tr>
<td></td>
<td>• Below the plateau and linear regions of the amplification curve.</td>
</tr>
<tr>
<td></td>
<td>• Within the exponential phase of the amplification curve.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Select the Start Cycle and End Cycle values so that the baseline ends</td>
</tr>
<tr>
<td></td>
<td>before significant fluorescent signal is detected.</td>
</tr>
</tbody>
</table>

**Note:** This setting is applicable only to the Baseline Threshold algorithm.

**Note:** Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.

**Flag Settings**

Use the Flag Settings tab to:

- Adjust the sensitivity so that more wells or fewer wells are flagged.
- Change the flags that are applied by the QuantStudio™ 12K Flex Software.

To adjust the flag settings:

1. In the Use column, select the check boxes for flags to apply during analysis.

2. **(Optional)** If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.
   
   **Note:** If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.
   
   **Note:** After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments using the Standard Deviation calculations may change the result of $C_T$ SD. For some flags, analysis results calculated before the well is rejected are maintained.

4. Click **Apply Analysis Settings** in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.
Chapter 5  Review Results and Adjust Experiment Parameters

Adjust analysis settings

The Flag Settings tab looks like this:

![Flag Settings Tab]

**Advanced Settings**

Use the Advanced Settings tab to change baseline settings well-by-well.

**Note:** The baseline and threshold values do not affect the analysis using the Relative Threshold setting.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.
2. Deselect the **Use C_T Settings Defined for Target** check box.
3. Define the custom baseline settings:

   - For automatic baseline calculations, select the **Automatic Baseline** check box.
   - To define the baseline, deselect the **Automatic Baseline** check box, then enter the baseline start cycle and baseline end cycle.
### For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification efficiency</td>
<td><em>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note.</em></td>
<td>127AP05-03</td>
</tr>
</tbody>
</table>
Chapter 5  Review Results and Adjust Experiment Parameters

For more information
Export Analysis Results

1. Open the Melt Curve example experiment file that you analyzed in Chapter 5.

2. In the Experiment Menu, click **Export**.
   
   **Note**: To export data automatically after analysis, select the **Auto Export** check box during experiment setup or before running the experiment. Auto export is unchecked for the example experiment.

3. Select **QuantStudio™ 12K Flex format**.

4. Complete the Export dialog box as shown below:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export/ Select Content</td>
<td>Results</td>
</tr>
<tr>
<td>Export Data To</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>384-Well Melt Curve Example_QuantStudio_export</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td>&lt;drive&gt;:\Applied Biosystems\QuantStudio 12K Flex Software\experiments</td>
</tr>
</tbody>
</table>
Chapter 6 Export Analysis Results

Your Export screen should look like this:

```
<table>
<thead>
<tr>
<th>Well</th>
<th>Wells Position</th>
<th>Sample Name</th>
<th>Target Name</th>
<th>Task</th>
<th>Reporter</th>
<th>Quencher</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>A1</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>A2</td>
<td>A2</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>A3</td>
<td>A3</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>B1</td>
<td>B1</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>B2</td>
<td>B2</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>B3</td>
<td>B3</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>C1</td>
<td>C1</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>C2</td>
<td>C2</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>C3</td>
<td>C3</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>D1</td>
<td>D1</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>D2</td>
<td>D2</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>D3</td>
<td>D3</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>E1</td>
<td>E1</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>E2</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>E3</td>
<td>Sample 1</td>
<td>Target 1</td>
<td>UNK</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>
```

Your exported file when opened in Notepad should look like this:

```
<table>
<thead>
<tr>
<th>Sample Setup</th>
<th>Sample Name</th>
<th>Sample Color</th>
<th>Sample Group Name</th>
<th>Sample Group Color</th>
<th>Target Name</th>
<th>Target Color</th>
<th>Task</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Quencher Color</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A2</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A3</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B1</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B2</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B3</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C1</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C3</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D1</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D2</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D3</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E1</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>Sample 1</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>&quot;Red (0,0,255)&quot;</td>
<td>Target 1</td>
<td>UNKNOWN SYBR</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```
Index

A
adjusting analysis settings adjusting 35
adjusting parameters, re-analyzing own experiments 35
Advanced Settings tab 39
Algorithm Settings
  Baseline Threshold 37
  Relative Threshold 37
amplification efficiency 40
amplification, include PCR 35
amplified products 5
AMPNC flag 34
AMPSCORE flag 34
analysis settings 35, 36
  Advanced Settings 35
  C_T Settings 35
  Flag Settings 35
  Melt Curve Settings 35
Analyze 25
  Melt Curve Plot 25
  Multicomponent Plot 29
  QC Summary 32
  Raw Data Plot 30
Auto Export 7, 41
Automatic Baseline 39
Automatic Threshold 38

B
BADROX flag 33
BLFAIL flag 34

C
cocktail mix 14
C_T settings
  algorithm settings 37
  data step, selecting 37
  default 37
  target 37
C_T Settings tab 37, 34

dissociation curve 5
dye accuracy
  irregularities in the signal 30
  passive reference 30
  reporter dye 30

E
Enable the Multi-Peak Calling 37
example experiment 6
experiment properties, defining 7
EXPFAIL flag 34
Export 41
extraneous peaks 6

F
Flag Settings tab 38
flags, QC
  AMPNC 34
  AMPSCORE 34
  BADROX 33
  BLFAIL 34
  CTFAIL 34
  EXPFAIL 34
  HIGHSD 34
  MTP 33, 34
  NOAMP 34
  NOISE 34
  NOSIGNAL 33, 34
  OFFSCALE 33
  OUTLIERRG 34
  SPIKE 34
  THOLDFAIL 34
fluorescence peaks 5

H
HIGHSD flag 34

I
include amplification, Pre-processing flag
  OFFSCALE 33
include amplification, Primary analysis flags
  AMPSCORE 34
  BADROX 33
  BLFAIL 34
  CTFAIL 34
  EXPFAIL 34
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOAMP  34</td>
</tr>
<tr>
<td>NOISE  34</td>
</tr>
<tr>
<td>NOSIGNAL  34</td>
</tr>
<tr>
<td>SPIKE  34</td>
</tr>
<tr>
<td>THOLDFAIL  34</td>
</tr>
<tr>
<td>include amplification, Secondary analysis flags</td>
</tr>
<tr>
<td>AMPNC  34</td>
</tr>
<tr>
<td>HIGHSD  34</td>
</tr>
<tr>
<td>MPT  34</td>
</tr>
<tr>
<td>OUTLIERRG  34</td>
</tr>
<tr>
<td>Melt curve experiments</td>
</tr>
<tr>
<td>melt curve reactions 5</td>
</tr>
<tr>
<td>overview 5</td>
</tr>
<tr>
<td>Melt Curve Plot 18, 25</td>
</tr>
<tr>
<td>assessing 25</td>
</tr>
<tr>
<td>Derivative Reporter 25</td>
</tr>
<tr>
<td>Normalized Reporter 25</td>
</tr>
<tr>
<td>reactions type, negative controls 6</td>
</tr>
<tr>
<td>reactions type, unknowns 6</td>
</tr>
<tr>
<td>tips for analyzing own experiment 26</td>
</tr>
<tr>
<td>viewing 18, 25</td>
</tr>
<tr>
<td>Melt Curve Settings tab 37</td>
</tr>
<tr>
<td>melt curve stage 6</td>
</tr>
<tr>
<td>Melting temperature (Tm) 5</td>
</tr>
<tr>
<td>MTP flag 33</td>
</tr>
<tr>
<td>multicomponent plot</td>
</tr>
<tr>
<td>confirming dye accuracy 29</td>
</tr>
<tr>
<td>tips for analyzing own experiment 30</td>
</tr>
<tr>
<td>viewing 29</td>
</tr>
<tr>
<td>qc summary 32</td>
</tr>
<tr>
<td>QC Summary, reviewing flags 32</td>
</tr>
<tr>
<td>Rram increment 10</td>
</tr>
<tr>
<td>editing 10</td>
</tr>
<tr>
<td>method, continuous (default) 10</td>
</tr>
<tr>
<td>method, step and hold 10</td>
</tr>
<tr>
<td>Raw Data Plot 30</td>
</tr>
<tr>
<td>raw data plot</td>
</tr>
<tr>
<td>determining signal accuracy 30</td>
</tr>
<tr>
<td>tips for analyzing own experiments 32</td>
</tr>
<tr>
<td>viewing 30</td>
</tr>
<tr>
<td>reaction mix</td>
</tr>
<tr>
<td>components 13</td>
</tr>
<tr>
<td>preparing reactions 14</td>
</tr>
<tr>
<td>reactions, assembling materials for 13</td>
</tr>
<tr>
<td>review results 25</td>
</tr>
<tr>
<td>run</td>
</tr>
<tr>
<td>monitoring 17</td>
</tr>
<tr>
<td>starting 17</td>
</tr>
<tr>
<td>run method</td>
</tr>
<tr>
<td>reaction volume per well 10</td>
</tr>
<tr>
<td>setting up 10</td>
</tr>
<tr>
<td>thermal profile 10</td>
</tr>
<tr>
<td>viewing 19</td>
</tr>
<tr>
<td>Run Screen</td>
</tr>
<tr>
<td>Melt Curve Plot 18</td>
</tr>
<tr>
<td>Run Method 19</td>
</tr>
<tr>
<td>Temperature Plot 19</td>
</tr>
<tr>
<td>View Run Data 20</td>
</tr>
<tr>
<td>Run screen 18</td>
</tr>
<tr>
<td>Ssample dilutions, preparing reactions 13</td>
</tr>
<tr>
<td>Sample temperature 19</td>
</tr>
</tbody>
</table>
samples, defining  8
single-stranded DNA  5
SPIKE flag  34

T
target DNA  5
targets and samples
  assigning  9
  defining  8
targets, defining  8
temperature plot, viewing  19
thermal profile, setting up  10
THOLDFAIL flag  34
touchscreen, running the experiment from
  Experiment View  20
  Plot View  21
  Time View  21
troubleshooting
  multiple peaks  26
  non-specific amplification  26

W
well table
  identifying well problems  27
  tips for viewing own experiments  28
  viewing  27
well table, column
  Dyes  28
  Flag  28
  Omit  28
  Sample Name  28
  Target Name  28
  Task  28
  Tm1  28
  Tm2  28
  Tm3  28
  Well  27
For Research Use Only. Not intended for any animal or human therapeutic or diagnostic use.
APPENDIX A

Ordering Information .................................................. 5

Consumables ........................................................................ 5
  Calibration and verification consumables ............................... 5
  Experiment consumables .................................................... 7

Reagents ............................................................................. 8

General-use materials and consumables ................................. 9

Documentation and Support .................................................. 11

Related documentation ...................................................... 11

Other related documents ................................................... 12
  Documents related to Genotyping experiments ...................... 12
  Documents related to Presence/Absence experiments ............. 12
  Documents related to Relative Standard Curve and Comparative C_T experiments ... 13
  Documents related to Standard Curve experiments ............... 13

How to obtain support ....................................................... 13

  Obtaining information from the Help system ....................... 13

Index ............................................................................... 15
Ordering Information

This appendix covers:

- Consumables ................................................................. 5
- Reagents ........................................................................... 8
- General-use materials and consumables.............................. 9

Consumables

The consumables listed below are required for calibrating the QuantStudio™ 12K Flex Instrument and for performing experiments with the QuantStudio™ 12K Flex System.

**Note:** For reagent or consumable shelf-life expiration date, see the package label.

**Calibration and verification consumables**

The following table shows the reagents and consumables required to calibrate the QuantStudio™ 12K Flex Instrument.

<table>
<thead>
<tr>
<th>384-well sample block</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Consumable</strong></td>
</tr>
<tr>
<td>384-Well Spectral Calibration Plate with FAM™ Dye</td>
</tr>
<tr>
<td>384-Well Spectral Calibration Plate with VIC® Dye</td>
</tr>
<tr>
<td>384-Well Spectral Calibration Plate with ROX™ Dye</td>
</tr>
<tr>
<td>384-Well Spectral Calibration Plate with SYBR® Green Dye</td>
</tr>
<tr>
<td>384-Well Spectral Calibration Plate with TAMRA™ Dye</td>
</tr>
<tr>
<td>384-Well Spectral Calibration Plate with NED™ Dye</td>
</tr>
<tr>
<td>384-Well Region of Interest (ROI) and Background Plates</td>
</tr>
<tr>
<td>384-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes</td>
</tr>
<tr>
<td>TaqMan® RNase P Fast 384-Well Instrument Verification Plate</td>
</tr>
</tbody>
</table>
### 96-well (0.2 µL) sample block

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
<th>Shelf-life at environmental temperature</th>
<th>Storage conditions (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-Well Spectral Calibration Plate with FAM™ Dye</td>
<td>4432327</td>
<td>Use the consumable by the expiration date mentioned on the package</td>
<td>−15 to −25°C</td>
</tr>
<tr>
<td>96-Well Spectral Calibration Plate with VIC® Dye</td>
<td>4432334</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Spectral Calibration Plate with ROX™ Dye</td>
<td>4432340</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Spectral Calibration Plate with SYBR® Green Dye</td>
<td>4432346</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Spectral Calibration Plate with TAMRA™ Dye</td>
<td>4432352</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Spectral Calibration Plate with NED™ Dye</td>
<td>4432358</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan® RNase P 96-Well Instrument Verification Plate</td>
<td>4432382</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Region of Interest [ROI] and Background Plates</td>
<td>4432364</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes</td>
<td>4432370</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan® RNase P 96-Well Instrument Verification Plate</td>
<td>4432382</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Fast 96-well (0.1 µL) sample block

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
<th>Shelf-life at environmental temperature</th>
<th>Storage conditions (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast 96-Well Spectral Calibration Plate with FAM™ Dye</td>
<td>4432389</td>
<td>Use the consumable by the expiration date mentioned on the package</td>
<td>−15 to −25°C</td>
</tr>
<tr>
<td>Fast 96-Well Spectral Calibration Plate with VIC® Dye</td>
<td>4432396</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast 96-Well Spectral Calibration Plate with ROX™ Dye</td>
<td>4432402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast 96-Well Spectral Calibration Plate with SYBR® Green Dye</td>
<td>4432408</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast 96-Well Spectral Calibration Plate with TAMRA™ Dye</td>
<td>4432414</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast 96-Well Spectral Calibration Plate with NED™ Dye</td>
<td>4432420</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast 96-Well Region of Interest [ROI] and Background Plates</td>
<td>4432426</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast 96-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes</td>
<td>4432432</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan® RNase P Fast 96-Well Instrument Verification Plate</td>
<td>4351979</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Array card sample block

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
<th>Shelf-life at environmental temperature</th>
<th>Storage conditions (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array Card Spectral Dye Calibration Kit</td>
<td>4432314</td>
<td>Use the consumable by the expiration date mentioned on the package</td>
<td>−15 to −25°C</td>
</tr>
<tr>
<td>Array Card RNase P Instrument Verification Kit</td>
<td>4432265</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The following table shows the reagents and consumables required to perform experiments with the QuantStudio™ 12K Flex System.

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
<th>Shelf-life at environmental temperature</th>
<th>Storage conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array Card Buckets/Clip Set</td>
<td></td>
<td>Use the consumable by the expiration date mentioned on the package</td>
<td>Room temperature</td>
</tr>
<tr>
<td>1st Generation</td>
<td>4337762</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2nd Generation</td>
<td>4442571</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan® Array Micro Fluidic Card Sealer</td>
<td>4331770</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Optical 384-Well Reaction Plate with Barcode</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1000 plates</td>
<td>4343814</td>
<td></td>
<td></td>
</tr>
<tr>
<td>500 plates</td>
<td>4326270</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50 plates</td>
<td>4309849</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Optical 384-Well Reaction Plate, 1000 plates</td>
<td>4343370</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Optical 96-Well Reaction Plate (0.2µL)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>500 plates</td>
<td>4316813</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 plates</td>
<td>N8010560</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Optical 96-Well Reaction Plate with Barcode (0.2µL)</td>
<td>4326659</td>
<td></td>
<td></td>
</tr>
<tr>
<td>500 plates</td>
<td>4307637</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Fast Optical 96-Well Reaction Plate (0.1µL)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 plates</td>
<td>4346907</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Fast Optical 96-Well Reaction Plate with Barcode (0.1µL)</td>
<td>4366932</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200 plates</td>
<td>4346906</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centrifuge Buckets, Array Card</td>
<td>4337230</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1st Generation</td>
<td>4442573</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2nd Generation</td>
<td>434682</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clip, Array Card Centrifuge Adaptor</td>
<td>4311971</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Optical Adhesive Film</td>
<td>4360954</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 films</td>
<td>4313950</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25 films</td>
<td>4332032</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Multi-Removal Tool (1 tool)</td>
<td>AM9935</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RT-PCR Grade Water</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Optical 8-Cap Strip</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>300 strips</td>
<td>4323032</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Optical 8-Tube Strip (0.2µL)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>125 strips</td>
<td>4316567</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Fast 8-Tube Strip (0.1µL)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>125 strips</td>
<td>4358293</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Optical Tube without cap (0.2µL)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2000 tubes</td>
<td>N8010533</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Fast Reaction Tube with cap (0.1µL)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1000 tubes</td>
<td>4358297</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® 96-Well Tray/Retainer Set (Blue) (for 0.2µL)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 pairs</td>
<td>4381850</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® 96-Well Tray (Black) (for 0.1µL)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 plates</td>
<td>4379983</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix A  Ordering Information

Reagents

The following table lists the reagents that can be ordered for performing experiments with the QuantStudio™ 12K Flex System.

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
<th>Shelf-life at environmental temperature</th>
<th>Storage conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-Well Plate Adapter (0.2 µL)</td>
<td>4459845</td>
<td>Use the consumable by the expiration date mentioned on the package</td>
<td>Room temperature</td>
</tr>
<tr>
<td>Fast 96-Well Plate Adapter (0.1 µL)</td>
<td>4459846</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Tube Adapter (0.2 µL)</td>
<td>4462077</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Tube Adapter (0.1 µL)</td>
<td>4462078</td>
<td></td>
<td></td>
</tr>
<tr>
<td>384-Well Plate Adapter</td>
<td>4457087</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Array Card Adapter</td>
<td>4454166</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Cap Installing Tool (Handle) (1 tool)</td>
<td>4330015</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Adhesive Film Applicator (5 applicators)</td>
<td>4333183</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Recommended reagent kits

<table>
<thead>
<tr>
<th>To perform</th>
<th>Reagent</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse Transcription</td>
<td>SuperScript® VILO™ cDNA Synthesis Kit</td>
<td>4453650</td>
</tr>
<tr>
<td>TaqMan® PCR</td>
<td>TaqMan® Fast Advanced Master Mix</td>
<td>4444557</td>
</tr>
<tr>
<td></td>
<td>TaqMan® GTXpress™ Master Mix</td>
<td>4401892</td>
</tr>
<tr>
<td></td>
<td>TaqMan® Fast Virus 1-Step Master Mix</td>
<td>4444432</td>
</tr>
<tr>
<td></td>
<td>TaqMan® Gene Expression Master Mix</td>
<td>4369016</td>
</tr>
<tr>
<td></td>
<td>TaqMan® Genotyping Master Mix</td>
<td>4371355</td>
</tr>
<tr>
<td></td>
<td>TaqMan® Universal Master Mix II, with UNG</td>
<td>4440038</td>
</tr>
<tr>
<td></td>
<td>TaqMan® RNA-to-CT™ 1-Step Kit</td>
<td>4392938</td>
</tr>
<tr>
<td>SYBR® Green PCR</td>
<td>Fast SYBR® Green Master Mix</td>
<td>4385612</td>
</tr>
<tr>
<td></td>
<td>Power SYBR® Green PCR Master Mix</td>
<td>4367659</td>
</tr>
<tr>
<td></td>
<td>Power SYBR® Green RNA-to-CT™ 1-Step Kit</td>
<td>4389986</td>
</tr>
</tbody>
</table>
General-use materials and consumables

The following general-use materials and consumables are required to calibrate, maintain, and perform experiments with the QuantStudio™ 12K Flex System. Unless indicated otherwise, all materials shown below are available from major laboratory suppliers (MLS). The materials are applicable to all sample blocks.

<table>
<thead>
<tr>
<th>Material/Consumable</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bleach, 10% solution</td>
<td>MLS</td>
</tr>
<tr>
<td>Lint-free lab tissues</td>
<td>MLS</td>
</tr>
<tr>
<td>Cotton or nylon swabs and lint-free cloths</td>
<td>MLS</td>
</tr>
<tr>
<td>Centrifuge with buckets appropriate for your consumable type</td>
<td>MLS</td>
</tr>
<tr>
<td>Ethanol, 95% solution</td>
<td>MLS</td>
</tr>
<tr>
<td>Glasses, safety</td>
<td>MLS</td>
</tr>
<tr>
<td>Gloves, powder-free</td>
<td>MLS</td>
</tr>
<tr>
<td>Permanent marker or pen</td>
<td>MLS</td>
</tr>
<tr>
<td>Pipettors: 100-µL and 200-µL [with pipette tips]</td>
<td>MLS</td>
</tr>
<tr>
<td>Screwdriver, flathead</td>
<td>MLS</td>
</tr>
</tbody>
</table>
## Documentation and Support

### Related documentation

The following related documents are shipped with the system:

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System</td>
<td>4470689</td>
<td>Explains how to use and maintain the Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System. Intended for laboratory staff responsible for the use and maintenance of the QuantStudio™ 12K Flex Instrument.</td>
</tr>
</tbody>
</table>
| Maintenance and Administration Guide                             | 4470050    | Contains five individual booklets that explain how to perform the six different experiments on the QuantStudio™ 12K Flex Instrument. The experiments include Standard Curve, Relative Standard Curve and Comparative C\textsubscript{T}, Genotyping, Presence/ Absence and Melt Curve. Each Getting Started Guide booklet functions as both:  
  • A tutorial, using example experiment data provided with the QuantStudio™ 12K Flex Software.
  • A guide for your own experiments. Intended for laboratory staff and principal investigators who perform experiments using the QuantStudio™ 12K Flex System. |
| Multi-well Plates and Array Card Experiments User Guide           | 4470688    | Explains how to install and maintain the QuantStudio™ 12K Flex Instrument. Intended for laboratory staff responsible for the use and maintenance of the QuantStudio™ 12K Flex Instrument. |
| Quick Reference Guide                                             | 4470654    | Explains how to prepare your site to receive and install the QuantStudio™ 12K Flex Instrument. Intended for personnel who schedule, manage, and perform the tasks required to prepare your site for installation of the QuantStudio™ 12K Flex Instrument. |
QuantStudio™ 12K Flex Software Help

NA

Explain how to use the QuantStudio™ 12K Flex Software to:

- Set up, run, and analyze experiments.
- Monitor a networked QuantStudio™ 12K Flex Instrument.
- Calibrate the QuantStudio™ 12K Flex Instrument.
- Verify the performance of QuantStudio™ 12K Flex Instrument with an RNase P run.

Intended for:
- Laboratory staff and principal investigators who perform experiments using the QuantStudio™ 12K Flex System.
- Laboratory staff responsible for the installation and maintenance of the QuantStudio™ 12K Flex Instrument.

Note: For additional documentation, see “How to obtain support” on page 13.

### Other related documents

#### Documents related to Genotyping experiments

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allelic Discrimination Pre-Developed TaqMan® Assay Reagents Quick Reference Card</td>
<td>4312212</td>
</tr>
<tr>
<td>Custom TaqMan® Genomic Assays Protocol</td>
<td>4367671</td>
</tr>
<tr>
<td>Custom TaqMan® SNP Genotyping Assays Protocol</td>
<td>4334431</td>
</tr>
<tr>
<td>Ordering TaqMan® SNP Genotyping Assays Quick Reference Card</td>
<td>4374204</td>
</tr>
<tr>
<td>Pre-Developed TaqMan® Assay Reagents Allelic Discrimination Protocol</td>
<td>4312214</td>
</tr>
<tr>
<td>TaqMan® Drug Metabolism Genotyping Assays Protocol</td>
<td>4362038</td>
</tr>
<tr>
<td>TaqMan® SNP Genotyping Assays Protocol</td>
<td>4332856</td>
</tr>
</tbody>
</table>

#### Documents related to Presence/Absence experiments

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal Swabs Protocol</td>
<td>4343586</td>
</tr>
<tr>
<td>NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue Protocol</td>
<td>4333959</td>
</tr>
<tr>
<td>PrepMan® Ultra Sample Preparation Reagent Protocol</td>
<td>4318925</td>
</tr>
</tbody>
</table>
How to obtain support

For the latest services and support information for all locations, go to:

www.appliedbiosystems.com

At the Life Technologies web site, you can:

- Access worldwide telephone and fax numbers to contact Life Technologies Technical Support and Sales facilities.
- Search through frequently asked questions (FAQs).
- Submit a question directly to Technical Support.
- Order Applied Biosystems user documents, SDSs, certificates of analysis, and other related documents.
- Download PDF documents.
- Obtain information about customer training.
- Download software updates and patches.

Obtaining information from the Help system

The QuantStudio™ 12K Flex Software has a Help system that describes how to use each feature of the user interface. Access the Help system by doing one of the following:

- Click 🕵️ in the toolbar of the QuantStudio™ 12K Flex Software window.
- Select Help ‣ QuantStudio™ 12K Flex Software Help.
- Press F1.
You can use the Help system to find topics of interest by:

- Reviewing the table of contents
- Searching for a specific topic
- Searching an alphabetized index

You can also access PDF versions of all documents in the QuantStudio™ 12K Flex Software document set from the Help system.
C
Calibration and verification consumables
  384-well  5
  96-well (0.2µL)  6
  array card  6
  Fast 96-well (0.1µL)  6

E
experiment consumables  7
expiration date  5

H
Help system  13

P
package label  5

S
SYBR® Green I Reagents  8

T
TaqMan® Reagents  8
training, information on  13